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1. About Small Office Security
Small Office Security on-premise allows organizations to host security in their own
infrastructure and easily deploy, administer and monitor protection for PC andMac desktops
and file servers, featuring leading antimalware detection as well as the latest administration
console developed by Bitdefender.

Unlike the cloud-managed version which is hosted by Bitdefender and requires no onsite
infrastructure, the Small Office Security version is deployed in the customer’s own
environment.

Small Office Security includes the following components:

• Control Center
• Security for Endpoints
• Security for Mobile Devices

Control Center
A web-based dashboard and unified management console that provides full visibility into
organization’s overall security posture, global security threats, and control over its security
services that protects desktops and servers.

Control Center integrates with the existing system management and monitoring systems to
make it simple to automatically apply protection to unmanaged desktops and servers.

Security for Endpoints
Bitdefender Security for Endpoints unobtrusively protects computers by using
number-one-ranked antimalware technology combined with firewall, intrusion detection,
web access control and filtering, sensitive data protection and application control. Security
for Endpoints offers protection for computers and laptops running on Windows and Mac
OS X operating systems and Windows servers. Employee productivity is ensured with low
resource consumption, optimized system scanning and automated security that requires
no end-user interaction.

Security for Mobile Devices
Manages and controls iPhone, iPad and Android devices with a unified enterprise-grade
management that keeps the device safe with real-time scanning and enforces organization’s
security policies on mobile devices to lock screen, require authentication, encrypt removable
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media, locate lost devices and deny non-compliant or jailbroken devices accessing corporate
services.
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2. System Requirements
All of the Small Office Security solutions are installed and managed via Control Center.

2.1. Small Office Security Appliance Requirements
Small Office Security is delivered as a virtual appliance. The Small Office Security appliance
is available in the following formats:

• OVA (compatible with VMware vSphere, View)
• XVA (compatible with Citrix XenServer, XenDesktop, VDI-in-a-Box)
• VHD (compatible with Microsoft Hyper-V)
• OVF (compatible with Red Hat Enterprise Virtualization)*
• OVF (compatible with Kernel-based Virtual Machine or KVM)*
• RAW (compatible with Oracle VM)*

*OVF and RAW packages are archived in tar.bz2 format.

Support for other formats and virtualization platforms may be provided on request.

2.1.1. Hardware Requirements
The following table describes the hardware requirements for the Small Office Security
appliance, depending on the number of managed network objects.

CPUsHDDRAMNumber of protected objects

2 virtual CPUs (2GHz each)40 GB4 GB1-250 endpoints

1-250 mobile devices

4 virtual CPUs (2GHz each)60 GB8 GB250-1000 endpoints

250-1000 mobile devices

2.1.2. Internet Connection
The Small Office Security appliance requires Internet access.
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2.1.3. Control Center Web Console Requirements
To access the Control Center web console, the following are required:

• Internet Explorer 9+, Mozilla Firefox 14+, Google Chrome 15+, Safari 5+
• Recommended screen resolution: 1280x800 or higher
• The computer you connect from must have network connectivity to the Control Center

appliance.

Warning
Control Center will not work / display properly in Internet Explorer 9+ with the Compatibility
View feature enabled, which is equivalent with using an unsupported browser version.

2.2. Security for Endpoints Requirements

2.2.1. Supported Operating Systems
Security for Endpoints currently protects the following operating systems:

Workstation operating systems:
• Windows 8.1
• Windows 8
• Windows 7
• Windows Vista with Service Pack 1
• Windows XP with Service Pack 3
• Mac OS X Lion (10.7.x)
• Mac OS X Mountain Lion (10.8.x)
• Mac OS X Mavericks (10.9.x)

Tablet and embedded operating systems:
• Windows Embedded 8.1 Industry
• Windows Embedded 8 Standard
• Windows Embedded Standard 7
• Windows Embedded Compact 7
• Windows Embedded POSReady 7
• Windows Embedded Enterprise 7
• Windows Embedded POSReady 2009
• Windows Embedded Standard 2009
• Windows XP Embedded with Service Pack 2*
• Windows XP Tablet PC Edition*

*Specific operating systemmodules must be installed for Security for Endpoints to work.

Server operating systems:
• Windows Server 2012 R2
• Windows Server 2012
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• Windows Small Business Server (SBS) 2011
• Windows Small Business Server (SBS) 2008
• Windows Server 2008 R2
• Windows Server 2008
• Windows Small Business Server (SBS) 2003
• Windows Server 2003 R2
• Windows Server 2003 with Service Pack 1
• Windows Home Server

2.2.2. Hardware Requirements
• Intel® Pentium compatible processor:

Workstation Operating Systems
– 1 GHz or faster for Microsoft Windows XP SP3, Windows XP SP2 64 bit andWindows

7 Enterprise (32 and 64 bit)
– 2 GHz or faster for Microsoft Windows Vista SP1 or higher (32 and 64 bit), Microsoft

Windows 7 (32 and 64 bit), Microsoft Windows 7 SP1 (32 and 64bit), Windows 8
– 800 MHZ or faster for Microsoft Windows Embedded Standard 7 SP1, Microsoft

Windows POSReady 7, Microsoft Windows POSReady 2009, Microsoft Windows
Embedded Standard 2009, Microsoft Windows XP Embedded with Service Pack 2,
Microsoft Windows XP Tablet PC Edition

Server Operating Systems
– Minimum: 2.4 GHz single-core CPU
– Recommended: 1.86 GHz or faster Intel Xeon multi-core CPU

• Free RAM memory:
– For Windows: 512 MB minimum, 1 GB recommended
– For Mac: 1 GB minimum

• HDD space:

– 1.5 GB of free hard-disk space

Note
At least 6 GB free disk space is required for entities with Endpoint Security Relay
role, as they will store all updates and installation packages.

2.2.3. Supported Browsers
Endpoint browser security is verified to be working with the following browsers:

• Internet Explorer 8+
• Mozilla Firefox 8+
• Google Chrome 15+
• Safari 4+
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2.3. Security for Mobile Devices Requirements

2.3.1. Supported Platforms
Security for Mobile Devices supports the following types of mobile devices and operating
systems:

• Apple iPhones and iPad tablets (iOS 5.1+)
• Google Android smartphones and tablets (2.3+)

2.3.2. Connectivity Requirements
Mobile devices must have an active cellular data or Wi-Fi connection and connectivity with
the Communication Server.

2.3.3. Push Notifications
Security for Mobile Devices uses push notifications to alert mobile clients when policy
updates and tasks are available. Push notifications are sent by the Communication Server
via the service provided by the operating system manufacturer:

• Google Cloud Messaging (GCM) service for Android devices. For GCM to work, the
following are required:
– Google Play Store must be installed.
– Devices running a version lower than Android 4.0.4 must also have at least one logged

in Google account.
– To send push notifications, a number of ports must be open.

• Apple Push Notifications service (APNs) for iOS devices. For more information, refer to
this Apple KB article.

To learn more about Small Office Security Mobile Device Management workflow, please
refer to this KB article.

2.3.4. iOS Management Certificates
To set up the infrastructure for iOS mobile device management, you must provide a number
of security certificates.

2.4. Small Office Security Communication Ports
The following table provides information on the ports used by the Small Office Security
components:
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UsagePort

Port used to access the Control Center web console.80 (HTTP) / 443
(HTTPS)

Port used by client/agent software to connect to the
Communication Server.

8443 (HTTPS)

Update Server port7074 (HTTP)

Handles communication between Small Office Security services
and the outside world.

7075

Ports used to allow communication between Control Center and
Communication Server.

4369 / 6150

Default port used by the Communication Server and Control Center
to access the Database.

27017

Google CloudMessaging (GCM) ports. The Communication Server
uses GCM to send push notifications tomanaged Android devices.

5228, 5229, 5230

Apple Push Notification service (APNs) ports. Ports 2195 and 2196
are used by the Communication Server to communicate with the

2195, 2196, 5223

APNs servers. Port 5223 is used by managed iOS devices to
communicate with the APNs servers over Wi-Fi in specific
conditions. For more information, refer to this Apple KB article.

User Datagram Protocol (UDP) port used by Small Office Security
appliances for time synchronization with the NTP server.

123 (UDP)

For detailed information regarding Small Office Security ports, refer to this KB article.
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3. Small Office Security Installation and
Setup
To make sure installation goes smoothly, follow these steps:

1. Prepare for installation.

2. Deploy and set up the Small Office Security virtual appliance.

3. Connect to Control Center and setup the first user account.

4. Configure Control Center settings.

3.1. Prepare for Installation
For installation, you need a Small Office Security virtual appliance image. After you deploy
and set up the Small Office Security appliance, you can remotely install the client or download
the necessary installation packages from the Control Center web interface.

The Small Office Security appliance image is available in several different formats, compatible
with the main virtualization platforms. You can obtain the download links by registering for
a trial on the Bitdefender Enterprise website.

For installation and initial setup, you must have the following at hand:

• DNS names or fixed IP addresses (either by static configuration or via a DHCP reservation)
for the Small Office Security appliance

• Username and password of a domain administrator

• License key (check the trial registration or purchase email)

• Outgoing mail server settings

• If needed, proxy server settings

• Security certificates

Additional prerequisites must be met in order to install protection on your endpoints.

3.2. Deploy and Set Up Small Office Security
Appliance
Small Office Security appliance is delivered with the following preconfigured roles:

• Database Server

Small Office Security Installation and Setup 8

ENTERPRISE BITDEFENDER SMALL OFFICE SECURITY

http://enterprise.bitdefender.com


• Update Server
• Web Console
• Communication Server

To deploy and set up the Small Office Security appliance:

1. Import the Small Office Security virtual appliance image in your virtualized environment.

2. Power on the appliance.

3. From your virtualization management tool, access the console interface of the Small
Office Security appliance.

4. Configure the password for the built-in bdadmin system administrator.

Appliance console interface: enter new password

5. Login with the password you have set.

Appliance console interface: login

6. You will access the appliance configuration interface. Use the arrow keys and the Tab
key to navigate through menus and options. Press Enter to select a specific option.
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Appliance console interface: main menu

7. Configure the network settings.

You can configure the appliance to automatically obtain network settings from the DHCP
server or you can manually configure network settings. If you choose to use DHCP, you
must configure the DHCP Server to reserve a specific IP address for the appliance.

a. From the main menu, select Configure Network Settings.

Appliance console interface: network settings option

b. Select the network interface.

c. Select the configuration method:
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• Configure network settingsmanually. Youmust specify the IP address, network
mask, gateway address and DNS server addresses.

• Obtain network settings automatically via DHCP. Use this option only if you
have configured the DHCP Server to reserve a specific IP address for the appliance.

Appliance console interface: network configuration

d. You can check current IP configuration details or link status by selecting the
corresponding options.

8. Configure the hostname and domain settings.

Communication with the Small Office Security roles is performed using the IP address
or DNS name of the appliance they are installed on. By default, the Small Office Security
components communicate using IP addresses. If you want to enable communication via
DNS names, you must configure Small Office Security appliances with a DNS name and
make sure it correctly resolves to the configured IP address of the appliance.

Prerequisites:

• Configure the DNS record in the DNS server.

• The DNS name must correctly resolve to the configured IP address of the appliance.
Therefore, youmust make sure the appliance is configured with the correct IP address.

Besides configuring the hostname of the appliance, you might also need to join it to a
domain.

Important
The hostname setting is to be configured (if needed) only during initial setup. Changing
the hostname afterwards can cause communication errors with previously deployed
clients.
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To configure the hostname and domain settings:

a. From the main menu, select Configure Hostname and Domain Settings.

Appliance console interface: hostname and domain configuration

b. Select Configure hostname.

c. Enter the hostname of the appliance and the domain name.

d. Select OK to save the changes.

e. Select Configure domain.

f. Enter the username and password of a domain administrator.

g. Select OK to save the changes.

9. Configure Proxy Settings.

If the appliance connects to the Internet through a proxy server, you must configure the
proxy settings:

a. From the main menu, select Configure Proxy Settings.

b. Select Configure proxy settings.
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Appliance console interface: configure proxy settings

c. Enter the proxy server address. Use the following syntax:

• If the proxy server does not require authentication:

http(s)://<IP/hostname>:<port>

• If the proxy server requires authentication:

http(s)://<username>:<password>@<IP/hostname>:<port>

d. Select OK to save the changes.

3.3. Control Center Initial Setup
After deploying and setting up the Small Office Security appliance, you must access the
Control Center web interface and configure your company administrator account.

1. In the address bar of your web browser, enter the IP address or the DNS hostname of
the Control Center appliance (using the https:// prefix). A configuration wizard will
appear.

2. You must first register your Small Office Security deployment to a Bitdefender account.
Provide the username and password of your Bitdefender account. If you do not have a
Bitdefender account yet, click the corresponding link to create one.
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Initial setup - Provide MyBitdefender account

Click Next to continue.

3. Provide the license key required for validating Small Office Security. Check the trial
registration or purchase email to find your license key. Enter the license key in the Key

field and click the Add button. Wait until the license key is validated. You can also
view the expiry date for your license key in the corresponding column.

Initial setup - Provide license key

Click Next to continue.

4. Specify the required details for your company administrator account: username, email
address and a password. Password must contain at least one upper case character, at
least one lower case character and at least one digit or special character.
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Initial setup - Provide license key

5. Click Create Account.

The company administrator account will be created and you will automatically log on with
the new account to Bitdefender Control Center.

3.4. Configure Control Center Settings
After the initial setup, you need to configure Control Center settings. As company
administrator, you can do the following:

• Configure mail, proxy and other general settings.

• Set up integration with Active Directory.

• Install security certificates.

• Manage and install available Small Office Security updates.

• View the Small Office Security license key details.

3.4.1. Mail Server
Control Center requires an external mail server to send email communications.
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Note
It is recommended to create a dedicated mail account to be used by Control Center.

To enable Control Center to send emails:

1. Go to the Configuration page.

2. Select the Mail Server tab.

3. Select Mail Server Settings and configure the required settings:

• Mail server (SMTP). Enter the IP address or hostname of the mail server that is going
to send the emails.

• Port. Enter the port used to connect to the mail server.

• Encryption type. If the mail server requires an encrypted connection, choose the
appropriate type from the menu (SSL, TLS or STARTTLS).

• From email. Enter the email address that you want to appear in the From field of the
email (sender's email address).

• Use authentication. Select this check box if the mail server requires authentication.
You must specify a valid username / email address and password.

4. Click Save.

Control Center automatically validates the mail settings when you save them. If the provided
settings cannot be validated, an error message informs you of the incorrect setting. Correct
the setting and try again.

3.4.2. Proxy
If your company connects to the Internet through a proxy server, you must configure the
proxy settings:

1. Go to the Configuration page.

2. Select the Proxy tab.

3. Select Use Proxy Settings and configure the required settings:

• Address - type in the IP address of the proxy server.

• Port - type in the port used to connect to the proxy server.

• Username - type in a user name recognized by the proxy.

• Password - type in the valid password of the previously specified user.

4. Click Save.
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3.4.3. Miscellaneous
• Concurrent deployments. Administrators can remotely deploy security components

by running installation tasks. Use this option to specify the maximum number of
simultaneous deployments that can be performed at a time.

For example, if the maximum number of concurrent deployments is set to 10 and a
remote client installation task is assigned to 100 computers, Control Center will initially
send 10 installation packages through the network. In this case, the client installation is
performed simultaneously on amaximum number of 10 computers, all the other sub-tasks
being in pending state. As soon as a sub-task is done, another installation package is
sent, and so on.

• NTP Server Settings. The NTP server is used to synchronize time between all Small
Office Security appliances. A default NTP server address is provided, which you can
change in the NTP Server Address field.

Note
For the Small Office Security appliances to communicate with the NTP Server, 123 (UDP)
port must be open.

Click Save to save the changes.

3.4.4. Active Directory
Through Active Directory integration, the existing Active Directory inventory is imported into
Control Center, simplifying security deployment, management, monitoring and reporting.
Additionally, Active Directory users can be assigned different user roles in Control Center.

To integrate and synchronize Control Center with an Active Directory domain:

1. Go to the Configuration > Active Directory page in Control Center.

2. Select Synchronize with Active Directory and configure the required settings:
• Synchronization interval (in hours)
• Active Directory domain name (including the domain extension)
• Username and password of a domain administrator

3. Click Save.

Important
Whenever the user password changes, remember to also update it in Control Center.

3.4.5. Certificates
In order for your Small Office Security deployment to operate correctly, you must create and
add a number of security certificates in Control Center.
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Control Center supports the following certificate formats:

• PEM (.pem, .crt, .cer, .key)

• DER (.der, .cer)

• PKCS#7 (.p7b, .p7c)

• PKCS#12 (.p12, .pfx)

Note
Except for the Control Center security certificate, all other certificates are needed exclusively
for managing Apple iOS devices. If you do not plan to roll out iOSmobile device management,
you do not need to provide the corresponding certificates.

Adding Control Center Security Certificate

The Control Center Security certificate is needed to identify the Control Center web console
as a trusted website in the web browser. Control Center uses by default an SSL certificate
signed by Bitdefender. This built-in certificate is not recognized by web browsers and triggers
security warnings. To avoid browser security warnings, add an SSL certificate signed by
your company or by an external Certificate Authority (CA).

To add or update the Control Center certificate:

1. Go to the Configuration page.

2. Select the Certificates tab.

3. Click the certificate name.

4. Choose the certificate type (with separate or embedded private key).

5. Click the Add button next to the Certificate field and upload the certificate.

6. For certificates with separate private key, click the Add button next to the Private key
field and upload the private key.

7. If the certificate is password protected, enter the password in the corresponding field.

8. Click Save.

Adding Communication Server Certificate

The Communication Server certificate is used to secure communication between the
Communication Server and iOS mobile devices.

Requirements:

• This SSL certificate can be signed either by your company or by an external Certificate
Authority.

• The certificate common name must match exactly the domain name or IP address used
by mobile clients to connect to the Communication Server. This is configured as the
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external MDM address in the configuration interface of the Small Office Security appliance
console.

• Mobile clients must trust this certificate. For this, you must also add the iOS MDM Trust
Chain.

To add or update the Communication Server certificate:

1. Go to the Configuration page.

2. Select the Certificates tab.

3. Click the certificate name.

4. Choose the certificate type (with separate or embedded private key).

5. Click the Add button next to the Certificate field and upload the certificate.

6. For certificates with separate private key, click the Add button next to the Private key
field and upload the private key.

7. If the certificate is password protected, enter the password in the corresponding field.

8. Click Save.

Adding Apple MDM Push Certificate

The Apple MDM Push certificate is required by Apple to ensure secure communication
between the Communication Server and the Apple Push Notifications service (APNs) servers
when sending push notifications. Push notifications are used to prompt devices to connect
to the Communication Server when new tasks or policy changes are available.

Apple issues this certificate directly to your company, but it requires that your Certificate
Signing Request be signed by Bitdefender. Control Center provides a wizard to help you
easily obtain your Apple MDM Push certificate.

Note
You will need an Apple ID to obtain the certificate. If you do not have an Apple ID, you can
create one here. Make sure to validate your Apple ID and set a security question before
proceeding to obtain your Apple MDM Push certificate.

To add or update the Apple MDM Push certificate:

1. Go to the Configuration page.

2. Select the Certificates tab.

3. Click the certificate name and follow the wizard to obtain your certificate.

4. Obtain a Certificate Signing Request signed by Bitdefender. Two options are available:

• I need to generate a certificate signing request signed by Bitdefender. This is
the recommended option. Enter your company name, your full name and email
address, then click Generate to generate and download the signed request file.
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• I already have a certificate signing request and I need to get it signed by
Bitdefender. Upload your CSR file and the associated private key (specifying the
password protecting the private key, if any), then click Sign to have it sign by
Bitdefender and to download the signed request file.

Note
The private key is needed by the Communication Server when authenticating with
the APNs servers.

5. Request a push certificate from Apple. Click the Apple Push Certificates Portal link.
Sign in using your Apple ID and password, upload your Certificate Signing Request and
then download the Apple push certificate.

6. Import the Apple push certificate. Click Add Certificate and upload the certificate file
from your computer. Check the certificate details.

Click Finish.

Adding iOS MDM Identity and Profile Signing Certificate

The iOS MDM Identity and Profile Signing certificate is used by the Communication Server
to sign identity certificates and configuration profiles sent to mobile devices.

Requirements:

• It must be an Intermediate or End-Entity certificate, signed either by your company or
by an external Certificate Authority.

• Mobile clients must trust this certificate. For this, you must also add the iOS MDM Trust
Chain.

To add or update the iOS MDM Identity and Profile Signing certificate:

1. Go to the Configuration page.

2. Select the Certificates tab.

3. Click the certificate name.

4. Choose the certificate type (with separate or embedded private key).

5. Click the Add button next to the Certificate field and upload the certificate.

6. For certificates with separate private key, click the Add button next to the Private key
field and upload the private key.

7. If the certificate is password protected, enter the password in the corresponding field.

8. Click Save.
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Adding iOS MDM Trust Chain Certificates

The iOS MDM Trust Chain certificates are required on mobile devices to ensure they trust
the Communication Server certificate and the iOSMDM Identity and Profile Signing certificate.
The Communication Server sends this certificate to mobile devices during activation.

The iOS MDM Trust Chain must include all intermediate certificates up to the root certificate
of your company or to the intermediate certificate issued by the external Certificate Authority.

To add or update the iOS MDM Trust Chain certificates:

1. Go to the Configuration page.

2. Select the Certificates tab.

3. Click the certificate name.

4. Click the Add button next to the Certificate field and upload the certificate.

5. Click Save.

3.4.6. Managing Small Office Security Updates
Small Office Security includes an Update Server role, designed to serve as the centralized
update distribution point for your Small Office Security deployment. Update Server checks
for and downloads all available Small Office Security updates from the Bitdefender update
servers on the Internet, making them available in the local network.

Updating Small Office Security Appliance

To update the Small Office Security appliances installed in your environment and the
installation packages of the Small Office Security components, login with a company
administrator account and go to the Update > Product Update page.

Before any update, it is recommended that you check the Release Notes of the new version.
Release Notes are published on the Bitdefender Support Center and they contain useful
information, such as known issues or special instructions for performing the update.

You can view information about your Small Office Security deployment version and available
updates under Small Office Security Update. When an update is available, you can click
Update Now to upgrade the Small Office Security appliance to the latest version. The
upgrade might take a while. After the upgrade, make sure to clear the browser cache.

You can view information about the existing Small Office Security component packages
under Component Update. Available information includes current version, update version
(if any) and the status for update operations you initiate.

To update a Small Office Security component:

1. Select the check box corresponding to the component you want to update.
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2. Click the Update button at the right side of the table. The selected component will be
downloaded / updated. Refresh the table contents and check the corresponding status.
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4. Using Small Office Security
Appliance Console
The Small Office Security appliance comes with a basic configuration interface, available
from the management tool used to manage the virtualized environment where you have
deployed the appliance.

The following options are available:

• Configure Hostname and Domain Settings

• Configure Network Settings

• Configure Proxy Settings

• Configure Language

• Show Locally Installed Roles

• Configure Communication Server

Use the arrow keys and the Tab key to navigate through menus and options. Press Enter
to select a specific option.

4.1. Configure Hostname and Domain Settings
Communication with the Small Office Security roles is performed using the IP address or
DNS name of the appliance they are installed on. By default, the Small Office Security
components communicate using IP addresses. If you want to enable communication via
DNS names, you must configure Small Office Security appliances with a DNS name and
make sure it correctly resolves to the configured IP address of the appliance.

Prerequisites:

• Configure the DNS record in the DNS server.

• The DNS name must correctly resolve to the configured IP address of the appliance.
Therefore, you must make sure the appliance is configured with the correct IP address.

Besides configuring the hostname of the appliance, youmight also need to join it to a domain.

Important
The hostname setting is to be configured (if needed) only during initial setup. Changing the
hostname afterwards can cause communication errors with previously deployed clients.

To configure the hostname and domain settings:
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1. Access the appliance console from your virtualization management tool (for example,
vSphere Client).

2. From the main menu, select Configure Hostname and Domain Settings.

3. Select Configure hostname.

4. Enter the hostname of the appliance and the domain name.

5. Select OK to save the changes.

6. Select Configure domain.

7. Enter the username and password of a domain administrator.

8. Select OK to save the changes.

4.2. Configure Network Settings
You can configure the appliance to automatically obtain network settings from the DHCP
server or you can manually configure network settings. If you choose to use DHCP, you
must configure the DHCP Server to reserve a specific IP address for the appliance.

To configure the network settings:

1. Access the appliance console from your virtualization management tool (for example,
vSphere Client).

2. From the main menu, select Configure Network Settings.

3. Select the network interface (default eth0).

4. Select the configuration method:

• Configure network settings manually. You must specify the IP address, network
mask, gateway address and DNS server addresses.

• Obtain network settings automatically via DHCP. Use this option only if you have
configured the DHCP Server to reserve a specific IP address for the appliance.

5. You can check current IP configuration details or link status by selecting the corresponding
options.

4.3. Configure Proxy Settings
If the appliance connects to the Internet through a proxy server, you must configure the
proxy settings.

Note
The proxy settings can also be configured from Control Center, Configuration > Proxy
page. Changing the proxy settings in one location automatically updates them in the other
location too.
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To configure the proxy settings:

1. Access the appliance console from your virtualization management tool (for example,
vSphere Client).

2. From the main menu, select Configure Proxy Settings.

3. Select Configure proxy settings.

4. Enter the proxy server address. Use the following syntax:

• If the proxy server does not require authentication:

http(s)://<IP/hostname>:<port>

• If the proxy server requires authentication:

http(s)://<username>:<password>@<IP/hostname>:<port>

5. Select OK to save the changes.

4.4. Configure Language
To change the Command Line Interface language:

1. From the main menu, select Configure Language.

2. Select a language. A confirmation message will appear.

3. Select OK to save the changes.

4.5. Show Locally Installed Roles
The Small Office Security appliance is delivered with all the required roles (Database Server,
Update Server, Web Console and Communication Server). Each role is pre-installed on a
built-in component. You can view the IP of each role by selecting Show locally installed
roles from the appliance's main menu.

4.6. Configure Communication Server
Note
This configuration is only required for mobile device management and available only after
the initial set-up of the Small Office Security appliance.

In the default Small Office Security setup, mobile devices can be managed only when they
are directly connected to the corporate network (via Wi-Fi or VPN). This happens because
when enrolling mobile devices they are configured to connect to the local address of the
Communication Server appliance.

To be able to manage mobile devices over the Internet, no matter where they are located,
you must configure the Communication Server with a publicly reachable address.
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To be able to managemobile devices when they are not connected to the company network,
the following options are available:

• Configure port forwarding on the corporate gateway for the appliance running the
Communication Server role.

• Add an additional network adapter to the appliance running the Communication Server
role and assign it a public IP address.

In both cases, you must configure the Communication Server with the external address to
be used for mobile device management:

1. Access the appliance console from your virtualization management tool (for example,
vSphere Client).

2. From the main menu, select Configure Communication Server.

3. Select Configure MDM Server external address.

4. Enter the external address.

Use the following syntax: https://<IP/Domain>:<Port>.

• If you use port forwarding, you must enter the public IP address or domain name and
the port open on the gateway.

• If you use a public address for the Communication Server, you must enter the public
IP address or domain name and the Communication Server port. The default port is
8443.

5. Select OK to save the changes.
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5. Getting Started
Small Office Security solutions can be configured andmanaged via a centralizedmanagement
platform named Control Center. Control Center has a web-based interface, which you can
access by means of username and password.

5.1. Connecting to Control Center
Access to Control Center is done via user accounts. You will receive your login information
by email once your account has been created.

Prerequisites:

• Internet Explorer 9+, Mozilla Firefox 14+, Google Chrome 15+, Safari 5+
• Recommended screen resolution: 1024x768 or higher

To connect to Control Center:

1. In the address bar of your web browser, enter the IP address or the DNS hostname of
the Control Center appliance (using the https:// prefix).

2. Enter your user name and password.

3. Click Login.

Note
If you have forgotten your password, use the password recovery link to receive a new
password. You must provide the email address of your account.
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5.2. Control Center at a Glance
Control Center is organized so as to allow easy access to all the features. Use the menu bar
in the upper area to navigate through the console. Available features depend on the type of
user accessing the console.

The Dashboard

5.2.1. Control Center Overview
Users with company administrator role have full privileges over the Control Center
configuration and network security settings, while users with administrator role have access
to network security features, including users management.

According to their role, Small Office Security administrators can access the following sections
from the menu bar:

Dashboard
View easy-to-read charts providing key security information concerning your network.

Network
Install protection, apply policies to manage security settings, run tasks remotely and
create quick reports.

Policies
Create and manage security policies.

Reports
Get security reports concerning the managed clients.

Quarantine
Remotely manage quarantined files.
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Accounts
Manage the access to Control Center for other company employees.

Note
This menu is available only to users with Manage Users right.

Logs
Check the user activity log.

Configuration
Configure Control Center settings, such as mail server, proxy settings and security
certificates.

Note
This menu is available only to users with Manage Solution right.

Additionally, in the upper-right corner of the console, the Notifications icon provides
easy access to notification messages and also to the Notifications page.

By pointing to the username in the upper-right corner of the console, the following options
are available:

• My Account. Click this option to manage your user account details and preferences.
• Credentials Manager. Click this option to add andmanage the authentication credentials

required for remote installation tasks.
• Logout. Click this option to log out of your account.

On the lower-right corner of the console, the following links are available:

• Help and Support. Click this button to find help and support information.
• Help Mode. Click this button to enable a help feature providing expandable tooltips

boxes placed on Control Center items. You will easily find out useful information regarding
the Control Center features.

• Feedback. Click this button to display a form allowing you to edit and send your feedback
messages regarding your experience with Small Office Security.

5.2.2. Table Data
Tables are frequently used throughout the console to organize data into an easy-to-use
format.
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The Reports page - Reports Table

Navigating through Pages

Tables with more than 10 entries span on several pages. By default, only 10 entries are
displayed per page. To move through the pages, use the navigation buttons at the bottom
of the table. You can change the number of entries displayed on a page by selecting a
different option from the menu next to the navigation buttons.

Searching for Specific Entries

To easily find specific entries, use the search boxes available below the column headers.

Enter the search term in the corresponding field. Matching items are displayed in the table
as you type. To reset the table contents, clear the search fields.

Sorting Data

To sort data by a specific column, click the column header. Click the column header again
to revert the sorting order.

Refreshing Table Data

To make sure the console displays the latest information, click the Refresh button in the
bottom-left corner of the table.

5.2.3. Action Toolbars
In Control Center, action toolbars allow you to perform specific operations pertaining to the
section you are in. Each toolbar consists of a set of icons that is usually placed to the right
side of the table. For example, the action toolbar in theReports section allows you to perform
the following actions:

• Create a new report.

• Download reports generated by a scheduled report.
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• Delete a scheduled report.

The Reports page - Action Toolbars

5.2.4. Contextual Menu
The action toolbar commands are also accessible from the contextual menu. Right-click the
Control Center section you are currently using and select the command that you need from
the available list.

The Reports page - Contextual menu

5.2.5. Service Selector
As administrator or reporter, you can manage the Control Center services one at a time.
Select the service you want to work with from the services menu in the upper-right corner
of the page.

Note
The services menu is available only in the pages where it makes sense to filter data by service
type.

The services menu contains the following options:

• Computers (Security for Endpoints)

• Mobile Devices (Security for Mobile Devices)
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Note
You will see only the services you have permissions to view, permissions granted to you by
the administrator who added your user to Control Center.

5.3. Managing Your Account
To check or change your account details and settings:

1. Point to your username in the upper-right corner of the console and chooseMy Account.

The User Account menu

2. Under Account Details, correct or update your account details. If you use an Active
Directory user account, you cannot change account details.
• Username. The username is the unique identifier of a user account and cannot be

changed.
• Full name. Enter your full name.
• Email. This is your login and contact email address. Reports and important security

notifications are sent to this address. Email notifications are sent automatically
whenever important risk conditions are detected in the network.

• Password. A Change password link allows you to change your login password.

3. Under Settings, configure the account settings according to your preferences.
• Timezone. Choose from the menu the timezone of the account. The console will

display time information according to the selected timezone.
• Language. Choose from the menu the console display language.
• Session Timeout. Select the inactivity time interval before your user session will

expire.

4. Click Save to save the changes.

Note
You cannot delete your own account.

5.4. Changing Login Password
After your account has been created, you will receive an email with the login credentials.
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Unless you use Active Directory credentials to access Control Center, it is recommended
to do the following:

• Change the default login password first time you visit Control Center.
• Change your login password periodically.

To change the login password:

1. Point to your username in the upper-right corner of the console and chooseMy Account.
2. Under Account Details, click Change password.
3. Enter your current password and the new password in the corresponding fields.
4. Click Save to save the changes.
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6. Licensing and Registration
Small Office Security is licensed with a single key for all security services.

You can choose to test Small Office Security and decide if it is the right solution for your
organization. To activate your evaluation period, you must enter the evaluation license key
from the registration email in Control Center.

Note
Control Center is provided for free with any Small Office Security security service.

To continue using Small Office Security after the trial period expires, you must purchase a
license key and use it to register the product.

To purchase a license, contact a Bitdefender reseller or contact us by email at
enterprisesales@bitdefender.com. Please write your email in English in order for us to be
able to assist you promptly.

Small Office Security license key can be managed from the License page in Control Center.
When your current license key is about to expire, a message will appear in the console
informing you that it needs to be renewed. To enter a new license key or view the current
license details, go to the License page.

6.1. Finding a Reseller
Our resellers will assist you with all the information you need and help you choose the best
licensing option for you.

To find a Bitdefender reseller in your country:

1. Go to http://www.bitdefender.com/partners.

2. Go to Partner Locator.

3. The contact information of the Bitdefender partners should be displayed automatically.
If this does not happen, select the country you reside in to view the information.

4. If you do not find a Bitdefender reseller in your country, feel free to contact us by email
at enterprisesales@bitdefender.com. Please write your email in English in order for us to
be able to assist you promptly.

6.2. Checking Current License Details
To view your license details:
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1. Log in to Control Center using a company administrator account.

2. Go to the Configuration > License page.

The License page

3. In the table, you can view details about the license key.

• License key

• License key status

• Expiry date and remaining license period

• License usage count

6.3. Entering Your License Keys
You must enter a valid license key to use Small Office Security. To register your product or
to change the current license key:

1. Log in to Control Center using a company administrator account.

2. Go to the Configuration > License page.

3. Enter the license key in the corresponding field.

4. Click the Add button. The license key will be added to the list.

Note
You cannot delete the license key. You can only enter a new key; only one license key
can be active. When entering a new valid license key (for registering or upgrading the
product), the previous key is invalidated. All invalid keys are automatically removed from
the License page after a short period of time.
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7. Managing User Accounts
You can create the first Small Office Security user account during the initial Control Center
setup, after deploying the Small Office Security appliance. The initial Control Center user
account has company administrator role, with full rights over Control Center configuration
and network management. From this account you can create all the other user accounts
required for the management of your company's network.

This is what you need to know about Small Office Security user accounts:

• To allow other employees of the company to access Control Center, you can create
internal user accounts. You can assign user accounts with different roles, according to
their access level in the company.

• For each user account, you can customize the access to Small Office Security features
or to specific parts of the network it belongs to.

• All accounts with theManage Users right can create, edit and delete other user accounts.

• You can only manage accounts with equal privileges as your account, or lesser.

• You can create and manage user accounts in the Accounts page.

The Accounts page

Existing accounts are displayed in the table. For each user account, you can view:

– The username of the account (used to log in to Control Center).

– Email address of the account (used as a contact address). Reports and important
security notifications are sent to this address. Email notifications are sent automatically
whenever important risk conditions are detected in the network.

– User role (partner / company administrator / administrator / reporter / custom).
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– Small Office Security security services the user is allowed to manage (Computers,
Mobile Devices).

7.1. User Roles
A user role consists in a specific combination of user rights. When creating a user account,
you can choose one of the predefined roles or you can create a custom role, by selecting
certain user rights only.

Note
You can grant user accounts the same privileges as your account, or lesser.

The following user roles are available:

1. Company Administrator - Usually, a unique user account with Company Administrator
role is created for each company, with full access to all management features of the
Small Office Security solutions. A company administrator configures the Control Center
settings, manages the security services license keys, manages user accounts while also
having administrative privileges over the company's network security settings. Company
administrators can share or delegate their operational responsibilities to subordinate
administrator and reporter user accounts.

2. Administrator - Several accounts with Administrator role can be created for a company,
with administrative privileges over the company's entire Security for Endpoints deployment
or over a specific group of computers, including user management. Administrators are
responsible for actively managing the network security settings.

3. Reporter - Reporter accounts are internal read-only accounts. They only allow access
to reports and logs. Such accounts can be allocated to personnel with monitoring
responsibilities or to other employees who must be kept up-to-date with security status.

4. Custom - Predefined user roles include a certain combination of user rights. If a
predefined user role does not fit your needs, you can create a custom account by selecting
only the rights that you are interested in.

The following table summarizes the relationships between different account roles and their
rights. For detailed information, refer to “User Rights” (p. 38).

User RightsAllowed Child AccountsAccount Role

Manage SolutionCompany Administrators,
Administrators, Reporters

Company Administrator

Manage Company

Manage Users

Manage Networks

Manage Reports
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User RightsAllowed Child AccountsAccount Role

Manage UsersAdministrators, ReportersAdministrator

Manage Networks

Manage Reports

Manage Reports-Reporter

7.2. User Rights
You can assign the following user rights to Small Office Security user accounts:

• Manage Solution. Allows to configure Control Center settings (mail server and proxy
settings, security certificates and Small Office Security updates). This privilege is specific
to company administrator accounts.

• Manage Users. Create, edit or delete user accounts.

• Manage Company. Users can manage their own Small Office Security license key and
edit their company profile settings. This privilege is specific to company administrator
accounts.

• Manage Networks. Provides administrative privileges over the network security settings
(network inventory, policies, tasks, installation packages, quarantine). This privilege is
specific to administrator accounts.

• Manage Reports. Create, edit, delete reports and manage dashboard.

7.3. Creating User Accounts
Before creating a non-Active Directory user account, make sure you have the required email
address at hand. The user will receive the Small Office Security login details at the supplied
email address.

To create a user account:

1. Go to the Accounts page.

2. Click the Add button at the right side of the table. A configuration window is displayed.

3. Under the Details section, fill in the account details.

• You can either add a user from Active Directory (provided Active Directory integration
is configured), or create a custom user.

– To add a user from Active Directory, select Import from Active Directory option.
You can then specify the user account in the Username field.
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When adding a user from Active Directory, user details are imported from Active
Directory. The user will log in to Control Center using the Active Directory user
password.

Note
• By default, Control Center is automatically synchronized with Active Directory

by a specified interval. To make sure the latest Active Directory changes are
imported in Control Center, click the Synchronize button.

• Users with Manage Solution right can configure the Active Directory
synchronization interval. For more details, refer to “Active Directory” (p. 17)

– To create a custom user, disable the Import from Active Directory option and
fill in the user's username, email address, full name and password.

Note
• The password must contain at least one upper case character, at least one

lower case character and at least one digit or special character.

• The email address must be unique. You cannot create another user account
with the same email address.

4. Under the Settings and Privileges section, configure the following settings:

• Timezone. Choose from the menu the timezone of the account. The console will
display time information according to the selected timezone.

• Language. Choose from the menu the console display language.

• Role. Select the user's role. For details regarding the user roles, refer to “User Roles”
(p. 37).

• Rights. Each predefined user role has a certain configuration of rights. However, you
can select only the rights that you need. In this case, the user role changes toCustom.
For details regarding the user rights, refer to “User Rights” (p. 38).

• Select Targets. Scroll down the configuration window to display the targets section.
Select the network groups the user will have access to for each available security
service. You can restrict the user access to a certain Small Office Security security
service or to specific areas of the network.

Note
The target selection options will not be displayed for users with Manage Solution
right, which, by default, have privileges over the entire network and security services.

Important
Whenever you make changes to your network structure, remember to also review
and update access privileges for existing users.
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5. Click Save to add the user. The new account will appear in the user accounts list.

Control Center automatically sends the user an email with the login details, provided the
mail server settings have been properly configured.

7.4. Editing Accounts
Edit accounts to keep account details up to date or to change account settings.

To edit a user account:

1. Log in to Control Center.
2. Go to the Accounts page.
3. Click the user's name.
4. Change account details and settings as needed.
5. Click Save to save the changes.

Note
All accounts with the Manage Users right can create, edit and delete other user accounts.
You can only manage accounts with equal privileges as your own account, or lesser.

7.5. Deleting Accounts
Delete accounts when they are no longer needed. For example, if the account owner is no
longer with the company.

To delete an account:

1. Log in to Control Center.
2. Go to the Accounts page.
3. Select the account from the list.
4. Click the Delete button at the right side of the table.

7.6. Resetting Login Passwords
Accounts owners who forget their password can reset it by using the password recovery
link on the login page. You can also reset a forgotten login password by editing the
corresponding account from the console.

To reset the login password for a user:

1. Log in to Control Center.
2. Go to the Accounts page.
3. Click the user's name.
4. Type a new password in the corresponding fields (under Details).
5. Click Save to save the changes. The account owner will receive an email with the new

password.
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8. Install Security Services
To protect your network with Bitdefender, you must install the Small Office Security security
services. To install the Small Office Security security services, you need a Control Center
user with administrator privileges over all services and over the entire network. You also
need administrator access to the network computers.

The following table shows the type of network objects each service is designed to protect:

Network ObjectsService

Computers (workstations, laptops and servers) running on
Microsoft Windows

Security for Endpoints

iPhone, iPad and Android devicesSecurity for Mobile Devices

8.1. Installing Security for Endpoints
Security for Endpoints is intended for computers and laptops running on Windows and Mac
OS X operating systems and Windows servers. To protect your physical computers with
Security for Endpoints, you must install Endpoint Security (the client software) on each of
them. Endpoint Security manages protection on the local computer. It also communicates
with Control Center to receive the administrator's commands and to send the results of its
actions.

You can install Endpoint Security with one of the following roles (available in the installation
wizard):

1. Endpoint, when the corresponding computer is a regular endpoint in the network.

2. Endpoint Security Relay, when the corresponding computer is used by other endpoints
in the network to communicate with Control Center. Endpoint Security Relay role installs
Endpoint Security together with an update server, which can be used to update all the
other clients in the network. Endpoints in the same network can be configured via policy
to communicate with Control Center through one or several computers with Endpoint
Security Relay role. Thus, when an Endpoint Security Relay is unavailable, the next one
is taken into account to assure the computer's communication with Control Center.

You can install Endpoint Security on computers by running installation packages locally or
by running installation tasks remotely from Control Center.

It is very important to carefully read and follow the instructions to prepare for installation.

Endpoint Security has a minimal user interface. It only allows users to check protection
status and run basic security tasks (updates and scans), without providing access to settings.
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By default, the display language of the user interface on protected computers is set at
installation time based on the language of your account.

To install the user interface in another language on certain computers, you can create an
installation package and set the preferred language in the package configuration options.
For more information on creating installation packages, refer to “Creating Endpoint Security
Installation Packages” (p. 43).

8.1.1. Preparing for Installation
Before installation, follow these preparatory steps to make sure it goes smoothly:

1. Make sure the computers meet the minimum system requirements. For some computers,
you may need to install the latest operating system service pack available or free up disk
space. Compile a list of computers that do not meet the necessary requirements so that
you can exclude them from management.

2. Uninstall (not just disable) any existing antimalware, firewall or Internet security software
from computers. Running Endpoint Security simultaneously with other security software
on a computer may affect their operation and cause major problems with the system.

Many of the security programs Endpoint Security is incompatible with are automatically
detected and removed at installation time. To learn more and to check the list of detected
security software, refer to this KB article.

Important
No need to worry aboutWindows security features (Windows Defender, Windows Firewall),
as they will be turned off automatically before installation is initiated.

3. The installation requires administrative privileges and Internet access. Make sure you
have the necessary credentials at hand for all computers.

4. Computers must have network connectivity to the Control Center appliance.

8.1.2. Local Installation
One way to install Endpoint Security on a computer is to locally run an installation package.

You can create and manage installation packages according to your needs in the Network
> Packages page.

The Network > Packages menu
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Once the first client has been installed, it will be used to detect other computers in the same
network, based on the Network Discovery mechanism. For detailed information on network
discovery, refer to “How Network Discovery Works” (p. 51).

To locally install Endpoint Security on a computer, follow the next steps:

1. Create an installation package according to your needs.

Note
This step is not mandatory if an installation package has already been created for the
network under your account.

2. Download the installation package on the computer.
3. Run the installation package on the computer.

Creating Endpoint Security Installation Packages

To create an Endpoint Security installation package:

1. Connect and log in to Control Center using your account.

2. Go to the Network > Packages page.

The Packages page

3. Click the Add button at the right side of the table and choose Endpoint Security from
the menu. A configuration window will appear.
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Create Endpoint Security Packages - Options

4. Enter a suggestive name and description for the installation package you want to create.

5. Select the target computer role:

• Endpoint. Select this option to create the package for a regular endpoint.

• Endpoint Security Relay. Select this option to create the package for an endpoint
with Endpoint Security Relay role. Endpoint Security Relay is a special role which
installs an update server on the target machine along with Endpoint Security, which
can be used to update all the other clients in the network, lowering the bandwidth
usage between the client machines and the Small Office Security appliance.

6. Select the protection modules you want to install.

7. From the Language field, select the desired language for the client's interface.

8. Select Scan before installation if you want to make sure the computers are clean before
installing the Endpoint Security on them. An on-the cloud quick scan will be performed
on the corresponding computers before starting the installation.
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9. Endpoint Security is installed in the default installation directory on the selected
computers. Select Use custom installation path if you want to install the Endpoint
Security in a different location. In this case, enter the desired path in the corresponding
field. Use Windows conventions when entering the path (for example, D:\folder). If
the specified folder does not exist, it will be created during the installation.

10. If you want to, you can set a password to prevent users from removing protection. Select
Set uninstall password and enter the desired password in the corresponding fields.

11. Click Next.

12. Depending on the installation package role (Endpoint or Endpoint Security Relay), choose
the entity to which the target computers will periodically connect to update the client:

• Small Office Security Appliance, available for both roles. You can also configure
the Communication Server and local update addresses in the following fields, if
required.

To change the local update address, use one of these syntaxes:

Note
The update address configured here is used temporarily after installation. As soon
as a policy is applied to the client, the update location is changed according to policy
settings. To make sure the client continues to update from the same update address,
configure it accordingly in the policy settings.

– update_server_ip:port
– update_server_name:port

• Endpoint Security Relay, if you want to connect the endpoints to an Endpoint Security
Relay installed in your network. All computers with Endpoint Security Relay role
detected in your network will show-up in the table displayed below. Select the Endpoint
Security Relay that you want. Connected endpoints will communicate with Control
Center only via the specified Endpoint Security Relay.

Important
Port 7074 must be open for the deployment through Endpoint Security Relay to work.

13. Click Save.

You can find the new installation package in the list of packages.

Downloading Installation Packages

To download Endpoint Security installation packages:

1. Log in to Control Center from the computer on which you want to install protection.

2. Go to the Network > Packages page.

Install Security Services 45

ENTERPRISE BITDEFENDER SMALL OFFICE SECURITY



3. Select the Endpoint Security installation package you want to download.

4. Click the Download button at the right side of the table and select the type of installer
you want to use. Two types of installation files are available:

• Downloader. The downloader first downloads the full installation kit from the Control
Center appliance and then starts the installation. It is small in size and it can be run
both on 32-bit and 64-bit systems (which makes it easy to distribute).

• Full Kit. The full installation kits are bigger in size and they have to be run on the
corresponding operating system type.

Note
Available full kit versions:

– Windows OS: 32-bit and 64-bit systems

– Mac OS X: only 64-bit systems
Make sure to use the correct version for the computer you install on.

5. Save the file to the computer.

Running Installation Packages

For installation to work, the installation package must be run using administrator privileges
or under an administrator account.

1. Connect and log in to Control Center.

2. Download or copy the installation file to the target computer or to a network share
accessible from that computer.

3. Run the installation package.

4. Follow the on-screen instructions.

Once Endpoint Security has been installed, the computer will show up as managed in Control
Center (Network page) within a few minutes.

8.1.3. Remote Installation
Control Center allows you to remotely install Endpoint Security on Active Directory computers
and on other computers detected in the network by using installation tasks.

Once Endpoint Security is installed on a computer, it may take a few minutes for the rest of
the network computers to become visible in Control Center.

Endpoint Security includes an automatic network discovery mechanism that allows detecting
computers that are not in Active Directory. Detected computers are displayed as unmanaged
computers in the Network page, Computers section, under Custom Groups. Control
Center automatically removes Active Directory computers from the detected computers list.
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To enable network discovery, you must have Endpoint Security already installed on at least
one computer in the network. This computer will be used to scan the network and install
Endpoint Security on unprotected computers.

For detailed information on network discovery, refer to “How Network Discovery Works” (p.
51).

Remote Endpoint Security Installation Requirements

For remote installation to work:

• Each target computer must have the admin$ administrative share enabled. Configure
each target workstation to use advanced file sharing.

• Temporarily turn off User Account Control on all computers running Windows operating
systems that include this security feature (Windows Vista, Windows 7, Windows Server
2008 etc.). If the computers are in a domain, you can use a group policy to turn off User
Account Control remotely.

• Disable or shutdown firewall protection on computers. If the computers are in a domain,
you can use a group policy to turn off Windows Firewall remotely.

Running Remote Endpoint Security Installation Tasks

To run a remote installation task:

1. Connect and log in to Control Center.

2. Go to the Network page.

3. Choose Computers from the service selector.

4. Select the desired network group from the left-side pane. The entities contained in the
selected group are displayed in the right-side pane table.

Note
Optionally, you can apply filters to display unmanaged computers only. Click the Filters
button and select the following options: Unmanaged from the Security category and
All items recursively from the Depth category.

5. Select the entities (computers or groups of computers) on which you want to install
protection.

6. Click the Tasks button at the right-side of the table and choose Install client. The
Install Client wizard is displayed.
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Installing Endpoint Security from the Tasks menu

7. Configure the installation options:

• Select the role you want the client to have:

– Endpoint. Select this option if you want to install the client on a regular endpoint.

– Endpoint Security Relay. Select this option to install the client with Endpoint
Security Relay role on the target computer. Endpoint Security Relay is a special
role which installs an update server on the target machine along with Endpoint
Security, which can be used to update all the other clients in the network, lowering
the bandwidth usage between the client machines and the Small Office Security
appliance.

• Select the protection modules you want to install. Please note that only antimalware
protection is available for server operating systems.

• From the Language field, select the desired language for the client's interface.

• Select Scan before installation if you want to make sure the computers are clean
before installing the Endpoint Security on them. An on-the cloud quick scan will be
performed on the corresponding computers before starting the installation.

• Endpoint Security is installed in the default installation directory on the selected
computers. Select Use custom installation path if you want to install the Endpoint
Security in a different location. In this case, enter the desired path in the corresponding
field. Use Windows conventions when entering the path (for example, D:\folder).
If the specified folder does not exist, it will be created during the installation.
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• During the silent installation, the computer is scanned for malware. Sometimes, a
system restart may be needed to complete malware removal.

SelectAutomatically reboot (if needed) to make sure detectedmalware is completely
removed before installation. Otherwise, installation may fail.

• If you want to, you can set a password to prevent users from removing protection.
Select Set uninstall password and enter the desired password in the corresponding
fields.

• Select Additional targets if you want to deploy the client to specific machines from
your network that are not shown in the network inventory. Enter the IP addresses or
the hostnames of those machines in the dedicated field, separated by a comma. You
can add as many IPs as you need.

• Click Next.

• In theConnection tab, choose the entity through which the clients will communicate:

– Small Office Security Appliance. You can also configure the Communication
Server and local update addresses in the following fields, if required.

To change the local update address, use one of these syntaxes:
• update_server_ip:port
• update_server_name:port

Note
The update address configured here is used temporarily after installation. As
soon as a policy is applied to the client, the update location is changed according
to policy settings. To make sure the client continues to update from the same
update address, configure it accordingly in the policy settings.

– Endpoint Security Relay, if you want to connect the endpoints to an Endpoint
Security Relay installed in your network. All computers with Endpoint Security
Relay role detected in your network will show-up in the table displayed below.
Select the Endpoint Security Relay that you want. Connected endpoints will
communicate with Control Center only via the specified Endpoint Security Relay.

Important
Port 7074 must be open for the deployment through Endpoint Security Relay to
work.
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8. Click Next.

9. Under the Credentials Manager section, specify the administrative credentials required
for remote authentication on selected endpoints. You can add the required credentials
by entering the user and password of each target operating system.

Note
A warning message is displayed as long as you have not selected any credentials. This
step is mandatory to remotely install the Endpoint Security on computers.

To add the required OS credentials:
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a. Enter the user name and password of an administrator account for each target
operating system in the corresponding fields. Optionally, you can add a description
that will help you identify each account more easily. If computers are in a domain, it
suffices to enter the credentials of the domain administrator.

Use Windows conventions when entering the name of a domain user account, for
example, user@domain.com or domain\user. Tomake sure that entered credentials
will work, add them in both forms (user@domain.com and domain\user).

Note
Specified credentials are automatically saved to your Credentials Manager so that
you do not have to enter them the next time.

b. Click the Add button. The account is added to the list of credentials.

c. Select the check box corresponding to the account you want to use.

10. Click Save. A confirmation message will appear.

You can view and manage the task in the Network > Tasks page.

8.1.4. How Network Discovery Works
Besides integration with Active Directory, Security for Endpoints also includes an automatic
network discovery mechanism intended to detect workgroup computers.

Security for Endpoints relies on the Microsoft Computer Browser service to perform
network discovery. The Computer Browser service is a networking technology used by
Windows-based computers to maintain updated lists of domains, workgroups, and the
computers within them and to supply these lists to client computers upon request. Computers
detected in the network by the Computer Browser service can be viewed by running the net
view command in a command prompt window.

The Net view command

To enable network discovery, you must have Endpoint Security already installed on at least
one computer in the network. This computer will be used to scan the network.
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Important
Control Center does not use network information from Active Directory or from the network
map feature available in Windows Vista and later. Network map relies on a different network
discovery technology: the Link Layer Topology Discovery (LLTD) protocol.

Control Center is not actively involved in the Computer Browser service operation. Endpoint
Security only queries the Computer Browser service for the list of workstations and servers
currently visible in the network (known as the browse list) and then sends it to Control Center.
Control Center processes the browse list, appending newly detected computers to its
Unmanaged Computers list. Previously detected computers are not deleted after a new
network discovery query, so you must manually exclude & delete computers that are no
longer on the network.

The initial query for the browse list is carried out by the first Endpoint Security installed in
the network.

• If Endpoint Security is installed on a workgroup computer, only computers from that
workgroup will be visible in Control Center.

• If Endpoint Security is installed on a domain computer, only computers from that domain
will be visible in Control Center. Computers from other domains can be detected if there
is a trust relationship with the domain where Endpoint Security is installed.

Subsequent network discovery queries are performed regularly every hour. For each new
query, Control Center divides the managed computers space into visibility areas and then
designates one Endpoint Security in each area to perform the task. A visibility area is a group
of computers that detect each other. Usually, a visibility area is defined by a workgroup or
domain, but this depends on the network topology and configuration. In some cases, a
visibility area might consist of multiple domains and workgroups.

If a selected Endpoint Security fails to perform the query, Control Center waits for the next
scheduled query, without choosing another Endpoint Security to try again.

For full network visibility, Endpoint Security must be installed on at least one computer in
each workgroup or domain in your network. Ideally, Endpoint Security should be installed
on at least one computer in each subnetwork.

More about the Microsoft Computer Browser Service

Quick facts about the Computer Browser service:

• Works independent of Active Directory.

• Runs exclusively over IPv4 networks and operates independently within the boundaries
of a LAN group (workgroup or domain). A browse list is compiled and maintained for
each LAN group.

• Typically uses connectionless server broadcasts to communicate between nodes.

• Uses NetBIOS over TCP/IP (NetBT).
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• Requires NetBIOS name resolution. It is recommended to have aWindows Internet Name
Service (WINS) infrastructure up and running in the network.

• Is not enabled by default in Windows Server 2008 and 2008 R2.

For detailed information on the Computer Browser service, check the Computer Browser
Service Technical Reference on Microsoft Technet.

Network Discovery Requirements

In order to successfully discover all the computers (servers and workstations) that will be
managed from Control Center, the following are required:

• Computers must be joined in a workgroup or domain and connected via an IPv4 local
network. Computer Browser service does not work over IPv6 networks.

• Several computers in each LAN group (workgroup or domain) must be running the
Computer Browser service. Primary Domain Controllers must also run the service.

• NetBIOS over TCP/IP (NetBT) must be enabled on computers. Local firewall must allow
NetBT traffic.

• File sharing must be enabled on computers. Local firewall must allow file sharing.

• A Windows Internet Name Service (WINS) infrastructure must be set up and working
properly.

• For Windows Vista and later, network discovery must be turned on (Control Panel >
Network and Sharing Center > Change Advanced Sharing Settings).

To be able to turn on this feature, the following services must first be started:
– DNS Client
– Function Discovery Resource Publication
– SSDP Discovery
– UPnP Device Host

• In environments with multiple domains, it is recommended to set up trust relationships
between domains so that computers can access browse lists from other domains.

Computers from which Endpoint Security queries the Computer Browser service must be
able to resolve NetBIOS names.

Note
The network discovery mechanism works for all supported operating systems, including
Windows Embedded versions, provided the requirements are met.
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8.2. Installing Security for Mobile Devices
Security for Mobile Devices is a mobile device management solution designed for iPhone,
iPad and Android devices. For a complete list of supported operating system versions, check
the system requirements.

Security for Mobile Devices is managed in Control Center by adding mobile devices to
specific users and then installing the GravityZone Mobile Client application on devices. You
can add mobile devices to existing Active Directory users or you can create custom users
to add the devices to.

Before you start, make sure to configure a public (external) address for the Communication
Server.

To install Security for Mobile Devices:

1. If you do not have integration with Active Directory, you must create users for mobile
device owners.

2. Add devices to users.

3. Install GravityZone Mobile Client on devices and activate it.

8.2.1. Configure External Address for Communication Server
In the default Small Office Security setup, mobile devices can be managed only when they
are directly connected to the corporate network (via Wi-Fi or VPN). This happens because
when enrolling mobile devices they are configured to connect to the local address of the
Communication Server appliance.

To be able to manage mobile devices over the Internet, no matter where they are located,
you must configure the Communication Server with a publicly reachable address.

To be able to managemobile devices when they are not connected to the company network,
the following options are available:

• Configure port forwarding on the corporate gateway for the appliance running the
Communication Server role.

• Add an additional network adapter to the appliance running the Communication Server
role and assign it a public IP address.

In both cases, you must configure the Communication Server with the external address to
be used for mobile device management:

1. Access the appliance console from your virtualization management tool (for example,
vSphere Client).

2. From the main menu, select Configure Communication Server.
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Application Options window

3. Select Configure MDM Server external address.

Configure Communication Server window

4. Enter the external address.

Use the following syntax: https://<IP/Domain>:<Port>.

MDM Server external address input window

• If you use port forwarding, you must enter the public IP address or domain name and
the port open on the gateway.

• If you use a public address for the Communication Server, you must enter the public
IP address or domain name and the Communication Server port. The default port is
8443.

5. Select OK to save the changes.
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8.2.2. Create and Organize Custom Users
In non-Active Directory situations, you must first create custom users in order to have a
mean to identify the owners of mobile devices. Specified mobile device users are not linked
in any way with Active Directory or with other users defined in Control Center.

Creating Custom Users

To create a custom user:

1. Go to the Network page.

2. From the menu in the upper-right corner of the page, choose Mobile Devices.

3. In the left-side pane, select Custom Groups.

Network - Mobile devices page - Users view

4. Click the Add User icon on the action toolbar. A configuration window will appear.

5. Specify the required user details:
• A suggestive username (for example, the user's full name)
• User's email address

Important
Make sure to provide a valid email address. The user will be sent the installation
instructions by email when you add a device.

6. Click OK.
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Organizing Custom Users

To organize custom users:

1. Create custom groups.

a. Select Custom Groups in the left-side pane and click the Add Group icon on the
action toolbar (above the pane).

b. Enter a suggestive name for the group and click OK. The new group is displayed
under Custom Groups.

2. Move custom users into appropriate custom groups.

a. Select users in the right-side pane.

b. Drag and drop the selection over the desired group in the left-side pane.

8.2.3. Add Devices to Users
To add a device to a user:

1. Go to the Network page.

2. From the menu in the upper-right corner of the page, choose Mobile Devices.

3. Search the user in the Active Directory folders or in Custom Groups.

4. Click the Add Device icon on the action toolbar. A configuration window will appear.

Add mobile device to a user

5. Enter a suggestive name for the device.

6. Use the Auto-configure name option if you want the device name to be automatically
generated. Once this option is enabled, the device name cannot be edited, instead a
default name is automatically assigned.
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7. Select the device ownership type (Enterprise or Personal).

8. Select the Show activation credentials option after clicking the OK button if you are
going to install the GravityZone Mobile Client on the user's device.

9. Click OK. The user is immediately sent an email with the installation instructions and the
activation details to be configured on the device. The activation details include the
activation token and the communication server address (and corresponding QR code).

Note
You can view the activation details of a device at any time by clicking its name in Control
Center.

Note
You can also add mobile devices to a selection of users and groups. In this case, the
configuration window will allow defining the devices ownership only. Mobile devices
created by multiple selection will be given by default a generic name. As soon as a device
is enrolled, its name will automatically change, including the corresponding manufacturer
and model labels.

8.2.4. Install GravityZone Mobile Client on Devices
The GravityZone Mobile Client application is exclusively distributed via Apple App Store and
Google Play.

To install GravityZone Mobile Client on a device:

1. Search for the application on the official app store.
• Google Play link
• Apple App Store link

2. Download and install the application on the device.

3. Start the application and make the required configuration:

a. On Android devices, tap Activate to enable GravityZone Mobile Client as device
administrator. Read carefully the provided information.

b. Enter the activation token and the communication server address or, alternatively,
scan the QR code received by email.

c. Tap Activate.

d. On iOS devices, you are prompted to install theMDMprofile. If your device is password
protected, you will be asked to provide it. Follow the on-screen instructions to
complete profile installation.
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9. Managing Network Objects
TheNetwork page provides several features for exploring andmanaging the entities available
for each service. TheNetwork view consists of a two-pane interface displaying the real-time
status of all network objects available for the selected service:

The Network Page

1. The left-side pane displays the available network tree structure. You can view in this
pane the Active Directory network objects. For more information, refer to “Active
Directory” (p. 17).

You can organize non-Active Directory network objects under Custom Groups.

Note
You can view and manage only the groups on which you have administrator rights.

2. The right-side pane displays the contents of the group that you have selected in the
network tree. This pane consists of a grid, where the rows contain network objects and
the columns display specific information for each type of object.

From this pane, you can do the following:

• View detailed information about each network object under your account. You can
view the status of each object by checking the icon next to its name. Click the object's
name to display a window containing more specific details.

• Use the Action Toolbar at the right-side of the table to carry out specific operations
for each network object (such as run tasks, create reports, assign policies and delete).

• Refresh table data.
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From the Network section you can also manage the installation packages and the list of
tasks for each type of network object.

For detailed information, refer to:

• “Managing Computers” (p. 60)
• “Managing Mobile Devices” (p. 87)
• “Viewing and Managing Tasks” (p. 114)
• “Installation Packages” (p. 110)
• “Credentials Manager” (p. 117)

9.1. Managing Computers
To view the computers under your account, go to theNetwork page and chooseComputers
from the service selector.

You can view the available computer network in the left-side pane and details about each
computer in the right-side pane.

From the Network section, you can manage computers as follows:

• Check the computer status.
• Organize computers into groups.
• View computer details.
• Sort, filter and search for computers.
• Run tasks on computers.
• Create quick reports.
• Assign policies.
• Synchronize with Active Directory.
• Delete computers from network inventory.

9.1.1. Check the Computer Status
Each computer is represented in the network page by an icon specific to the computer's
status. View the computer statuses and the corresponding icons in the following table:

StatusIcon

Computer, Managed, No issues, Online

Computer, Managed, With security issues, Online,

Computer, Managed, No issues, Offline

Computer, Managed, With security issues, Offline

Unmanaged

Deleted
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For detailed information, refer to:

• “Managed, Unmanaged and Deleted Computers” (p. 61)

• “Online and Offline Computers” (p. 61)

• “Computers with security issues” (p. 62)

Managed, Unmanaged and Deleted Computers

Computers can have different management statuses:

• Managed - computers on which the Endpoint Security protection is installed.

• Unmanaged - detected computers on which the Endpoint Security protection has
not been installed yet.

• Deleted - computers that you have deleted fromControl Center. For more information,
refer to “Deleting Computers from Network Inventory” (p. 85).

Online and Offline Computers

The connectivity status concerns only the managed computers. From this point of view,
managed computers can be:

• Online. A blue icon indicates that the computer is online.

• Offline. A grey icon indicates that the computer is offline.

A computer is offline if Endpoint Security is inactive for more than 5minutes. Possible reasons
why computers appear offline:

• Computer is shut down, sleeping or hibernating.

Note
Computers normally appear online even when they are locked or the user is logged off.

• Endpoint Security does not have connectivity with the Communication Server:

– Computer might be disconnected from the network.

– A network firewall or router might block the communication between Endpoint Security
and the Communication Server.

• Endpoint Security has been manually uninstalled from the computer, while the computer
did not have connectivity with the Communication Server.

• Endpoint Security might not be working properly.

To find out for how long computers have been inactive:
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1. Display only the managed computers. Click the Filters menu located above the table,
selectManaged (Endpoints) andManaged (Endpoint Security Relay) in the Security
category and click Save.

2. Click the Last Seen column header to sort computers by inactivity period.

You can ignore shorter periods of inactivity (minutes, hours) as they are likely the result of
a temporary condition. For example, the computer is currently shut down.

Longer inactivity periods (days, weeks) usually indicate a problem with the computer.

Computers with security issues

The security status concerns only the managed computers. Check the status icon displaying
a warning symbol to identify computers with security issues:

• Computer managed, with issues, online.

• Computer managed, with issues, offline.

A computer has security issues provided at least one of the following situations applies:

• Antimalware protection is disabled.

• The license of Endpoint Security has expired.

• Endpoint Security is outdated.

• Malware is detected.

If you notice a computer with security issues, click its name to display theComputer Details

page. You can identify the security issues by icon. Check the icon's tooltip to find out
more details. Further local investigations may be needed.

9.1.2. Organizing Computers into Groups
You can manage computer groups in the left-side pane of the Network page.

Computers imported from Active Directory are grouped under Active Directory folder. You
cannot edit the Active Directory groups. You can only view and manage the corresponding
computers.

All non-Active Directory computers detected by Network Discovery are placed underCustom
Groups, where you are can organize them into groups as you want. For more information
regarding network discovery, refer to “How Network Discovery Works” (p. 51)

A major benefit is that you can use group policies to meet different security requirements.

Under Custom Groups you can create, delete, rename and move computer groups within
a custom-defined tree structure.
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Important
Please note the following:

A group can contain both computers and other groups.•

• When selecting a group in the left-side pane, you can view all computers except those
placed into its sub-groups. To view all computers included in the group and in its
sub-groups, click the Filters menu located above the table and select All items
recursively in the Depth section.

Creating Groups

Before you start creating groups, think of the reasons why you need them and come up with
a grouping scheme. For example, you can group computers based on one or a mix of the
following criteria:

• Organization structure (Sales, Marketing, Quality Assurance, Software Development,
Management etc.).

• Security needs (Desktops, Laptops, Servers, etc.).

• Location (Headquarter, Local Offices, Remote Workers, Home Offices etc.).

To organize your network into groups:

1. Select Custom Groups in the left-side pane.

2. Click the Add group button at the top of the left-side pane.

3. Enter a suggestive name for the group and click OK. The new group is displayed under
Custom Groups.

Renaming Groups

To rename a group:

1. Select the group in the left-side pane.

2. Click the Edit group button at the top of the left-side pane.

3. Enter the new name in the corresponding field.

4. Click OK to confirm.

Moving Groups and Computers

You canmove groups and users anywhere in theCustomGroups inside the group hierarchy.
To move a group or a user, drag and drop it from the current location to the new one.
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Note
The entity that is moved will inherit the policy settings of the new parent group, unless a
different policy has been assigned to it. For more information about policy inheritance, refer
to “” (p. 122).

Deleting Groups

A group cannot be deleted if it contains at least one computer. Move all computers from
the group you want to delete to another group. If the group includes sub-groups, you can
choose to move all sub-groups rather than individual computers.

To delete a group:

1. Select the empty group in the right side pane of the Network page.

2. Click the Remove group button at the top of the left-side pane. You will have to
confirm your action by clicking Yes.

9.1.3. Viewing Computer Details
You can obtain detailed information about each computer from theNetwork page, including
OS, IP, last seen date and time, etc.

To find out details about a computer:

1. Go to the Network page.

2. Choose Computers from the service selector.

3. Select the desired group from the left-side pane.

All computers from the selected group are displayed in the right-side pane table.

4. You can easily identify the computer status by checking the corresponding icon. For
detailed information, refer to “Check the Computer Status” (p. 60).

5. Check the information displayed on columns for each computer:

• Name: computer name.

• OS: operating system installed on the computer.

• IP: computer's IP address.

• Last Seen: date and time when the computer was last seen online.

Note
It is important to monitor the Last Seen field as long inactivity periods might indicate
a communication issue or a disconnected computer.

• Label: the label added to the computer in the Computer Details window.
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6. Click the name of the managed computer you are interested in. The Computer Details
window is displayed.

• Go to Overview tab to find the following details:

– General computer information, such as name, IP address, operating system, parent
group and current status. You can also assign the computer with a label. You can
therefore search and filter computers by label using the Label column search field
from right-side table of the Network page.

– Security details related to the Endpoint Security installed on the selected computer,
such as installed modules, assigned policy, antimalware status, license status,
last update and detected malware in the last 24 hours. You can also obtain a quick
overview regarding the number of malware detections on computer in the current
day.

– Click Generate malware status report to access the malware report options for
the selected computer.

For more information, refer to “Creating Reports” (p. 190)

Note

Each property generating security issues is marked with icon. Check the icon's
tooltip to find out more details. Further local investigations may be needed.

Computer Details - Overview
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• Click the Scan logs tab to view detailed information about all scan tasks performed
on the computer. Click the scan report you are interested in to open it in a new page
of the browser.

To move through the pages, use the navigation options at the bottom of the table. If
there are too many entries, you can use the filter options available at the top of the
table.

Click the Refresh button in the bottom-left corner of the table to update the scan
logs list.

Computer Details - Scan Logs

• For computers with Endpoint Security Relay role, the Connected Clients tab is also
available, where you can view the list of connected endpoints.

Computer Details - Connected Clients
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9.1.4. Sorting, Filtering and Searching for Computers
Depending on the number of computers, the computers table can span several pages (only
10 entries are displayed per page by default). To move through the pages, use the navigation
buttons at the bottom of the table. To change the number of entries displayed on a page,
select an option from the menu next to the navigation buttons.

If there are too many entries, you can use the search boxes under the column headers or
the Filtersmenu at the top of the table to filter displayed data. For example, you can search
for a specific computer or choose to view only the managed computers.

Sorting Computers

To sort data by a specific column, click the column headers. For example, if you want to
order computers by name, click the Name heading. If you click the heading again, the
computers will be displayed in reverse order.

Sorting Computers

Filtering Computers

1. Select the desired group in the left-side pane.
2. Click the Filters menu located above the table.
3. Select the filter criteria as follows:

• Type. Select the type of entities you want to display (computers, folders or both).

Computers - Filter by Type
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• Security. Choose to display computers by management and security status.

Computers - Filter by Security

• Policy. Select the policy template you want to filter the computers by as well as the
policy assignment status (Assigned or Pending).

Computers - Filter by Policy

• Depth. When managing a tree-structure computer network, computers placed in
sub-groups are not displayed when selecting the root group. Select All items
recursively to view all computers included in the current group and in its sub-groups.
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Computers - Filter by Depth

Note
You can view all selected filter criteria in the lower part of the Filters window.
If you want to clear all filters, click the Reset button.

4. Click Save to filter the computers by the selected criteria. The filter remains active in the
Network page until you log out or reset the filter.

Searching for Computers

1. Select the desired group in the left-side pane.

2. Enter the search term in the corresponding box under the column headers (Name, OS
or IP) from the right-side pane. For example, enter the IP of the computer you are looking
for in the IP field. Only the matching computer will appear in the table.

Clear the search box to display the full list of computers.

Search for computers

9.1.5. Running Tasks on Computers
From the Network page, you can remotely run a number of administrative tasks on
computers.
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This is what you can do:

• “Scan” (p. 70)
• “Install Client” (p. 77)
• “Modify Installer” (p. 81)
• “Uninstall Client” (p. 81)
• “Update Client” (p. 82)
• “Restart Computer” (p. 82)
• “Network Discovery” (p. 83)

You can choose to create tasks individually for each computer or for groups of computers.
For example, you can remotely install the Endpoint Security on a group of unmanaged
computers. At a later time, you can create a scan task for a certain computer from the same
group.

For each computer, you can only run compatible tasks. For example, if you select an
unmanaged computer, you can only choose to Install client, all the other tasks being
disabled.

For a group, the selected task will be created only for compatible computers. If none of the
computers in the group is compatible with the selected task, you will be notified that the
task could not be created.

Once created, the task will start running immediately on online computers. If a computer is
offline, the task will run as soon as it gets back online.

You can view and manage the task in the Network > Tasks page. For more information,
refer to “Viewing and Managing Tasks” (p. 114).

Scan

To remotely run a scan task on one or several computers:

1. Go to the Network page.

2. Choose Computers from the service selector.

3. Select the desired group from the left-side pane. All computers from the selected group
are displayed in the right-side pane table.

4. Select the check boxes corresponding to the computers you want to scan.

5. Click the Task button at the right-side of the table and choose Scan.
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Computers Scan Task

A configuration window will appear.

6. Configure the scan options:

• In the General tab, you can choose the type of scan and you can enter a name for
the scan task. The scan task name is intended to help you easily identify the current
scan in the Tasks page.

Computers Scan task - Configuring general settings

Select the type of scan from the Type menu:

– Quick Scan uses in-the-cloud scanning to detect malware running in the system.
Running a Quick Scan usually takes less than a minute and uses a fraction of the
system resources needed by a regular virus scan.
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Note
Quick Scan only detects existing malware, without taking any action. If malware
is found during a Quick Scan, you must run a Full System Scan task to remove
detected malware.

– Full Scan checks the entire computer for all types of malware threatening its
security, such as viruses, spyware, adware, rootkits and others.

– Custom Scan allows you to choose the locations to be scanned and to configure
the scan options. To define a custom scan:

• Go to Options tab to set the scan options. Click the security level that best
suits your needs (Aggressive, Normal or Permissive). Use the description on
the right-side of the scale to guide your choice.

Based on the selected profile, the scan options in the Settings section are
automatically configured. However, if you want to, you can configure them in
detail. To do that, select the Custom check box and then go to the Settings
section.

Computers Scan Task

The following options are available:

– File Types. Use these options to specify which types of files you want to
be scanned. You can set Endpoint Security to scan all files (regardless of
their file extension), application files only or specific file extensions you
consider to be dangerous. Scanning all files provides best protection, while
scanning applications only can be used to perform a quicker scan.
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Note
Application files are far more vulnerable to malware attacks than other
types of files. For more information, refer to “List of Application File Types”
(p. 214).

If you want only specific extensions to be scanned, choose Custom
extensions from the menu and then enter the extensions in the edit field,
pressing Enter after each extension.

Computers scan task options - Adding custom extensions

– Archives. Archives containing infected files are not an immediate threat
to system security. The malware can affect the system only if the infected
file is extracted from the archive and executed without having real-time
protection enabled. However, it is recommended to use this option in order
to detect and remove any potential threat, even if it is not an immediate
threat.

Note
Scanning archived files increases the overall scanning time and requires
more system resources.

• Scan inside archives. Select this option if you want to check archived
files for malware. If you decide on using this option, you can configure
the following optimization options:

– Limit archive size to (MB). You can set a maximum accepted size
limit of archives to be scanned. Select the corresponding check box
and type the maximum archive size (in MB).

– Maximum archive depth (levels). Select the corresponding check
box and choose the maximum archive depth from the menu. For
best performance choose the lowest value, for maximum protection
choose the highest value.

• Scan email archives. Select this option if you want to enable scanning
of email message files and email databases, including file formats such
as .eml, .msg, .pst, .dbx, .mbx, .tbb and others.
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Note
Email archive scanning is resource intensive and can impact system
performance.

– Miscellaneous. Select the corresponding check boxes to enable the
desired scan options.

• Scan boot sectors. Scans the system’s boot sector. This sector of the
hard disk contains the necessary computer code to start the boot
process. When a virus infects the boot sector, the drive may become
inaccessible and you may not be able to start your system and access
your data.

• Scan registry. Select this option to scan registry keys. Windows
Registry is a database that stores configuration settings and options
for the Windows operating system components, as well as for installed
applications.

• Scan for rootkits. Select this option to scan for rootkits and objects
hidden using such software.

• Scan for keyloggers. Select this option to scan for keylogger software.

• Scan memory. Select this option to scan programs running in the
system's memory.

• Scan cookies. Select this option to scan the cookies stored by
browsers on the computer.

• Scan only new and changed files. By scanning only new and changed
files, you may greatly improve overall system responsiveness with a
minimum trade-off in security.

• Scan for Potentially Unwanted Applications (PUA). A Potentially
Unwanted Application (PUA) is a program that may be unwanted on the
PC and sometimes comes bundled with freeware software. Such
programs can be installed without the user's consent (also called adware)
or will be included by default in the express installation kit
(ad-supported). Potential effects of these programs include the display
of pop-ups, installing unwanted toolbars in the default browser or running
several processes in the background and slowing down the PC
performance.

– Actions. Depending on the type of detected file, the following actions are
taken automatically:

• When an infected file is found. Files detected as infected match a
malware signature in the Bitdefender Malware Signature Database.
Endpoint Security can normally remove the malware code from an
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infected file and reconstruct the original file. This operation is known as
disinfection.

If an infected file is detected, Endpoint Security will automatically attempt
to disinfect it. If disinfection fails, the file is moved to quarantine in order
to contain the infection.

Important
For particular types of malware, disinfection is not possible because
the detected file is entirely malicious. In such cases, the infected file
is deleted from the disk.

• When a suspect file is found. Files are detected as suspicious by the
heuristic analysis. Because B-HAVE is a heuristic analysis technology,
Endpoint Security cannot be sure that the file is actually infected with
malware. Suspect files cannot be disinfected, because no disinfection
routine is available.

Scan tasks are configured by default to ignore suspect files. You may
want to change the default action in order to move suspect files to
quarantine. Quarantined files are sent for analysis to Bitdefender Labs
on a regular basis. If malware presence is confirmed, a signature is
released to allow removing the malware.

• When a rootkit is found. Rootkits represent specialized software used
to hide files from the operating system. Though not malicious in nature,
rootkits are often used to hide malware or to conceal the presence of
an intruder into the system.

Detected rootkits and hidden files are ignored by default.

Though not recommended, you can change the default actions. You can
specify a second action to be taken if the first one fails and different actions
for each category. Choose from the corresponding menus the first and the
second action to be taken on each type of detected file. The following
actions are available:

Disinfect
Remove the malware code from infected files. It is recommended to
always keep this as the first action to be taken on infected files.

Move to quarantine
Move detected files from their current location to the quarantine folder.
Quarantined files cannot be executed or opened; therefore, the risk of
getting infected disappears. You can manage quarantine files from the
Quarantine page of the console.

Managing Network Objects 75

ENTERPRISE BITDEFENDER SMALL OFFICE SECURITY



Delete
Delete detected files from the disk, without any warning. It is advisable
to avoid using this action.

Ignore
No action will be taken on detected files. These files will only appear
in the scan log.

• Go to Target tab to add the locations you want to be scanned on the target
computers.

In the Scan target section you can add a new file or folder to be scanned:

a. Choose a predefined location from the drop-down menu or enter the
Specific paths you want to scan.

b. Specify the path to the object to be scanned in the edit field.

– If you have chosen a predefined location, complete the path as needed.
For example, to scan the entire Program Files folder, it suffices to
select the corresponding predefined location from the drop-downmenu.
To scan a specific folder from Program Files, you must complete
the path by adding a backslash (\) and the folder name.

– If you have chosen Specific paths, enter the full path to the object to
be scanned. It is advisable to use system variables (where appropriate)
to make sure the path is valid on all target computers. For more
information regarding system variables, refer to “Using System Variables”
(p. 214)

c. Click the corresponding Add button.

To edit an existing location, click it. To remove a location from the list, move

the cursor over it and click the corresponding Delete button.

Click the Exclusions sections if you want to define target exclusions.
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Computers Scan Task - Defining Exclusions

You can either choose to use the global exclusions on a specific scan or define
explicit exclusions for each scan. For more details regarding exclusions, refer
to “Exclusions” (p. 144).

7. Click Save to create the scan task. A confirmation message will appear.

8. You can view and manage the task on the Network > Tasks page. For more information,
refer to “Viewing and Managing Tasks” (p. 114).

Install Client

To protect your computers with Security for Endpoints, you must install Endpoint Security
on each of them.

Important
In isolated networks that do not have direct connectivity with the Small Office Security
appliance, you can install Endpoint Security with Endpoint Security Relay role. In this case,
the communication between the Small Office Security appliance and the other Endpoint
Security clients will be done through the Endpoint Security client with Endpoint Security
Relay role, which will also act as a local update server for the Endpoint Security clients
protecting the isolated network.

Once you have installed an Endpoint Security client with Endpoint Security Relay role in a
network, it will automatically detect unprotected computers in that network.

Note
It is recommended that the computer on which you install Endpoint Security with Endpoint
Security Relay role to be always on.
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Note
If no Endpoint Security with Endpoint Security Relay role is installed in the network, the
detection of unprotected computersmust be donemanually by sending aNetwork Discovery
task to an Endpoint Security client.

The Security for Endpoints protection can then be installed on those computers remotely
from Control Center.

Remote installation is performed in the background, without the user knowing about it.

Warning
Before installation, be sure to uninstall existing antimalware and firewall software from
computers. Installing Security for Endpoints over existing security software may affect their
operation and cause major problems with the system. Windows Defender and Windows
Firewall will be turned off automatically when installation starts.

To remotely install the Security for Endpoints protection on one or several computers:

1. Go to the Network page.

2. Choose Computers from the service selector.

3. Select the desired network group from the left-side pane. The entities contained in the
selected group are displayed in the right-side pane table.

Note
Optionally, you can apply filters to display unmanaged computers only. Click the Filters
button and select the following options: Unmanaged from the Security category and
All items recursively from the Depth category.

4. Select the entities (computers or groups of computers) on which you want to install
protection.

5. Click the Tasks button at the right-side of the table and choose Install client. The
Install Client wizard is displayed.

6. Configure the installation options:

• Select the role you want the client to have:

– Endpoint. Select this option if you want to install the client on a regular endpoint.

– Endpoint Security Relay. Select this option to install the client with Endpoint
Security Relay role on the target computer. Endpoint Security Relay is a special
role which installs an update server on the target machine along with Endpoint
Security, which can be used to update all the other clients in the network, lowering
the bandwidth usage between the client machines and the Small Office Security
appliance.
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• Select the protection modules you want to install. Please note that only antimalware
protection is available for server operating systems.

• From the Language field, select the desired language for the client's interface.

• Select Scan before installation if you want to make sure the computers are clean
before installing the Endpoint Security on them. An on-the cloud quick scan will be
performed on the corresponding computers before starting the installation.

• Endpoint Security is installed in the default installation directory on the selected
computers. Select Use custom installation path if you want to install the Endpoint
Security in a different location. In this case, enter the desired path in the corresponding
field. Use Windows conventions when entering the path (for example, D:\folder).
If the specified folder does not exist, it will be created during the installation.

• During the silent installation, the computer is scanned for malware. Sometimes, a
system restart may be needed to complete malware removal.

SelectAutomatically reboot (if needed) to make sure detectedmalware is completely
removed before installation. Otherwise, installation may fail.

• If you want to, you can set a password to prevent users from removing protection.
Select Set uninstall password and enter the desired password in the corresponding
fields.

• Select Additional targets if you want to deploy the client to specific machines from
your network that are not shown in the network inventory. Enter the IP addresses or
the hostnames of those machines in the dedicated field, separated by a comma. You
can add as many IPs as you need.

• Click Next.

• Depending on the client role (Endpoint or Endpoint Security Relay), choose the entity
through which the clients will communicate:

– Small Office Security Appliance, available for both roles. You can also configure
the Communication Server and local update addresses in the following fields, if
required.

To change the local update address, use one of these syntaxes:
• update_server_ip:port
• update_server_name:port

Note
The update address configured here is used temporarily after installation. As
soon as a policy is applied to the client, the update location is changed according
to policy settings. To make sure the client continues to update from the same
update address, configure it accordingly in the policy settings.

– Bitdefender Cloud, if you want to update the clients directly from the Internet.
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– Endpoint Security Relay, if you want to connect the endpoints to an Endpoint
Security Relay installed in your network. All computers with Endpoint Security
Relay role detected in your network will show-up in the table displayed below.
Select the Endpoint Security Relay that you want. Connected endpoints will
communicate with Control Center only via the specified Endpoint Security Relay.

Important
Port 7074 must be open for the deployment through Endpoint Security Relay to
work.

7. Click Next.

8. Under the Credentials Manager section, specify the administrative credentials required
for remote authentication on selected endpoints.

You can add the required credentials by entering the user and password of each target
operating system.

Note
A warning message is displayed as long as you have not selected any credentials. This
step is mandatory to remotely install the Endpoint Security on computers.

To add the required OS credentials:

a. Enter the user name and password of an administrator account for each target
operating system in the corresponding fields. Optionally, you can add a description
that will help you identify each account more easily. If computers are in a domain, it
suffices to enter the credentials of the domain administrator.

Use Windows conventions when entering the name of a domain user account, for
example, user@domain.com or domain\user. Tomake sure that entered credentials
will work, add them in both forms (user@domain.com and domain\user).

Note
Specified credentials are automatically saved to your Credentials Manager so that
you do not have to enter them the next time.

b. Click the Add button. The account is added to the list of credentials.

c. Select the check box corresponding to the account you want to use.

9. Click Save. A confirmation message will appear.

You can view and manage the task in the Network > Tasks page. For more information,
refer to “Viewing and Managing Tasks” (p. 114).
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Modify Installer

To change the protection modules installed on one or several computers:

1. Go to the Network page.

2. Choose Computers from the service selector.

3. Select the desired group from the left-side pane. All computers from the selected group
are displayed in the right-side pane table.

4. Select the check boxes corresponding to the managed computers on which you want
to change the installed protection modules.

5. Click the Task button at the right-side of the table and choose Modify installer.

6. Select in the Modules section only the protection modules you want to be installed:

Antimalware
The Antimalware module protects the system against all kinds of malware threats
(viruses, Trojans, spyware, rootkits, adware and so on).

Firewall
The Firewall protects the computer from inbound and outbound unauthorized
connection attempts.

Content Control
The Content Control module helps you control users' access to Internet and to
applications. Please note that the configured Content Control settings will apply to
all users who log on to the target computers.

Note
Please note that only antimalware protection is available for server operating systems.

7. CheckReboot if needed option to allow the computer to automatically reboot to complete
the installation.

8. Click Save. A confirmation message will appear.

You can view and manage the task in the Network > Tasks page. For more information,
refer to “Viewing and Managing Tasks” (p. 114).

Uninstall Client

To remotely uninstall the Security for Endpoints protection from one or several computers:

1. Go to the Network page.

2. Choose Computers from the service selector.

3. Select the desired group from the left-side pane. All computers from the selected group
are displayed in the right-side pane table.
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4. Select the check boxes corresponding to the computers from which you want uninstall
Security for Endpoints protection.

5. Click the Task button at the right-side of the table and choose Uninstall client.

6. A configuration window is displayed, allowing you to opt for keeping the quarantined
items on the client machine.

7. Click Save to create the task. A confirmation message will appear.

You can view and manage the task in the Network > Tasks page. For more information,
refer to “Viewing and Managing Tasks” (p. 114).

Note
If you want to reinstall protection, be sure to restart the computer first.

Update Client

Check the status of managed computers periodically. If you notice a computer with security
issues, click its name to display the Computer Details page. For more information, refer to
“Computers with security issues” (p. 62).

An outdated client represents a security issue. In this case, you should run a client update
on the corresponding computer. This task can be done locally from the computer, or remotely
from Control Center.

To remotely update the client on managed computers:

1. Go to the Network page.

2. Choose Computers from the service selector.

3. Select the desired group from the left-side pane. All computers from the selected group
are displayed in the right-side pane table.

4. Select the check boxes of computers where you want to run a client update.

5. Click the Task button at the right-side of the table and choose Update client.

6. You will have to confirm your action by clicking Yes. A confirmation message will appear.

You can view and manage the task on the Network > Tasks page. For more information,
refer to “Viewing and Managing Tasks” (p. 114).

Restart Computer

You can choose to remotely restart managed computers.

Note
Check the Network > Tasks page before restarting certain computers. Previously created
tasks may still be processing on target computers.
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1. Go to the Network page.

2. Choose Computers from the service selector.

3. Select the desired group from the left-side pane. All computers from the selected group
are displayed in the right-side pane table.

4. Select the check boxes corresponding to the computers you want to restart.

5. Click the Task button at the right-side of the table and choose Restart computer.

6. Choose the restart schedule option:

• Select Restart now to restart computers immediately.

• Select Restart on and use the fields below to schedule the restart at the desired date
and time.

7. Click Save. A confirmation message will appear.

You can view and manage the task in the Network > Tasks page. For more information,
refer to “Viewing and Managing Tasks” (p. 114).

Network Discovery

Network discovery is done automatically only by Endpoint Security with Endpoint Security
Relay role. If you do not have an Endpoint Security with Endpoint Security Relay role installed
in your network, you have to manually send a network discovery task to amachine protected
by Endpoint Security.

To run a network discovery task in your network:

1. Go to the Network page.

2. Choose Computers from the service selector.

3. Select the desired computer group from the left-side pane. All computers from the
selected group are displayed in the right-side pane table.

4. Select the check boxes corresponding to the computers you want to perform network
discovery with.

5. Click the Task button at the right-side of the table and choose Network Discovery.

6. A confirmation message will appear. Click Yes.

You can view and manage the task in the Network > Tasks page. For more information,
refer to “Viewing and Managing Tasks” (p. 114).

9.1.6. Creating Quick Reports
You can choose to create instant reports on managed computers starting from the Network
page:
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1. Go to the Network page.

2. Choose Computers from the service selector.

3. Select the desired group from the left-side pane. All computers from the selected group
are displayed in the right-side pane table.

Optionally, you can filter the contents of the selected group only by managed computers.

4. Select the check boxes corresponding to the computers to be included in the report.

5. Click the Report button at the right-side of the table and choose the report type from
the menu. Activity reports will only include data from the last week. For more information,
refer to “Computer Reports” (p. 186).

6. Configure the report options. For more information, refer to “Creating Reports” (p. 190)

7. Click Generate. The report is immediately displayed. The time required for reports to be
created may vary depending on the number of selected computers.

9.1.7. Assigning Policies
Security settings on computers are managed using policies.

From the Network section you can view, change and assign policies for each computer or
group of computers.

Note
You can view or change the security settings for managed computers or for groups. To make
this task easier, you can filter the table contents only by managed computers.

To view the policy assigned to a particular computer:

1. Go to the Network page.

2. Choose Computers from the service selector.

3. Select the desired group from the left-side pane. All computers from the selected group
are displayed in the right-side pane table.

4. Click the name of the managed computer you are interested in. A details window will
appear.

5. In the Security section, click the name of the current policy to view its settings.

6. You can change security settings as needed, provided the policy owner has allowed
other users to make changes to that policy. Please note that any change you make will
affect all the other computers assigned with the same policy.

For more information about changing computer policies, refer to “Computer Policies”
(p. 124).

To assign a policy to a computer or group:
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1. Go to the Network page.

2. Choose Computers from the service selector.

3. Select the desired group from the left-side pane. All computers from the selected group
are displayed in the right-side pane table.

4. Select the check box of the desired computer or group. You can select one or several
objects of the same type only from the same level.

5. Click the Policy button at the right side of the table.

6. Make the necessary settings in the Policy assignment window. For more information,
refer to “” (p. 122).

9.1.8. Synchronizing with Active Directory
The network inventory is automatically synchronized with Active Directory at a time interval
specified in the root configuration. For more information, refer to “Active Directory” (p. 17).

To manually synchronize the currently displayed computers list with Active Directory:

1. Go to the Network page.

2. Choose Computers from the service selector.

3. Click the Synchronize with Active Directory button at the right side of the table.

4. You will have to confirm your action by clicking Yes.

Note
For large Active Directory networks, the synchronization may take a longer time to
complete.

9.1.9. Deleting Computers from Network Inventory
Non-Active Directory computers detected by Network Discovery are displayed in Control
Center under Custom Groups as unmanaged so that you can remotely install protection
on them.

If you do not plan to manage some of the detected computers, you can choose to exclude
them from the network inventory. Furthermore, you can permanently delete excluded
computers from the network inventory.

Note
You cannot delete computers from Active Directory.
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Excluding Computers from the Network Inventory

To exclude computers from the network inventory:

1. Go to the Network page.

2. Choose Computers from the service selector.

3. Select the desired group from the left-side pane. All computers from the selected group
are displayed in the right-side pane table.

4. Select the check box corresponding to the computer you want to exclude.

5. Click the Delete button at the right-side of the table. You will have to confirm your
action by clicking Yes.

Note
If you delete a managed computer, the Endpoint Security will be automatically uninstalled
from it.

Once you have deleted a computer, you can no longer view it in the table. Deleted
computers still exist in the Small Office Security database, but they are no longer visible.

You may want to manage again some of the deleted computers. In this case, you have
to display the deleted computers and install the Endpoint Security on the ones you are
interested in. To display deleted computers, click the Filters menu located above the
table, go to the Security tab, check the option Deleted then click Save.

Computers - Filter by Deleted Endpoints
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Note
If you reinstall protection on an excluded computer, it will be detected as managed and
restored in the table.

Deleting Computers Permanently

To permanently delete computers from network inventory:

1. Go to the Network page.

2. Choose Computers from the service selector.

3. Select the desired group from the left-side pane. All computers from the selected group
are displayed in the right-side pane table.

4. Filter the table contents by Deleted computers.

5. Select the check box corresponding to the computers you want to delete.

6. Click the Delete button at the right-side of the table. You will have to confirm your
action by clicking Yes.

The corresponding computers are permanently deleted from the Small Office Security
database.

Warning
You cannot restore a permanently deleted computer in the Small Office Security database.

9.2. Managing Mobile Devices
To manage the security of mobile devices used in your company, first you have to associate
them to specific users in Control Center, then install and activate the GravityZone Mobile
Client application on each of them.

Mobile devices can be enterprise-owned or personally-owned. You can install and activate
GravityZone Mobile Client on each mobile device, then hand it to the corresponding user.
Users can also install and activate GravityZone Mobile Client by themselves, following the
instructions received by email. For more information, refer to “Install GravityZone Mobile
Client on Devices” (p. 58).

To view the mobile devices of users under your account, go to the Network section and
chooseMobile Devices from the service selector. TheNetwork page displays the available
user groups in the left-side pane and the corresponding users and devices in the right-side
pane.

If integration with Active Directory has been configured, you can add mobile devices to
existing Active Directory users. You can also create users under Custom Groups and add
mobile devices to them.
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You can switch the right-side pane view to Users or to Devices using the Filters menu
located above the table. The Users view allows you to manage users in Control Center (add
users and mobile devices, check the number of devices for each user, etc.). Use theDevices
view to easily manage and check the details of each mobile device in the Control Center.

You can manage users and mobile devices in the Control Center as follows:

• Add custom users.
• Add mobile devices to users.
• Organize custom users into groups.
• Filter and search users and devices.
• Check user or device status and details.
• Run tasks on mobile devices.
• Create quick reports about mobile devices.
• Check and change device security settings.
• Synchronize the Control Center inventory with Active Directory.
• Delete users and mobile devices.

9.2.1. Adding Custom Users
If integration with Active Directory has been configured, you can add mobile devices to
existing Active Directory users.

In non-Active Directory situations, you must first create custom users in order to have a
mean to identify the owners of mobile devices.

To add a custom user:

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. In the left-side pane, select Custom Groups.

4. Click the Add user button at the right-side of the table. A configuration window will
appear.

5. Specify the required user details:
• A suggestive username (for example, the user's full name)
• User's email address

Important
Make sure to provide a valid email address. The user will be sent the installation
instructions by email when you add a device.

Note
Each email address can only be associated with one user.
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6. Click OK.

You can afterwards create user groups under Custom Groups.

The policy and tasks assigned to a user will apply to all devices owned by the corresponding
user.

9.2.2. Adding Mobile Devices to Users
You can add an unlimited number of mobile devices to each user, but only one at a time.

To add a device to a specific user:

Note
The Filters must be set on Users in the View tab.

1. Go to the Network page.
2. Choose Mobile Devices from the service selector.
3. Locate the user in the Active Directory folders or in Custom Groups and select the

corresponding check box in the right-side pane.
4. Click the Add device button at the right-side of the table. A configuration window will

appear.

Add mobile device to a user

5. Configure the mobile device details:

• Enter a suggestive name for the device.

• Use the Auto-configure name option if you want the device name to be automatically
generated. Once this option is enabled, the device name cannot be edited, instead
a default name is automatically assigned.
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• Select the device ownership type (enterprise or personal). You can anytime filter
mobile devices by ownership and manage them according to your needs.

• Select the Show activation credentials option after clicking the OK button if you
are going to install the GravityZone Mobile Client on the user's device.

• Click OK to add the device.

– The user is immediately sent an email with the installation instructions and the
activation details to be configured on the device. The activation details include
the activation token and the communication server address (and corresponding
QR code).

– If you have selected the Show activation credentials option, the Activation
Detailswindow appears, displaying the unique activation token, the communication
server address and corresponding QR code for the new device. After installing
the GravityZone Mobile Client, when prompted to activate the device, enter the
activation token and the communication server address or scan the provided QR
code.

Note
You can also add mobile devices to a selection of users and groups.
• In this case, the configuration window will allow defining the device ownership

only.
• If there are users with no specified email address, you will be notified

immediately with a message. The list of corresponding users will be available
from the Notification area of Control Center.

• Mobile devices created by multiple selection will be given by default a generic
name. Once a device is activated, it will be automatically renamed with the
corresponding manufacturer and model information.

You can check the number of devices assigned to each user in the right-side pane, under
Devices column.

9.2.3. Organizing Custom Users into Groups
You can view the available user groups in the left-side pane of the Network page.

Active Directory users are grouped under Active Directory. You cannot edit the Active
Directory groups. You can only view and add devices to the corresponding users.

You can place all non-Active Directory users under Custom Groups, where you can create
and organize groups as you want. A major benefit is that you can use group policies to meet
different security requirements.

Under Custom Groups you can create, delete, rename and move user groups within a
custom-defined tree structure.

Managing Network Objects 90

ENTERPRISE BITDEFENDER SMALL OFFICE SECURITY



Important
Please note the following:

A group can contain both users and other groups.•

• When selecting a group in the left-side pane, you can view all users except those placed
into its sub-groups. To view all users included in the group and in its sub-groups, click
the Filters menu located above the table and select Show all users (including
subfolders) in the Depth section.

Creating Groups

To create a custom group:

1. Select Custom Groups in the left-side pane.

2. Click the Add group button at the top of the left-side pane.

3. Enter a suggestive name for the group and click OK. The new group is displayed under
Custom Groups.

Renaming Groups

To rename a custom group:

1. Select the group in the left-side pane.

2. Click the Edit group button at the top of the left-side pane.

3. Enter the new name in the corresponding field.

4. Click OK to confirm.

Moving Groups and Users

You can move groups and users anywhere inside the Custom Groups hierarchy. To move
a group or a user, drag and drop it from the current location to the new one.

Note
The entity that is moved will inherit the policy settings of the new parent group, unless the
policy inheritance has been disabled and a different policy has been assigned to it. For more
information about policy inheritance, refer to “” (p. 122).

Deleting Groups

A group cannot be deleted if it contains at least one user. Move all users from the group you
want to delete to another group. If the group includes sub-groups, you can choose to move
all sub-groups rather than individual users.

To delete a group:
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1. Select the empty group.

2. Click the Remove group button at the top of the left-side pane. You will have to
confirm your action by clicking Yes.

9.2.4. Managed and Unmanaged Mobile Devices
You can easily identify the mobile devices status by checking the corresponding icon.

Mobile devices can have the following management statuses:

• Managed (Active), when all the following conditions are satisfied:

– The GravityZone Mobile Client is activated on the device.

– The GravityZone Mobile Client has synchronized with the Control Center within the
last 48 hours.

• Managed (Idle), when all the following conditions are satisfied:

– The GravityZone Mobile Client is activated on the device.

– The GravityZone Mobile Client has not synchronized with the Control Center for more
than 48 hours.

• Unmanaged, in the following situations:

– The GravityZone Mobile Client has not yet been installed or activated on the mobile
device (for Android devices only).

– The GravityZone Mobile Client has been uninstalled from the mobile device.

– The Unlink action has been applied to the mobile device due to a non-compliance
issue.

– GravityZone Mobile Client is no longer device administrator.

To check the devices management status:

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. In the left-side pane, select the group you are interested in.

4. Click the Filters menu located above the table and make the following settings:

• Go to View tab and select Devices.

• Go to Security tab and select the status you are interested in under Management
section. You can select one or several filter criteria at the same time.

• You can also choose to view all devices recursively, by selecting the corresponding
option in the Depth tab.

• Click Save.
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All the mobile devices corresponding to the selected criteria are displayed in the table.

You can also generate a Device Synchronization status report on one or several mobile
devices. This report provides detailed information regarding the synchronization status of
each selected device, including the date and time of the last synchronization. For more
information, refer to “Creating Quick Reports” (p. 108)

9.2.5. Compliant and Not Compliant Mobile Devices
Once the GravityZone Mobile Client application has been activated on a mobile device, the
Control Center checks if the corresponding device meets all the compliance requirements.
Mobile devices can have the following security statuses:

• Without Security Issues, when all compliance requirements are satisfied.

• With Security Issues, when at least one of the compliance requirements is not satisfied.
When a device is declared non-compliant, the user is prompted to fix the non-compliance
issue. The user must make the required changes within a certain time period, otherwise
the action for non-compliant devices defined in the policy will be applied.

For more information regarding the non-compliance actions and criteria, refer to
“Compliance” (p. 169).

To check the devices compliance status:

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. In the left-side pane, select the group you are interested in.

4. Click the Filters menu located above the table and make the following settings:

• Go to View tab and select Devices.

• Go to Security tab and select the status you are interested in under Security Issues
section. You can select one or several filter criteria at the same time.

• You can also choose to view all devices recursively, by selecting the corresponding
option in the Depth tab.

• Click Save.

All the mobile devices corresponding to the selected criteria are displayed in the table.

5. You can view the device compliance ratio for each user:

a. Click the Filters menu located above the table and select Users from the View
category. All the users in the selected group are displayed in the table.

b. Check the Compliance column to view how many devices are compliant from the
total number of devices owned by the user.
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You can also generate a Device Compliance report on one or several mobile devices. This
report provides detailed information regarding the compliance status of each selected device,
including the non-compliance reason. For more information, refer to “Creating Quick Reports”
(p. 108)

9.2.6. Checking User and Mobile Devices Details
You can obtain detailed information about each user and mobile device from the Network
page.

Checking User Details

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. Select the desired group in the left-side pane.

4. Click the Filtersmenu located above the table and select Users from the View category.

Mobile devices - Filter by View

Click Save. All users in the selected group are displayed in the table.
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Network - Mobile devices page - Users view

5. Check the information displayed in the table columns for each user:

• Name. The user name.

• Devices. The number of devices attached to user. Click the number to switch to the
Devices view and display the corresponding devices only.

• Compliance. The ratio of compliant devices to total devices attached to user. Click
the first value to switch to the Devices view and display the compliant devices only.

6. Click the name of the user you are interested in. A configuration window appears, where
you can view and edit the user's name and email address.

Checking Device Details

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. Select the desired group in the left-side pane.

4. Click the Filtersmenu located above the table and selectDevices from the View category.
Click Save. All devices belonging to users in the selected group are displayed in the
table.
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Mobile devices - Devices view

5. Check the information displayed in the table columns for each device:

• Name. The device name.

• User. The name of the user owning the corresponding device.

• OS. The operating system of the corresponding device.

6. Click the name of a device for more details. TheMobile Device Detailswindow appears,
where you can check the following information grouped under Overview and Details
tabs:
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Mobile device details

• General.

– Name. The name specified when adding the device in Control Center.

– User. The device owner's name.

– Group. The mobile device's parent group in the network inventory.

– OS. The mobile device's operating system.

– Ownership. The mobile device ownership type (enterprise or personal).

• Security.

– Client Version. The version of GravityZone Mobile Client application installed on
the device, only detected after enrollment.

– Policy. The policy currently assigned to the mobile device. Click the policy name
to go to the corresponding Policy page and check the security settings.
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Important
By default, only the user who created the policy can modify it. To change that,
the policy owner must check the option Allow other users to change this policy
from the policy’sDetails page. The changesmade to a policy will affect all devices
assigned with the corresponding policy. For more information, refer to “Assigning
Policies” (p. 108).

– License status. View license information for the corresponding device.

– Compliance status. The compliance status is available for managed mobile
devices. A mobile device can be Compliant or Not compliant.

Note
For not compliant mobile devices, a notification icon is displayed. Check the
icon's tooltip to view the non-compliance reason.
For more details regarding mobile devices compliance, refer to “Compliance” (p.
169).

– Malware Activity for today. A quick overview regarding the number of malware
detections for the corresponding device in the current day.

– Lock Password. A unique password automatically generated at device enrollment,
which is used for remotely locking the device (for Android devices only).

– Encryption status. Some of 3.0 Android devices or newer support the device
encryption feature. Check the encryption status in the device details page to find
out if the corresponding device supports the encryption feature. If the encryption
has been required by policy on the device, you can also view the encryption
activation status.

• Activation Details

– Activation Code. The unique activation token assigned to the device.

– The communication server address.

– QR Code. The unique QR Code containing the activation token and the
communication server address.

• Hardware. You can view here the device hardware information, available only for
managed (activated) devices. Hardware information is checked every 12 hours and
updated if changes occur.

• Network. You can view here network connectivity information, available only for
managed (activated) devices.
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9.2.7. Filtering and Sorting Mobile Devices
The Mobile Devices inventory table can span several pages, depending on the number of
users or devices (only 10 entries are displayed per page by default). To move through the
pages, use the navigation buttons at the bottom of the table. To change the number of
entries displayed on a page, select an option from the menu next to the navigation buttons.

If there are too many entries, you can use the filter options to display only the entities you
are interested in.

Filtering Users and Mobile Devices using the Filters Menu

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. In the left-side pane, select the group you are interested in.

4. Click the Filters menu located above the table in the right-side pane.

5. Select the desired filter criteria:

• Type. Select the type of entities to filter by (Users/Devices or Folders).

Mobile devices - Filter by Type

• Security. Select the type of mobile devices you want to be displayed (managed,
unmanaged, vulnerable or secured devices).
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Mobile devices - Filter by Security

• Policy. Select the policy template you want to filter the mobile devices by as well as
the policy assignment status (Assigned or Pending).

Mobile devices - Filter by Policy

• View. Select Users to display only users in the selected group. Select Devices to
display only devices in the selected group.
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Mobile devices - Filter by View

• Ownership. You can filter mobile devices by ownership, choosing to show Enterprise
devices or Personal.

Mobile devices - Filter by Ownership

• Depth. When managing a tree-structure mobile devices network, mobile devices
placed in sub-groups are not displayed by default. Select All items recursively to
view all mobile devices included in the current group and in its sub-groups.
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Mobile devices - Filter by Depth

6. Click Save to filter the mobile devices by the selected criteria.

Filtering Users and Mobile Devices using the Table Columns

The right-side pane table provides specific information on users and mobile devices. You
can use the categories available on each column to filter the table contents.

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. In the left-side pane, select the group you are interested in.

4. Switch to the desired view (Users or Mobile Devices) using the Filters menu located
above the table in the right-side pane.

5. Filter the contents of the right-side pane table using the categories available on each
column:

• Enter the search term in the corresponding search boxes under the column headers.

For example, in the Devices view, enter the name of the user you are looking for in
the User field. Only the matching mobile devices will appear in the table.

• Select the desired criteria in the corresponding drop-down list boxes under the column
headers.

For example, in the Devices view, click the Synchronization list box and select
Unlinked to view only the unlinked mobile devices in the selected group.
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Note
To clear the search term and show all entities, place the mouse cursor over the
corresponding box and click the icon.

Sorting the Mobile Devices Inventory

To sort data by a specific column, click the column headers. For example, if you want to
order users by name, click the Name heading. If you click the heading again, the users will
be displayed in reverse order.

9.2.8. Running Tasks on Mobile Devices
From theNetwork page, you can remotely run several administrative tasks onmobile devices.
This is what you can do:

• “Lock” (p. 104)
• “Unlock” (p. 105)
• “Wipe” (p. 105)
• “Scan” (p. 106)
• “Locate” (p. 107)

Mobile devices tasks

In order to run remote tasks on mobile devices, certain prerequisites must be met. For more
information, refer to “Security for Mobile Devices Requirements” (p. 6).
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You can choose to create tasks individually for each mobile device, for each user or for
groups of users. For example, you can remotely scan for malware the mobile devices of a
group of users. You can also run a locate task for a specific mobile device.

The network inventory can contain active, idle or unmanaged mobile devices. Once created,
tasks will start running immediately on active mobile devices. For Idle devices, the tasks will
start as soon as they get back online. Tasks will not be created for unmanaged mobile
devices. A notification stating that the task could not be created will be displayed in this
case.

You can view and manage tasks in the Network > Tasks page. For more information, refer
to “Viewing and Managing Tasks” (p. 114).

Lock

The Lock task immediately locks the screen of target mobile devices. The Lock task behavior
is operating system dependent:

• On Android, the screen is locked with a password generated by Control Center. If the
user already has a lock screen password, this will be automatically changed. The device
can be unlocked only by an Unlock task sent from the Control Center.

Note
The lock screen password generated by Control Center is displayed in theMobile Device
Details window.

• On iOS, if the device has a lock screen password, it is asked in order to unlock.

To remotely lock mobile devices:

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. Select the desired group from the left-side pane.

4. Click the Filtersmenu located above the table and select Users from the View category.
Click Save. All users in the selected group are displayed in the table.

5. Select the check boxes corresponding to users you are interested in. You can select one
or several users at the same time.

6. Click the Task button at the right-side of the table and choose Lock.

7. You will have to confirm your action by clicking Yes. A message will inform you whether
the task was created or not.

8. You can view and manage the task in the Network > Tasks page. For more information,
refer to “Viewing and Managing Tasks” (p. 114).
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Unlock

The Unlock task resets the screen locking with password and unlocks the screen on the
target mobile devices.

Note
When unlocking a mobile device that is required to have a lock screen password via the
policy, GravityZone Mobile Client will notify the user to set a new lock screen password
according to policy settings.

To remotely unlock mobile devices:

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. Select the desired group from the left-side pane.

4. Click the Filtersmenu located above the table and select Users from the View category.
Click Save. All users in the selected group are displayed in the table.

5. Select the check boxes corresponding to users you are interested in. You can select one
or several users at the same time.

6. Click the Task button at the right-side of the table and choose Unlock.

7. You will have to confirm your action by clicking Yes. A message will inform you whether
the task was created or not.

8. You can view and manage the task in the Network > Tasks page. For more information,
refer to “Viewing and Managing Tasks” (p. 114).

Note
After applying the Unlock task to encrypted Android devices, the user is still prompted to
provide a blank password.

Wipe

TheWipe task restores the target mobile devices to factory settings. Run this task to remotely
erase all sensitive information and applications stored on target mobile devices.

Warning
Use the Wipe task carefully. Check the ownership of target devices (if you want to avoid
wiping personally-owned mobile devices) and make sure that you really want to wipe the
selected devices. Once sent, the Wipe task cannot be undone.

To remotely wipe a mobile device:

1. Go to the Network page.
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2. Choose Mobile Devices from the service selector.

3. Select the desired group from the left-side pane.

4. Click the Filtersmenu located above the table and selectDevices from the View category.
Click Save. All devices in the selected group are displayed in the table.

Note
You can also select Show all devices (including subfolders) under Depth section to
view recursively all devices in the current group.

5. Select the check box corresponding to the device you want to wipe.

6. Click the Task button at the right-side of the table and choose Wipe.

7. You will have to confirm your action by clicking Yes. A message will inform you whether
the task was created or not.

8. You can view and manage the task in the Network > Tasks page. For more information,
refer to “Viewing and Managing Tasks” (p. 114).

Scan

The Scan task allows you to check selected mobile devices for malware. The device user
is notified about any detected malware and prompted to remove it. The scan is performed
in the cloud, therefore the device must have Internet access.

Note
The remote scan does not work on iOS devices (platform limitation).

To remotely scan mobile devices:

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. Select the desired group from the left-side pane.

4. Click the Filtersmenu located above the table and selectDevices from the View category.
Click Save. All devices in the selected group are displayed in the table.

Note
You can also select Show all devices (including subfolders) under Depth section to
view recursively all devices in the current group.
To display only Android devices in the selected group, go to the OS column header in
the right-side pane and choose Android from the corresponding list box.

5. Select the check boxes corresponding to devices you want to scan.

6. Click the Task button at the right-side of the table and choose Scan.
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7. You will have to confirm your action by clicking Yes. A message will inform you whether
the task was created or not.

8. You can view and manage the task in the Network > Tasks page. A scan report is

available when the task completes. Click the corresponding icon in theReports column
to generate an instant report.

For more information, refer to “Viewing and Managing Tasks” (p. 114).

Locate

The Locate task opens a map showing the location of selected devices. You can locate one
or several devices at the same time.

For the Locate task to work, the location services must be enabled on the mobile devices.

To locate mobile devices:

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. Select the desired group from the left-side pane.

4. Click the Filtersmenu located above the table and selectDevices from the View category.
Click Save. All devices in the selected group are displayed in the table.

Note
You can also select Show all devices (including subfolders) under Depth section to
view recursively all devices in the current group.

5. Select the check box corresponding to the device you want to locate.

6. Click the Task button at the right-side of the table and choose Locate.

7. The Location window opens, displaying the following information:

• A map showing the position of the selected mobile devices. If a device is not
synchronized, the map will display its last known location.

• A table displaying the details of selected devices (name, user, last synchronization
date and time). To view the map location of a certain device listed in the table, just
select its check box. The map will instantly switch to the corresponding device's
location.

• The Autorefresh option automatically updates the selected mobile devices locations
after each 10 seconds.

8. You can view and manage the task in the Network > Tasks page. For more information,
refer to “Viewing and Managing Tasks” (p. 114).
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9.2.9. Creating Quick Reports
You can choose to create instant reports on mobile devices under your account from the
Network page:

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. Select the desired group from the left-side pane.

4. Click the Filtersmenu located above the table and select Users from the View category.
Click Save. All users in the selected group are displayed in the table.

5. Select the check boxes corresponding to users you are interested in. You can select one
or several users at the same time.

6. Click the Report button at the right-side of the table and choose the report type from
the menu. Activity reports will only include data from the last week. For more information,
refer to “Mobile Devices Reports” (p. 189)

7. Configure the report options. For more information, refer to “Creating Reports” (p. 190)

8. Click Generate. The report is immediately displayed. The time required for reports to be
created may vary depending on the number of selected mobile devices.

9.2.10. Assigning Policies
Security settings on mobile devices are managed using policies.

From the Network section you can view, change and assign policies for mobile devices
under your account.

You can assign policies to groups, users or specific mobile devices.

Note
A policy assigned to a user affects all devices owned by the user. For more information,
refer to “” (p. 122).

You can anytime view the mobile devices security settings. Switch to the corresponding
network view using the Filters menu located above the right-side pane table.

To view the security settings assigned to a mobile device:

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. Click the Filtersmenu located above the table and selectDevices from the View category.
Click Save. All devices belonging to users in the selected group are displayed in the
table.

4. Click the name of the mobile device you are interested in. A details window will appear.
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5. In the Security section, click the name of the current policy to view its settings.

6. You can change security settings as needed. Please note that any change you make will
also apply to all other devices on which the policy is active.

For more information, refer to “Mobile Device Policies” (p. 165)

To assign a policy to a mobile device:

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. In the left-side pane, select the group you are interested in.

4. Click the Filtersmenu located above the table and selectDevices from the View category.
Click Save. All devices belonging to users in the selected group are displayed in the
table.

5. In the right-side pane, select the check box of the mobile device you are interested in.

6. Click the Policy button at the right side of the table.

7. Make the necessary settings in the Policy assignment window. For more information,
refer to “” (p. 122).

9.2.11. Synchronizing with Active Directory
The network inventory is automatically synchronized with Active Directory at a time interval
specified in the root configuration. For more information, refer to “Active Directory” (p. 17).

To manually synchronize the currently displayed users list with Active Directory:

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. Click the Synchronize with Active Directory button at the right side of the table.

4. You will have to confirm your action by clicking Yes.

Note
For large Active Directory networks, the synchronization may take a longer time to
complete.

9.2.12. Deleting Users and Mobile Devices
When the network inventory contains obsolete users or mobile devices, it is recommended
to delete them.
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Deleting Mobile Devices from the Network Inventory

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. In the left-side pane, select the group you are interested in.

4. Click the Filtersmenu located above the table and selectDevices from the View category.

5. Click Save.

6. Select the check box corresponding to the mobile devices you want to delete.

7. Click the Delete button at the right-side of the table. You will have to confirm your
action by clicking Yes.

Warning
You cannot restore deleted mobile devices.

Deleting Users from the Network Inventory

Users currently associated with mobile devices cannot be deleted. You will have to delete
the corresponding mobile devices first.

Note
You can delete users from the Custom Groups only.

To delete a user:

1. Go to the Network page.

2. Choose Mobile Devices from the service selector.

3. In the left-side pane, select the group you are interested in.

4. Click the Filtersmenu located above the table and select Users from the View category.

5. Click Save.

6. Select the check box corresponding to the user you want to delete.

7. Click the Delete button at the right-side of the table. You will have to confirm your
action by clicking Yes.

9.3. Installation Packages
The Small Office Security protection components can be installed on the target network
objects either by deploying them from Control Center or by downloading the needed
installation package and running it manually on the target network objects.
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You can manage installation packages from the Network > Packages page.

9.3.1. Creating Installation Packages
You might need to make certain customizations to the installation packages, to better fit the
security needs.

Creating Endpoint Security Installation Packages

To create an Endpoint Security installation package:

1. Connect and log in to Control Center using your account.

2. Go to the Network > Packages page.

The Packages page

3. Click the Add button at the right side of the table and choose Endpoint Security from
the menu. A configuration window will appear.
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Create Endpoint Security Packages - Options

4. Enter a suggestive name and description for the installation package you want to create.

5. Select the target computer role:

• Endpoint. Select this option to create the package for a regular endpoint.

• Endpoint Security Relay. Select this option to create the package for an endpoint
with Endpoint Security Relay role. Endpoint Security Relay is a special role which
installs an update server on the target machine along with Endpoint Security, which
can be used to update all the other clients in the network, lowering the bandwidth
usage between the client machines and the Small Office Security appliance.

6. Select the protection modules you want to install.

7. From the Language field, select the desired language for the client's interface.

8. Select Scan before installation if you want to make sure the computers are clean before
installing the Endpoint Security on them. An on-the cloud quick scan will be performed
on the corresponding computers before starting the installation.
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9. Endpoint Security is installed in the default installation directory on the selected
computers. Select Use custom installation path if you want to install the Endpoint
Security in a different location. In this case, enter the desired path in the corresponding
field. Use Windows conventions when entering the path (for example, D:\folder). If
the specified folder does not exist, it will be created during the installation.

10. If you want to, you can set a password to prevent users from removing protection. Select
Set uninstall password and enter the desired password in the corresponding fields.

11. Click Next.

12. Depending on the installation package role (Endpoint or Endpoint Security Relay), choose
the entity to which the target computers will periodically connect to update the client:

• Small Office Security Appliance, available for both roles. You can also configure
the Communication Server and local update addresses in the following fields, if
required.

To change the local update address, use one of these syntaxes:

Note
The update address configured here is used temporarily after installation. As soon
as a policy is applied to the client, the update location is changed according to policy
settings. To make sure the client continues to update from the same update address,
configure it accordingly in the policy settings.

– update_server_ip:port
– update_server_name:port

• Endpoint Security Relay, if you want to connect the endpoints to an Endpoint Security
Relay installed in your network. All computers with Endpoint Security Relay role
detected in your network will show-up in the table displayed below. Select the Endpoint
Security Relay that you want. Connected endpoints will communicate with Control
Center only via the specified Endpoint Security Relay.

Important
Port 7074 must be open for the deployment through Endpoint Security Relay to work.

13. Click Save.

You can find the new installation package in the list of packages.

9.3.2. Downloading Installation Packages
To download Endpoint Security installation packages:

1. Log in to Control Center from the computer on which you want to install protection.

2. Go to the Network > Packages page.
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3. Select the Endpoint Security installation package you want to download.

4. Click the Download button at the right side of the table and select the type of installer
you want to use. Two types of installation files are available:

• Downloader. The downloader first downloads the full installation kit from the Control
Center appliance and then starts the installation. It is small in size and it can be run
both on 32-bit and 64-bit systems (which makes it easy to distribute).

• Full Kit. The full installation kits are bigger in size and they have to be run on the
corresponding operating system type.

Note
Available full kit versions:

– Windows OS: 32-bit and 64-bit systems

– Mac OS X: only 64-bit systems
Make sure to use the correct version for the computer you install on.

5. Save the file to the computer.

9.4. Viewing and Managing Tasks
The Network > Tasks page allows you to view and manage all the tasks you have created.

Once you have created a task for one of several network objects, you can view it in the tasks
table.

You can do the following from the Network > Tasks page:

• Check the task status
• View task reports
• Re-run tasks
• Delete tasks

9.4.1. Checking Task Status
Each time you create a task for one or several network objects, you will want to check its
progress and get notified when errors occur.

Go to the Network > Tasks page and check the Status column for each task you are
interested in. You can check the status of the main task, and you can also obtain detailed
information about each sub-task.

Managing Network Objects 114

ENTERPRISE BITDEFENDER SMALL OFFICE SECURITY



The Tasks page

• Checking the main task status.

The main task concerns the action launched on network objects (such as install client
or scan) and contains a certain number of sub-tasks, one for each selected network
object. For example, a main installation task created for eight computers contains eight
sub-tasks. The numbers between brackets represent the sub-tasks completion ratio. For
example, (2/8) means that two out of eight sub-tasks are finished.

The main task status may be:
– Pending, when none of the sub-tasks is started yet, or when the number of concurrent

deployments is exceeded. The maximum number of concurrent deployments can be
set from the Configuration menu. For more information, refer to “Miscellaneous” (p.
17).

– In Progress, when all sub-tasks are running. The main task status remains In Progress
until the last sub-task is done.

– Finished, when all sub-tasks are (successfully or unsuccessfully) finished. In case of
unsuccessful sub-tasks, a warning symbol is displayed.

• Checking the sub-tasks status.

Go to the task you are interested in and click the link available in the Status column to
open the Status window. You can view the list of network objects assigned with the
main task and the status of the corresponding sub-task. The sub-tasks status can be:

– In Progress, when the sub-task is still running.

– Finished, when the sub-task has finished successfully.

– Pending, when the sub-task has not started yet. This can happen in the following
situations:

• The sub-task is waiting in a queue.

• There are connectivity issues between Control Center and the target network
object.

• The target device is Idle (offline), in the case of mobile devices. The task will run
on target device as soon as it gets back online.

– Failed, when the sub-task could not start or it had stopped due to errors, such as
incorrect authentication credentials and low memory space.
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To view the details of each sub-task, select it and check theDetails section at the bottom
of the table.

Tasks Status Details

You will obtain information regarding:

– Date and time when the task started.

– Date and time when the task ended.

– Description of encountered errors.

9.4.2. Viewing Task Reports
From the Network > Tasks page you have the option to view quick scan tasks reports.

1. Go to the Network > Tasks page.

2. Choose the desired network object from the service selector.

3. Select the check box corresponding to the scan task you are interested in.

4. Click the corresponding button from the Reports column. Wait until the report is
displayed. For more information, refer to “Using Reports” (p. 186).

9.4.3. Re-running Tasks
For various reasons, the client installation, uninstallation or update tasks may fail to complete.
You can choose to re-run such failed tasks instead of creating new ones, following the next
steps:

1. Go to the Network > Tasks page.

2. Choose the desired network object from the service selector.
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3. Select the check boxes corresponding to the failed tasks.

4. Click the Run again button at the right side of the table. The selected tasks will restart
and the tasks status will change to Retrying.

Note
For tasks with multiple sub-tasks, Run again option is available only when all sub-tasks
have finished and it will execute only the failed sub-tasks.

9.4.4. Deleting Tasks
To prevent the tasks list from getting cluttered, it is recommended to delete the tasks that
you no longer need.

1. Go to the Network > Tasks page.

2. Choose the desired network object from the service selector.

3. Select the check box corresponding to the task you want to delete.

4. Click the Delete button at the right side of the table. You will have to confirm your
action by clicking Yes.

Warning
Deleting a pending task will also cancel the task.
If a task in progress is being deleted, any pending sub-tasks will be cancelled. In this
case, all finished sub-tasks cannot be undone.

9.5. Credentials Manager
The Credentials Manager helps you manage the credentials required for accessing the
available vCenter Server inventories and also for remote authentication on different operating
systems in your network.

To open the Credentials Manager, point to your username in the upper-right corner of the
page and choose Credentials Manager.

The Credentials Manager menu

The Credentials Manager window contains the following settings:
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9.5.1. OS
From the OS tab, you can manage the administrator credentials required for remote
authentication when running installation tasks on computers in your network.

Credentials Manager

1. Enter the user name and password of an administrator account for each target operating
system in the corresponding fields. Optionally, you can add a description that will help
you identify each account more easily. If computers are in a domain, it suffices to enter
the credentials of the domain administrator.

UseWindows conventions when entering the name of a domain user account, for example,
user@domain.com or domain\user. To make sure that entered credentials will work,
add them in both forms (user@domain.com and domain\user).

2. Click the Add button. The new set of credentials is added to the table.

Note
If you have not specified the authentication credentials, you will be required to enter
them when you run installation tasks. Specified credentials are automatically saved to
your Credentials Manager so that you do not have to enter them the next time.

9.5.2. Deleting Credentials from Credentials Manager
To delete obsolete credentials from the Credentials Manager:

1. Point to the row in the table containing the credentials you want to delete.

2. Click the Delete button at the right side of the corresponding table row. The selected
account will be deleted.
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10. Security Policies
Once installed, the Bitdefender protection can be configured and managed from Control
Center using security policies. A policy specifies the security settings to be applied on target
network inventory objects.

Immediately after installation, network inventory objects are assigned the default policy,
which is preconfigured with the recommended protection settings. You cannot modify or
delete the default policy. You can only use it as a template for creating new policies.

You can create as many policies as you need based on security requirements.

This is what you need to know about policies:

• Policies are created in the Policies page and assigned to network objects from the
Network page.

• Network objects can have only one active policy at a time.
• Policies are pushed to target network objects immediately after creating or modifying

them. Settings should be applied on network objects in less than a minute (provided they
are online). If a network object is not online, settings will be applied as soon as it gets
back online.

• The policy applies only to the installed protection modules. Please note that only
antimalware protection is available for server operating systems.

• You cannot edit policies created by other users (unless the policy owners allow it from
the policy settings), but you can override them by assigning the target objects a different
policy.
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10.1. Managing Policies
You can view and manage policies in the Policies page.

The Policies page

Each type of network object has specific policy settings. To manage policies, you must first
select the type of network object (Computers orMobile Devices) from the service selector.

Existing policies are displayed in the table. For each policy, you can see:

• Policy name.

• User who created the policy.

• Date and time when the policy was last modified.

You can sort the available policies and also search for certain policies using the available
criteria.

10.1.1. Creating Policies
You can create policies by two methods: add a new one or duplicate (clone) an existing
policy.

To create a new policy:

1. Go to the Policies page.

2. Choose the type of network objects from the service selector.

3. Choose the policy creation method:

• Add a new policy.

– Click the Add button at the right side of the table. This command creates a new
policy starting from the default policy template.

• Clone an existing policy.
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a. Select the check box of the policy you want to duplicate.

b. Click the Clone button at the right side of the table.

4. Configure the policy settings. For detailed information, refer to:

• “Computer Policies” (p. 124)

• “Mobile Device Policies” (p. 165)

5. Click Save to create the policy and return to the policies list.

10.1.2. Changing Policy Settings
Policy settings can be initially configured when creating the policy. Later on, you can change
them as needed anytime you want.

Note
By default, only the user who created the policy can modify it. To change that, the policy
owner must check the option Allow other users to change this policy from the policy’s
Details page.

To change the settings of an existing policy:

1. Go to the Policies page.

2. Choose the type of network objects from the service selector.

3. Find the policy you are looking for in the list and click its name to edit it.

4. Configure the policy settings as needed. For detailed information, refer to:

• “Computer Policies” (p. 124)

• “Mobile Device Policies” (p. 165)

5. Click Save.

Policies are pushed to target network objects immediately after changing the policy
assignments or after modifying the policy settings. Settings should be applied on network
objects in less than a minute (provided they are online). If a network object is not online,
settings will be applied as soon as it gets back online.

10.1.3. Renaming Policies
Policies should have suggestive names so that you or other administrator can quickly identify
them.

To rename a policy:

1. Go to the Policies page.

2. Choose the type of network objects from the service selector.
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3. Click the policy name. This will open the policy page.

4. Enter a new name for the policy.

5. Click Save.

Note
The policy name is unique. You must enter a different name for each new policy.

10.1.4. Deleting Policies
If you no longer need a policy, delete it. Once the policy is deleted, the network objects to
which it used to apply will be assigned the policy of the parent group. If no other policy
applies, the default policy will be enforced eventually.

Note
By default, only the user who created the policy can delete it. To change that, the policy
owner must check the option Allow other users to change this policy from the policy’s
Details page.

To delete a policy:

1. Go to the Policies page.

2. Choose the type of network objects from the service selector.

3. Select the corresponding check box.

4. Click the Delete button at the right side of the table. You will have to confirm your
action by clicking Yes.

Once you have defined the necessary policies in the Policies section, you can assign them
to the network objects in the Network section.

All network objects are initially assigned with the default policy.

Note
You can assign only policies created by you. To assign a policy created by another user,
you have to clone it first in the Policies page.

To assign a policy:

1. Go to the Network page.

2. Choose the type of network objects from the service selector.

3. Select the check box of the desired network object. You can select one or several objects
only from the same level.

4. Click the Assign Policy button at the right side of the table.

The Policy assignment window is displayed:
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Policy Assignment Settings

5. Configure the policy assignment settings for the selected objects:

• View the current policy assignments for the selected objects in the table under the
Targets section.

• Assign the following policy template. Select this option to assign the target objects
with one policy from the menu displayed at the right. Only the policies created from
your user account are available in the menu.

• Inherit from above. Select the Inherit from above option to assign the selected
network objects with the parent group's policy.

• Force policy inheritance for objects. By default, each network object inherits the
policy of the parent group. If you change the group policy, all the group's children
will be affected, excepting the group's members for which you have specifically
assigned another policy.

Select Force policy inheritance for objects option to apply the chosen policy to a
group, including to the group's children assigned with a different policy. In this case,
the table placed below will display the selected group's children that do not inherit
the group policy.

6. Click Finish to save and apply changes.

Policies are pushed to target network objects immediately after changing the policy
assignments or after modifying the policy settings. Settings should be applied on network
objects in less than a minute (provided they are online). If a network objects is not online,
settings will be applied as soon as it gets back online.
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To check if the policy has been successfully assigned, go to the Network page and click
the name of the object you are interested in to display theDetailswindow. Check the Policy
section to view the status of the current policy. If in pending state, the policy has not been
applied yet to the target object.

10.2. Computer Policies
Policy settings can be initially configured when creating the policy. Later on, you can change
them as needed anytime you want.

To configure the settings of a policy:

1. Go to the Policies page.

2. Choose Computers from the service selector.

3. Click the policy name. This will open the policy settings page.

4. Configure the policy settings as needed. Settings are organized under the following
categories:
• General
• Antimalware
• Firewall
• Content Control

You can select the settings category using the menu on the left-side of the page.

5. Click Save to save changes and apply them to the target computers. To leave the policy
page without saving changes, click Cancel.

Note
To learn how to work with policies, refer to “Managing Policies” (p. 120).

10.2.1. General
General settings help you manage user interface display options, communication options,
update preferences, password protection and other settings of Endpoint Security.

The settings are organized into the following sections:

• Details
• Display
• Communication
• Advanced
• Update

Details

The Details page shows general policy details:
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• Policy name

• User who created the policy

• Date and time when the policy was created

• Date and time when the policy was last modified

Computer Policies

You can rename the policy by entering the new name in the corresponding field and clicking
Save. Policies should have suggestive names so that you or other administrator can quickly
identify them.

Note
By default, only the user who created the policy can modify it. To change that, the policy
owner must check the option Allow other users to change this policy from the policy’s
Details page.

Display

In this section you can configure the user interface display options.
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Computer Policies - Display settings

• Enable Silent Mode. Use the checkbox to turn Silent Mode on or off. Silent Mode is
designed to help you easily disable user interaction in Endpoint Security. When turning
on Silent Mode, the following changes are made to the policy configuration:

– The Show icon in notification area,Display notification pop-ups andDisplay alert
pop-ups options in this section will be disabled.

– If the firewall protection level was set to Ruleset and ask or Ruleset, known files
and ask it will be changed to Ruleset, known files and allow. Otherwise, the
protection level setting will remain unchanged.

• Show icon in notification area. Select this option to show the Bitdefender icon in
the notification area (also known as the system tray). The icon informs users on their
protection status by changing its appearance and displaying a corresponding notification
pop-up. Additionally, users can right-click it to quickly open the Endpoint Security main
window or About window. Opening the About window automatically initiates an
on-demand update.

• Display notification pop-ups. Select this option to inform users about important security
events such as the detection of malware and the action taken through small notification
pop-ups. The pop-ups disappear automatically within a few seconds without user
intervention.
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• Display alert pop-ups. Different from notification pop-ups, alert pop-ups prompt users
for action. If you choose not to display alert pop-ups, Endpoint Security automatically
takes the recommended action. Alert pop-ups are generated in the following situations:

– If the firewall is set to prompt the user for action whenever unknown applications
request network or Internet access.

– If Active Virus Control / Intrusion Detection System is enabled, whenever a potentially
dangerous application is detected.

– If device scanning is enabled, whenever an external storage device is connected to
the computer. You can configure this setting in the Antimalware > On-demand
section.

• Status Alerts. Users are informed about their protection status in two ways:

– The security status area of the main window displays an appropriate status message
and changes its color depending on detected issues.

– The Bitdefender icon in the notification area changes its appearance when issues
are detected.

The protection status is determined based on the selected status alerts and it refers to
security configuration issues or other security risks. For example, if the Antimalware
status option is selected, users will be informed whenever there is a problem relating to
their antimalware protection (for example, if on-access scanning is disabled or a system
scan is overdue).

Select the security aspects that you want to be monitored. If you do not want users to
be informed about existing issues, clear all check boxes.

• Technical Support Information. You can customize the technical support and contact
information available in Endpoint Security by filling in the corresponding fields. Users

can access this information from the Endpoint Security window by clicking the icon

in the lower-right corner (or, alternatively, by right-clicking the Endpoint Security icon
in the system tray and selecting About).

Communication

When multiple communication servers are available on the Small Office Security appliance,
you can assign the target computers with one or several communication servers via policy.
Available Endpoint Security Relays, which serve as communication servers, are also taken
into account.

To assign communication servers to target computers:

1. In the Endpoint Communication Assignment table, click the Name field. The list of
detected communication servers is displayed.

2. Select an entity.
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Computer Polices - Communication settings

3. Click the Add button at the right side of the table.

The communication server is added to the list. All target computers will communicate
with Control Center via the specified communication server.

4. Follow the same steps to add several communication servers, if available.

5. You can configure the communication servers priority using the up and down arrows
available at the right side of each entity. The communication with target computers will
be carried out through the entity placed on top of the list. When the communication with
this entity cannot be done, the next one will be taken into account.

6. To delete one entity from the list, click the corresponding Delete button at the right
side of the table.

Advanced

In this section you can configure general settings and the uninstall password.
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Computer Policies - Advanced settings

• Remove events older than (days). Endpoint Security keeps a detailed log of events
concerning its activity on the computer (also including computer activities monitored by
Content Control). By default, events are deleted from the log after 30 days. If you want
to change this interval, choose a different option from the menu.

• Submit crash reports to Bitdefender. Select this option so that reports will be sent to
Bitdefender Labs for analysis if Endpoint Security crashes. The reports will help our
engineers find out what caused the problem and prevent it from occurring again. No
personal information will be sent.

• Password configuration. To prevent users with administrative rights from uninstalling
protection, you must set a password.

The uninstall password can be configured before installation by customizing the installation
package. If you have done so, selectKeep current settings to keep the current password.

To set the password, or to change the current password, select Enable password and
enter the desired password. To remove password protection, select Disable password.

Update

In this section you can configure the Endpoint Security update settings. Updates are very
important as they allow countering the latest threats.
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Computer Policies - Update options

• Update interval (hours). Endpoint Security automatically checks for, downloads and
installs updates every hour (default setting). Automatic updates are performed silently in
the background.

To change the automatic update interval, choose a different option from the menu. Please
note that automatic update cannot be turned off.

• Postpone reboot. Some updates require a system restart to install and work properly.
By selecting this option, the programwill keep working with the old files until the computer
is restarted, without informing the user. Otherwise, a notification in the user interface will
prompt the user to restart the system whenever an update requires it.

If you choose to postpone reboot, you can set a convenient time when computers will
reboot automatically if (still) needed. This can be very useful for servers. Select If needed,
reboot after installing updates and specify when it is convenient to reboot (daily or
weekly on a certain day, at a certain time of day).

• Proxy Settings. Select this option if computers connect to the Internet (or to the local
update server) through a proxy server. There are three options to set the proxy settings:

– Import proxy settings from default browser. Endpoint Security can import proxy
settings from the most popular browsers, including the latest versions of Internet
Explorer, Mozilla Firefox and Opera.
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– Auto-detect network proxy. Endpoint Security uses the Web Proxy Auto-Discovery
(WPAD) protocol included in Windows to automatically retrieve proxy settings from
a Proxy Auto-Configuration (PAC) file published on the local network. If no PAC file
is available, updates will fail.

– Use custom proxy settings. If you know the proxy settings, select this option and
then specify them:
• Server - type in the IP of the proxy server.
• Port - type in the port used to connect to the proxy server.
• Username - type in a user name recognized by the proxy.
• Password - type in the valid password of the previously specified user.

Note
Changing the proxy configuration option will overwrite existing proxy settings in Endpoint
Security.

Additionally, you must select the Use Proxy check box corresponding to the update
location to which the settings apply (the Internet or local update server address).

Computer Policies - Update Locations

• Update Locations. To avoid overloading the outside network traffic, Endpoint Security
is configured to update from the local Small Office Security update server. You can also
add other update server addresses to the list and configure their priority using the up
and down buttons displayed on mouse-over. If the first update location is unavailable,
the next one is checked and so on.

To set the local update address:

1. Enter the address of the local update server in the Add location field. Use one of
these syntaxes:
– update_server_ip:port
– update_server_name:port

The default port is 7074.
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2. If client computers connect to the local update server through a proxy server, select
Use Proxy.

3. Click the Add button at the right side of the table.

4. Use the Up / Down arrows in the Action column to set the local update address
the first one in the list. Place the mouse cursor over the corresponding row in order
for the arrows to become visible.

To remove a location from the list, move the cursor over it and click the corresponding

Delete button. Although you can remove the default update location, this is not
recommended.

10.2.2. Antimalware
The Antimalware module protects the system against all kinds of malware threats (viruses,
Trojans, spyware, rootkits, adware and so on). The protection is divided into two categories:

• On-access scanning: prevents new malware threats from entering the system.

• On-demand scanning: allows detecting and removing malware already residing in the
system.

When it detects a virus or other malware, Endpoint Security will automatically attempt to
remove the malware code from the infected file and reconstruct the original file. This operation
is referred to as disinfection. Files that cannot be disinfected are moved to quarantine in
order to contain the infection. When a virus is in quarantine it cannot do any harm because
it cannot be executed or read.

Advanced users can configure scan exclusions if they do not want specific files or file types
to be scanned.

The settings are organized into the following sections:

• On-Access
• On-Demand
• Exclusions
• Quarantine

On-Access

In this section you can configure the two real-time antimalware protection components:
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Computer Policies - On Access Settings

• On-access scanning
• Active Virus Control

On-access Scanning Settings

On-access scanning prevents new malware threats from entering the system - it scans files
when they are accessed (opened, moved, copied or executed), email messages sent and
received, and web traffic.

To configure on-access scanning:

1. Use the checkbox to turn on-access scanning on or off. If you turn off on-access scanning,
computers will be vulnerable to malware.

2. For a quick configuration, click the security level that best suits your needs (Aggressive,
Normal or Permissive). Use the description on the right side of the scale to guide your
choice.

3. Advanced users can configure the scan settings in detail by selecting the Custom
protection level and clicking the Settings link. TheOn-access Scanning Settingswindow
will appear, containing the several options organized under two tabs, General and
Advanced. Options are described hereinafter from the first tab to the last:

• File Location. Use these options to specify which types of files you want to be
scanned. Scan preferences can be configured separately for local files (stored on the
local computer) or network files (stored on network shares). If antimalware protection
is installed on all computers in the network, you may disable the network files scan
to allow for a faster network access.

You can set Endpoint Security to scan all accessed files (regardless of their file
extension), application files only or specific file extensions you consider to be
dangerous. Scanning all accessed files provides best protection, while scanning
applications only can be used for better system performance.
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Note
Application files are far more vulnerable to malware attacks than other types of files.
For more information, refer to “List of Application File Types” (p. 214).

If you want only specific extensions to be scanned, chooseUser defined extensions
from the menu and then enter the extensions in the edit field, pressing Enter after
each extension.

For system performance reasons, you can also exclude large files from scanning.
SelectMaximum size (MB) checkbox and specify the size limit of the files which will
be scanned. Use this option wisely because malware can affect larger files too.

• Archives Select Scan inside archives if you want to enable on-access scanning of
archived files. Scanning inside archives is a slow and resource-intensive process,
which is therefore not recommended for real-time protection. Archives containing
infected files are not an immediate threat to system security. The malware can affect
the system only if the infected file is extracted from the archive and executed without
having on-access scanning enabled.

If you decide on using this option, you can configure the following optimization options:

– Archive maximum size (MB). You can set a maximum accepted size limit of
archives to be scanned on-access. Select the corresponding check box and type
the maximum archive size (in MB).

– Archive maximum depth (levels). Select the corresponding check box and
choose the maximum archive depth from the menu. For best performance choose
the lowest value, for maximum protection choose the highest value.

• Miscellaneous. Select the corresponding check boxes to enable the desired scan
options.

– Scan boot sectors. Scans the system’s boot sector. This sector of the hard disk
contains the necessary computer code to start the boot process. When a virus
infects the boot sector, the drive may become inaccessible and you may not be
able to start your system and access your data.

– Scan only new or changed files. By scanning only new and changed files, you
may greatly improve overall system responsiveness with a minimum trade-off in
security.

– Scan for keyloggers. Keyloggers record what you type on your keyboard and
send reports over the Internet to a malicious person (hacker). The hacker can find
out sensitive information from the stolen data, such as bank account numbers
and passwords, and use it to gain personal benefits.

– Scan for Potentially Unwanted Applications (PUA). A Potentially Unwanted
Application (PUA) is a program that may be unwanted on the PC and sometimes
comes bundled with freeware software. Such programs can be installed without
the user's consent (also called adware) or will be included by default in the express
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installation kit (ad-supported). Potential effects of these programs include the
display of pop-ups, installing unwanted toolbars in the default browser or running
several processes in the background and slowing down the PC performance.

• Scan Actions. Depending on the type of detected file, the following actions are taken
automatically:

– Default action for infected files. Files detected as infected match a malware
signature in the Bitdefender Malware Signature Database. Endpoint Security can
normally remove themalware code from an infected file and reconstruct the original
file. This operation is known as disinfection.

If an infected file is detected, Endpoint Security will automatically attempt to
disinfect it. If disinfection fails, the file is moved to quarantine in order to contain
the infection.

Important
For particular types of malware, disinfection is not possible because the detected
file is entirely malicious. In such cases, the infected file is deleted from the disk.

– Default action for suspect files. Files are detected as suspicious by the heuristic
analysis. Because B-HAVE is a heuristic analysis technology, Endpoint Security
cannot be sure that the file is actually infected with malware. Suspect files cannot
be disinfected, because no disinfection routine is available.

When a suspect file is detected, users will be denied access to that file in order
to prevent a potential infection.

Though not recommended, you can change the default actions. You can define two
actions for each type of file. The following actions are available:

Deny access
Deny access to detected files.

Disinfect
Remove the malware code from infected files. It is recommended to always keep
this as the first action to be taken on infected files.

Delete
Delete detected files from the disk, without any warning. It is advisable to avoid
using this action.

Move to quarantine
Move detected files from their current location to the quarantine folder.
Quarantined files cannot be executed or opened; therefore, the risk of getting
infected disappears. You can manage quarantine files from the Quarantine page
of the console.
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Active Virus Control Settings

Bitdefender Active Virus Control is an innovative proactive detection technology which uses
advanced heuristic methods to detect new potential threats in real time.

Active Virus Control continuously monitors the applications running on the computer, looking
for malware-like actions. Each of these actions is scored and an overall score is computed
for each process. When the overall score for a process reaches a given threshold, the process
is considered to be harmful. Active Virus Control will automatically try to disinfect the detected
file. If the disinfection routine fails, Active Virus Control will delete the file.

Note
Before applying the disinfect action, a copy of the file is sent to quarantine so as you can
restore the file later, in the case of a false positive. This action can be configured using the
Copy files to quarantine before applying the disinfect action option available in the
Quarantine tab of the policy settings. This option is enabled by default in the policy templates.

Note
For more information, go to our web site and check out the whitepaper on Active Virus
Control.

To configure Active Virus Control:

1. Use the checkbox to turn Active Virus Control on or off. If you turn off Active Virus Control,
computers will be vulnerable to unknown malware.

2. Click the security level that best suits your needs (Aggressive, Normal or Permissive).
Use the description on the right side of the scale to guide your choice.

Note
As you set the protection level higher, Active Virus Control will require fewer signs of
malware-like behavior to report a process. This will lead to a higher number of applications
being reported and, at the same time, to an increased likelihood of false positives (clean
applications detected as malicious).

3. You should create exclusion rules for commonly used or known applications to prevent
false positives (incorrect detection of legitimate applications). Go to the Exclusions tab
and configure AVC/IDS process exclusion rules for trusted applications.
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Computer policy - AVC/IDS process exclusion

On-Demand

In this section you can configure antimalware scan tasks that will run regularly on the target
computers, according to the schedule you specify.

Computer Policies - On Demand Scan Tasks

The scanning is performed silently in the background. The user is informed that a scanning
process is running only through an icon that appears in the system tray.

Though not mandatory, it is recommended to schedule a comprehensive system scan to
run weekly on all computers. Scanning computers regularly is a proactive security measure
that can help detect and block malware that might evade real-time protection features.

Besides regular scans, you can also configure the automatic detection and scanning of
external storage media.
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Managing Scan Tasks

The Scan Tasks table informs you of the existing scan tasks, providing important information
on each of them:

• Task name and type.

• Schedule based on which the task runs regularly (recurrence).

• Time when the task was first run.

There are two default system scan tasks which you can configure to run as needed:

• Quick Scan uses in-the-cloud scanning to detect malware running in the system. Running
a Quick Scan usually takes less than a minute and uses a fraction of the system resources
needed by a regular virus scan.

• Full Scan checks the entire computer for all types of malware threatening its security,
such as viruses, spyware, adware, rootkits and others.

The scan options of the default scan tasks are preconfigured and you cannot change them.

Besides the default scan tasks (which you cannot delete or duplicate), you can create as
many custom scan tasks as you want. A custom scan task allows you to choose the specific
locations to be scanned and to configure the scan options.

To create and configure a new custom scan task, click the Add button at the right side
of the table. To change the settings of an existing scan task, click the name of that task.
Refer to the following topic to learn how to configure the task settings.

To remove a task from the list, select the task and click the Delete button at the right
side of the table.

Configuring Scan Tasks

The scan task settings are organized under three tabs:

• General: set task name and execution schedule.

• Options: choose a scan profile for quick configuration of the scan settings and define
scan settings for a custom scan.

• Target: select the files and folders to be scanned.

Options are described hereinafter from the first tab to the last:
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Computer Policies - Configuring On Demand Scan Tasks General Settings

• Details. Choose a suggestive name for the task to help easily identify what it is about.
When choosing a name, consider the scan task target and possibly the scan settings.

• Scheduler. Use the scheduling options to configure the scan schedule. You can set the
scan to run every few hours, days or weeks, starting with a specified date and time.

Please consider that computers must be on when the schedule is due. A scheduled scan
will not run when due if the computer is turned off, hibernating or in sleep mode, or if no
user is logged on. In such situations, the scan will be postponed until next time.

Note
The scheduled scan will run at the target endpoint local time. For example, if the
scheduled scan is set to start at 6:00 PM and the endpoint is in a different timezone than
Control Center, the scanning will start at 6:00 PM (endpoint time).

• Scan Options. Click the security level that best suits your needs (Aggressive, Normal
or Permissive). Use the description on the right side of the scale to guide your choice.

Based on the selected profile, the scan options in the Settings section are automatically
configured. However, if you want to, you can configure them in detail. To do that, select
the Custom check box and then go to the Settings section.
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Computers Scan Task

• File Types. Use these options to specify which types of files you want to be scanned.
You can set Endpoint Security to scan all files (regardless of their file extension),
application files only or specific file extensions you consider to be dangerous. Scanning
all files provides best protection, while scanning applications only can be used to perform
a quicker scan.

Note
Application files are far more vulnerable to malware attacks than other types of files. For
more information, refer to “List of Application File Types” (p. 214).

If you want only specific extensions to be scanned, choose User Defined Extensions
from the menu and then enter the extensions in the edit field, pressing Enter after each
extension.

• Archives. Archives containing infected files are not an immediate threat to system
security. The malware can affect the system only if the infected file is extracted from the
archive and executed without having real-time protection enabled. However, it is
recommended to use this option in order to detect and remove any potential threat, even
if it is not an immediate threat.

Note
Scanning archived files increases the overall scanning time and requires more system
resources.

– Scan inside archives. Select this option if you want to check archived files for
malware. If you decide on using this option, you can configure the following
optimization options:
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• Limit archive size to (MB). You can set a maximum accepted size limit of archives
to be scanned. Select the corresponding check box and type themaximum archive
size (in MB).

• Maximum archive depth (levels). Select the corresponding check box and
choose the maximum archive depth from the menu. For best performance choose
the lowest value, for maximum protection choose the highest value.

– Scan email archives. Select this option if you want to enable scanning of email
message files and email databases, including file formats such as .eml, .msg, .pst,
.dbx, .mbx, .tbb and others.

Note
Email archive scanning is resource intensive and can impact system performance.

• Miscellaneous. Select the corresponding check boxes to enable the desired scan
options.

– Scan boot sectors. Scans the system’s boot sector. This sector of the hard disk
contains the necessary computer code to start the boot process. When a virus infects
the boot sector, the drive may become inaccessible and you may not be able to start
your system and access your data.

– Scan registry. Select this option to scan registry keys. Windows Registry is a
database that stores configuration settings and options for the Windows operating
system components, as well as for installed applications.

– Scan for rootkits. Select this option to scan for rootkits and objects hidden using
such software.

– Scan for keyloggers. Select this option to scan for keylogger software.

– Scanmemory. Select this option to scan programs running in the system's memory.

– Scan cookies. Select this option to scan the cookies stored by browsers on the
computer.

– Scan only new and changed files. By scanning only new and changed files, you
may greatly improve overall system responsiveness with a minimum trade-off in
security.

– Scan for Potentially Unwanted Applications (PUA). A Potentially Unwanted
Application (PUA) is a program that may be unwanted on the PC and sometimes
comes bundled with freeware software. Such programs can be installed without the
user's consent (also called adware) or will be included by default in the express
installation kit (ad-supported). Potential effects of these programs include the display
of pop-ups, installing unwanted toolbars in the default browser or running several
processes in the background and slowing down the PC performance.

Security Policies 141

ENTERPRISE BITDEFENDER SMALL OFFICE SECURITY



• Actions. Depending on the type of detected file, the following actions are taken
automatically:

– Default action for infected files. Files detected as infected match a malware
signature in the Bitdefender Malware Signature Database. Endpoint Security can
normally remove the malware code from an infected file and reconstruct the original
file. This operation is known as disinfection.

If an infected file is detected, Endpoint Security will automatically attempt to disinfect
it. If disinfection fails, the file is moved to quarantine in order to contain the infection.

Important
For particular types of malware, disinfection is not possible because the detected
file is entirely malicious. In such cases, the infected file is deleted from the disk.

– Default action for suspect files. Files are detected as suspicious by the heuristic
analysis. Because B-HAVE is a heuristic analysis technology, Endpoint Security cannot
be sure that the file is actually infected with malware. Suspect files cannot be
disinfected, because no disinfection routine is available.

Scan tasks are configured by default to ignore suspect files. You may want to change
the default action in order to move suspect files to quarantine. Quarantined files are
sent for analysis to Bitdefender Labs on a regular basis. If malware presence is
confirmed, a signature is released to allow removing the malware.

– Default action for rootkits. Rootkits represent specialized software used to hide
files from the operating system. Though not malicious in nature, rootkits are often
used to hide malware or to conceal the presence of an intruder into the system.

Detected rootkits and hidden files are ignored by default.

Though not recommended, you can change the default actions. You can specify a second
action to be taken if the first one fails and different actions for each category. Choose
from the corresponding menus the first and the second action to be taken on each type
of detected file. The following actions are available:

Take no action
No action will be taken on detected files. These files will only appear in the scan log.

Disinfect
Remove the malware code from infected files. It is recommended to always keep
this as the first action to be taken on infected files.

Delete
Delete detected files from the disk, without any warning. It is advisable to avoid
using this action.
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Move to quarantine
Move detected files from their current location to the quarantine folder. Quarantined
files cannot be executed or opened; therefore, the risk of getting infected disappears.
You can manage quarantine files from the Quarantine page of the console.

• Scan Target. Add to the list all the locations you want to be scanned on the target
computers.

To add a new file or folder to be scanned:

1. Choose a predefined location from the drop-down menu or enter the Specific paths
you want to scan.

2. Specify the path to the object to be scanned in the edit field.

– If you have chosen a predefined location, complete the path as needed. For
example, to scan the entire Program Files folder, it suffices to select the
corresponding predefined location from the drop-down menu. To scan a specific
folder from Program Files, you must complete the path by adding a backslash
(\) and the folder name.

– If you have chosen Specific paths, enter the full path to the object to be scanned.
It is advisable to use system variables (where appropriate) to make sure the path
is valid on all target computers.

3. Click the corresponding Add button.

To edit an existing location, click it. To remove a location from the list, move the cursor

over it and click the corresponding Delete button.

• Exclusions. You can either choose to use the global exclusions on a specific scan or
define explicit exclusions for each scan. For more details regarding exclusions, refer to
“Exclusions” (p. 144).

Device Scanning

You can configure Endpoint Security to automatically detect and scan external storage
devices when they are connected to the computer. Detected devices fall into one of these
categories:

• CDs/DVDs

• USB storage devices, such as flash pens and external hard-drives

• Mapped network drives

• Devices with more than a specified amount of stored data.

Device scans automatically attempt to disinfect files detected as infected or to move them
to quarantine if disinfection is not possible. Take into account that no action can be taken
on infected files detected on CDs/DVDs or on mapped network drives that allow read-only
access.
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Note
During a device scan, the user can access any data from the device.

If alert pop-ups are enabled in the General > Display section, the user is prompted whether
or not to scan the detected device instead of the scan starting automatically.

When a device scan is started:

• A notification pop-up informs the user about the device scan, provided that notification
pop-ups are enabled in the General > Display section.

• A scan icon appears in the system tray. The user can double-click this icon to open
the scan window and check the scan progress.

Once the scan is completed, the user must check detected threats, if any.

Select Device Scanning option to enable the automatic detection and scanning of storage
devices. To configure device scanning individually for each type of device, use the following
options:

• CD/DVD media

• USB storage devices

• Mapped network drives

• Do not scan devices with stored datamore than (MB). Use this option to automatically
skip scanning of a detected device if the amount of stored data exceeds the specified
size. Type the size limit (in megabytes) in the corresponding field. Zero means that no
size restriction is imposed.

Note
This option applies only to CDs/DVDs and USB storage devices.

Exclusions

In this section you can configure scan exclusion rules. Exclusions can apply to on-access
scanning or on-demand scanning, or to both. Based on the object of the exclusion, there
are four types of exclusions:
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Computer Policies - Antimalware Exclusions

• File exclusions: the specified file only is excluded from scanning.

• Folder exclusions: all files inside the specified folder and all of its subfolders are excluded
from scanning.

• Extension exclusions: all files having the specified extension are excluded from scanning.

• Process exclusions: any object accessed by the excluded process is also excluded
from scanning. You can also configure process exclusions for the Active Virus Control
and Intrusion Detection System technologies.

Important
Scan exclusions are to be used in special circumstances or followingMicrosoft or Bitdefender
recommendations. For an updated list of exclusions recommended by Microsoft, please
refer to this article. If you have an EICAR test file that you use periodically to test antimalware
protection, you should exclude it from on-access scanning.

Use the check box Activate exclusions to turn exclusions on or off.

To configure an exclusion rule:

1. Select the exclusion type from the menu.

2. Depending on the exclusion type, specify the object to be excluded as follows:

• Extension exclusions. Specify one or more file extensions to be excluded from
scanning, separating them with a semicolon ";". You can enter extensions with or
without the preceding dot. For example, enter txt to exclude text files.

Note
Before you exclude extensions, document yourself to see which are commonly
targeted by malware and which are not.

• File, folder and process exclusions. You must specify the path to the excluded
object on the target computers.
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a. Choose from the menu either a predefined location or the Specific paths option.

b. If you have chosen a predefined location, complete the path as needed. For
example, to exclude the entire Program Files folder, it suffices to select the
corresponding predefined location from the menu. To exclude a specific folder
from Program Files, you must complete the path by adding a backslash (\) and
the folder name. For process exclusions, you must also add the name of the
application's executable file.

c. If you have chosen Specific paths, enter the full path to the object to be excluded.
It is advisable to use system variables (where appropriate) to make sure the path
is valid on all target computers.

3. Select the types of scanning the rule will apply to. Some exclusions may be relevant for
on-access scanning only, some for on-demand scanning only, while others may be
recommended for both. Process exclusions can be configured for on-access scanning
and for the Active Virus Control and Intrusion Detection System technologies.

Note
Please note that on-demand scanning exclusions will NOT apply to contextual scanning.
Contextual scanning is initiated by right-clicking a file or folder and selecting Scan with
Endpoint Security by Bitdefender.

4. Click the Add button. The new rule will be added to the list.

To remove a rule from the list, click the corresponding Delete button.

Quarantine

In this section you can configure the quarantine settings.

Computer Policies - Quarantine
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You can set Endpoint Security to automatically perform the following actions:

• Delete files older than (days). By default, quarantined files older than 30 days are
automatically deleted. If you want to change this interval, choose a different option from
the menu.

• Submit quarantined files to Bitdefender Labs every (hours). Keep this option selected
to automatically send quarantined files to Bitdefender Labs. You can edit the time interval
between quarantined files are being sent (one hour by default). The sample files will be
analyzed by the Bitdefender malware researchers. If malware presence is confirmed, a
signature is released to allow removing the malware.

By default, quarantined files are automatically sent to Bitdefender Labs every hour. If
you want to change this interval, choose a different option from the menu.

• Rescan quarantine after malware signatures updates. Keep this option selected to
automatically scan quarantined files after each malware signatures update. Cleaned files
are automatically moved back to their original location.

• Copy files to quarantine before applying the disinfect action. Select this option to
prevent data loss in case of false positives and copy each file detected as infected to
quarantine before applying the disinfect action. You can afterwards restore legitimate
files from the Quarantine page.

10.2.3. Firewall
The Firewall protects the computer from inbound and outbound unauthorized connection
attempts.

The Firewall's functionality relies on network profiles. The profiles are based on trust levels,
which have to be defined for each network.

Each time a new connection is created, the Firewall detects it and compares the connection's
adapter information with the information from the existing profiles, applying the correct
profile. For detailed information on how the profiles are applied, see networks settings.

The settings are organized into the following sections:

• General
• Settings
• Rules

General

In this section you can enable or disable the Bitdefender Firewall and configure the general
settings.
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Computer Policies - Firewall General Settings

• Firewall. Use the checkbox to turn Firewall on or off. If you turn off firewall protection,
computers will be vulnerable to network and Internet attacks.

• Block port scans. Port scans are frequently used by hackers to find out which ports
are open on a computer. They might then break into the computer if they find a less
secure or vulnerable port.

• Allow Internet Connection Sharing (ICS). Select this option to set the firewall to allow
Internet Connection Sharing traffic.

Note
This option does not automatically enable ICS on the user's system.

• Monitor Wi-Fi connections. Endpoint Security can inform users connected to a Wi-Fi
network when a new computer joins the network. To display such notifications on the
user's screen, select this option.

• Log verbosity level. Endpoint Security maintains a log of events regarding the Firewall
module usage (enabling/disabling firewall, traffic blocking, modifying settings) or generated
by the activities detected by this module (scanning ports, blocking connection attempts
or traffic according to the rules). Choose an option from the Log verbosity level to specify
how much information the log should include.

• Intrusion Detection System. Intrusion Detection System monitors the system for
suspicious activities (for example, unauthorized attempts to alter the Bitdefender files,
DLL injections, keylogging attempts, etc.).

To configure Intrusion Detection System:

1. Use the checkbox to turn Intrusion Detection System on or off.

2. Click the security level that best suits your needs (Aggressive, Normal or Permissive).
Use the description on the right side of the scale to guide your choice.
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To prevent a legitimate application from being detected by Intrusion Detection System,
add an AVC/IDS process exclusion rule for that application in the Antimalware >
Exclusions section.

Settings

The firewall automatically applies a profile based on the network type. You can specify the
generic profiles to be applied depending on the adapter type and also specify profiles
individually for your company's networks. The settings are organized under the following
tables:

• Networks
• Adapters

Computer Policies - Firewall Settings

Networks Settings

For the firewall to function properly, the administrator has to define the networks that will
be managed in the Networks table. The fields from the Networks table are described as
follows:

• Name. A name by which the administrator can recognize the network in the list.

• Type. Select from the menu the profile type assigned to the network.

Endpoint Security automatically applies one of four firewall profiles to each detected
network connection to define the basic traffic filtering options. The firewall profiles are:

– Trusted network. Disable the firewall for the respective adapter.

– Home/Office network. Allow all traffic to and from computers in the local network.

– Public network. All traffic is filtered.
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– Untrusted network. Completely block network and Internet traffic through the
respective adapter.

• Identification. Select from the menu the method through which the network will be
identified by Endpoint Security. The networks can be identified by three methods: DNS,
Gateway and Network.

• MAC. Use this field to specify the MAC address of a specific DNS server.

Note
This field is mandatory if the DNS identification method is selected.

• IP. Use this field to define specific IP addresses in a network. You can also use a mask
to define an entire sub-network.

After you defined a network, click the Add button at the right side of the table to add it to
the list.

Adapters Settings

If a network that is not defined in the Networks table is detected, Endpoint Security detects
the type of the network adapter and applies a corresponding profile to the connection. The
fields from the Adapters table are described as follows:

• Type. Displays the type of the network adapters. Endpoint Security can detect three
predefined adapter types: Wired, Wireless and Virtual (Virtual Private Network).

• Network Type. Describes the network profile assigned to a specific adapter type. The
network types are described in the network settings section. Clicking the network type
field allows you to change the setting. If you select Let Windows decide, for any new
network connection detected after the policy is applied, Endpoint Security applies a
firewall profile based on the network classification in Windows, ignoring the settings from
the Adapters table.

If the detection based onWindows Network Manager fails, a basic detection is attempted.
A generic profile is used in which the network type is considered Public and the stealth
settings are set to On. If the IP address of the domain the computer is found in is in one
of the networks associated with the adapter, then the trust level is considered
Home/Office and the stealth settings are set to Remote On. If the computer is not in a
domain, this condition is not applicable.

• Stealth Mode. Hides the computer from malicious software and hackers in the network
or the Internet. Configure Stealth Mode as needed for each adapter type by selecting
one of the following options:

– On. The computer is invisible from both the local network and the Internet.

– Off. Anyone from the local network or the Internet can ping and detect the computer.
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– Remote. The computer cannot be detected from the Internet. Anyone from the local
network can ping and detect the computer.

Rules

In this section you can configure the application network access and data traffic rules
enforced by the firewall. Note that available settings apply only to the Home/Office and
Public firewall profiles.

Computers policies - Firewall rules settings

Settings

You can configure the following settings:

• Protection level. The selected protection level defines the firewall decision-making logic
used when applications request access to network and Internet services. The following
options are available:

Ruleset and allow
Apply existing firewall rules and automatically allow all other connection attempts.
For each new connection attempt, a rule is created and added to the ruleset.

Ruleset and ask
Apply existing firewall rules and prompt the user for action for all other connection
attempts. An alert window with detailed information about the unknown connection
attempt is displayed on the user's screen. For each new connection attempt, a rule
is created and added to the ruleset.
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Ruleset and deny
Apply existing firewall rules and automatically deny all other connection attempts.
For each new connection attempt, a rule is created and added to the ruleset.

Ruleset, known files and allow
Apply existing firewall rules, automatically allow connection attempts made by known
applications and automatically allow all other unknown connection attempts. For
each new connection attempt, a rule is created and added to the ruleset.

Ruleset, known files and ask
Apply existing firewall rules, automatically allow connection attempts made by known
applications and prompt the user for action for all other unknown connection
attempts. An alert window with detailed information about the unknown connection
attempt is displayed on the user's screen. For each new connection attempt, a rule
is created and added to the ruleset.

Ruleset, known files and deny
Apply existing firewall rules, automatically allow connection attempts made by known
applications and automatically deny all other unknown connection attempts. For
each new connection attempt, a rule is created and added to the ruleset.

Note
Known files represent a large collection of safe, trustworthy applications, which is
compiled and continuously maintained by Bitdefender.

• Create aggressive rules. With this option selected, the firewall will create rules for each
different process that opens the application requesting network or Internet access.

• Create rules for applications blocked by IDS. With this option selected, the firewall
will automatically create a Deny rule each time the Intrusion Detection System blocks
an application.

• Monitor process changes. Select this option if you want each application attempting
to connect to the Internet to be checked whether it has been changed since the addition
of the rule controlling its Internet access. If the application has been changed, a new rule
will be created according to the existing protection level.

Note
Usually, applications are changed by updates. But there is a risk that they might be
changed by malware applications, with the purpose of infecting the local computer and
other computers in the network.

Signed applications are supposed to be trusted and have a higher degree of security.
You can select Ignore signed process to automatically allow changed signed applications
to connect to the Internet.

Security Policies 152

ENTERPRISE BITDEFENDER SMALL OFFICE SECURITY



Rules

The Rules table lists the existing firewall rules, providing important information on each of
them:

• Rule name or application it refers to.

• Protocol the rule applies to.

• Rule action (allow or deny packets).

• Actions you can take on the rule.

• Rule priority.

Note
These are the firewall rules explicitly enforced by the policy. Additional rules may be
configured on computers as a result of applying firewall settings.

A number of default firewall rules help you easily allow or deny popular traffic types. Choose
the desired option from the Permission menu.

Incoming ICMP / ICMPv6
Allow or deny ICMP / ICMPv6 messages. ICMP messages are often used by hackers
to carry out attacks against computer networks. By default, this type of traffic is denied.

Incoming Remote Desktop Connections
Allow or deny other computers' access over Remote Desktop Connections. By default,
this type of traffic is allowed.

Sending Emails
Allow or deny sending emails over SMTP. By default, this type of traffic is allowed.

Web Browsing HTTP
Allow or deny HTTP web browsing. By default, this type of traffic is allowed.

Printing in Another Network
Allow or deny access to printers in another local area network. By default, this type of
traffic is denied.

Windows Explorer traffic on HTTP / FTP
Allow or deny HTTP and FTP traffic from Windows Explorer. By default, this type of
traffic is denied.

Besides the default rules, you can create additional firewall rules for other applications
installed on computers. This configuration however is reserved for administrators with strong
networking skills.

To create and configure a new rule, click the Add button at the right side of the table.
Refer to the following topic for more information.
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To remove a rule from the list, click the corresponding Delete button at the right side of
the table.

Note
You can neither delete nor modify the default firewall rules.

Configuring Custom Rules

You can configure two types of firewall rules:

• Application-based rules. Such rules apply to specific software found on the client
computers.

• Connection-based rules. Such rules apply to any application or service that uses a
specific connection.

To create and configure a new rule, click the Add button at the right side of the table and
select the desired rule type from the menu. To edit an existing rule, click the rule name.

The following settings can be configured:

• Rule name. Enter the name under which the rule will be listed in the rules table ( for
example, the name of the application the rule applies to ).

• Application path (only for application-based rules). You must specify the path to the
application executable file on the target computers.

– Choose from the menu a predefined location and complete the path as needed. For
example, for an application installed in the Program Files folder, select
%ProgramFiles% and complete the path by adding a backslash (\) and the name
of the application folder.

– Enter the full path in the edit field. It is advisable to use system variables (where
appropriate) to make sure the path is valid on all target computers.

• Command line (only for application-based rules). If you want the rule to apply only when
the specified application is opened with a specific command in the Windows command
line interface, type the respective command in the edit field. Otherwise, leave it blank.

• Application MD5 (only for application-based rules). If you want the rule to check the
application's file data integrity based on its MD5 hash code, enter it in the edit field.
Otherwise, leave the field blank.

• Local Address. Specify the local IP address and port the rule applies to. If you have
more than one network adapter, you can clear the Any check box and type a specific IP
address. Likewise, to filter connections on a specific port or port range, clear the Any
check box and enter the desired port or port range in the corresponding field.
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• Remote Address. Specify the remote IP address and port the rule applies to. To filter
the traffic to and from a specific computer, clear the Any check box and type its IP
address.

• Apply rule only for directly connected computers. You can filter access based on
Mac address.

• Protocol. Select the IP protocol the rule applies to.

– If you want the rule to apply to all protocols, select Any.

– If you want the rule to apply to TCP, select TCP.

– If you want the rule to apply to UDP, select UDP.

– If you want the rule to apply to a specific protocol, select that protocol from theOther
menu.

Note
IP protocol numbers are assigned by the Internet Assigned Numbers Authority (IANA).
You can find the complete list of assigned IP protocol numbers at
http://www.iana.org/assignments/protocol-numbers.

• Direction. Select the traffic direction the rule applies to.

DescriptionDirection

The rule applies only for the outgoing traffic.Outbound

The rule applies only for the incoming traffic.Inbound

The rule applies in both directions.Both

• IP version. Select the IP version (IPv4, IPv6 or any) the rule applies to.

• Network. Select the type of network the rule applies to.

• Permission. Select one of the available permissions:

DescriptionPermission

The specified application will be allowed network / Internet access under
the specified circumstances.

Allow

The specified application will be denied network / Internet access under
the specified circumstances.

Deny

Click Save to add the rule.

For the rules you created, use the arrows at the right side of the table to set each rule priority.
The rule with higher priority is closer to the top of the list.
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10.2.4. Content Control
Use the Content Control module to configure your preferences regarding content filtering
and data protection for user activity including web browsing, email and software applications.
You can restrict or allow web access and application usage, configure traffic scan,
antiphishing and data protection rules. Please note that the configured Content Control
settings will apply to all users who log on to the target computers.

The settings are organized into the following sections:

• Traffic
• Web
• Data Protection
• Applications

Traffic

Configure the traffic security preferences using the settings under the following sections:

• Options
• Traffic Scan
• Traffic Scan Exclusions

Computer Policies - Content Control - Traffic

Options

• Scan SSL. Select this option if you want the Secure Sockets Layer (SSL) web traffic to
be inspected by the Endpoint Security protection modules.

• Show browser toolbar. The Bitdefender toolbar informs users about the rating of the
web pages they are viewing. The Bitdefender toolbar is not your typical browser toolbar.
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The only thing it ads to the browser is a small dragger at the top of every web
page. Clicking the dragger opens the toolbar.

Depending on how Bitdefender classifies the web page, one of the following ratings is
displayed on the left side of the toolbar:

– The message "This page is not safe" appears on a red background.

– The message "Caution is advised" appears on an orange background.

– The message "This page is safe" appears on a green background.

• Browser Search Advisor. Search advisor rates the results of Google, Bing and Yahoo!
searches, as well as links from Facebook and Twitter, by placing an icon in front of every
result. Icons used and their meaning:

You should not visit this web page.

This web page may contain dangerous content. Exercise caution if you decide to visit
it.

This is a safe page to visit.

Traffic Scan

Incoming emails and web traffic are scanned in real time to prevent malware from being
downloaded to the computer. Outgoing emails are scanned to prevent malware from infecting
other computers. Scanning the web traffic may slow down web browsing a little, but it will
block malware coming from the Internet, including drive-by downloads.

When an email is found infected, it is replaced automatically with a standard email informing
the receiver of the original infected email. If a web page contains or distributes malware, it
is automatically blocked. A special warning page is displayed instead to inform the user that
the requested web page is dangerous.

Though not recommended, you can disable email and web traffic scan to increase system
performance. This is not a major threat as long as on-access scanning of local files remains
enabled.

Traffic Scan Exclusions

You can choose to skip certain traffic of being scanned for malware while the traffic scan
options are enabled.

To define a traffic scan exclusion:

1. Select the exclusion type from the menu.

2. Depending on the exclusion type, define the traffic entity to be excluded from scanning
as follows:

• IP. Enter the IP address for which you do not want to scan the incoming and outgoing
traffic.
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• URL. Excludes from scanning the specified web addresses. To define an URL scan
exclusion:
– Enter a specific URL, such as www.example.com/example.html
– Use wildcards to define web address patterns:

• Asterisk (*) substitutes for zero or more characters.

• Question mark (?) substitutes for exactly one character. You can use several
question marks to define any combination of a specific number of characters.
For example, ??? substitutes for any combination of exactly three characters.

In the following table, you can find several sample syntaxes for specifying web
addresses.

Exception ApplicabilitySyntax

Any website or web page starting with www.example
(regardless of the domain extension).

www.example*

The exclusion will not apply to the subdomains of the
specified website, such as subdomain.example.com.

Any website ending in example.com, including pages
and subdomains thereof.

*example.com

Any website or web page whose address contains the
specified string.

*string*

Any website having the .com domain extension, including
pages and subdomains thereof. Use this syntax to exclude
from scanning the entire top-level domains.

*.com

Any web address starting with www.example?.com,
where ? can be replaced with any single character. Such

www.example?.com

websites might include: www.example1.com or
www.exampleA.com.

• Application. Excludes from scanning the specified process or application. To define
an application scan exclusion:
– Enter the full application path. For example, C:\Program Files\Internet

Explorer\iexplore.exe
– Use environment variables to specify the application path. For example:

%programfiles%\Internet Explorer\iexplore.exe
– Use wildcards to specify any applications matching a certain name pattern. For

example:
• c*.exe matches all applications starting with "c" (chrome.exe).
• ??????.exematches all applications with a name that contains six characters

(chrome.exe, safari.exe, etc.).
• [^c]*.exe matches all application except for those starting with "c".

Security Policies 158

ENTERPRISE BITDEFENDER SMALL OFFICE SECURITY



• [^ci]*.exe matches all application except for those starting with "c" or "i".

3. Click the Add button at the right side of the table.

To remove an entity from the list, click the corresponding Delete button.

Web

In this section you can configure the web browsing security preferences.

The settings are organized under the following sections:

• Web Control
• Antiphishing

Web Control

Web Control helps you allow or block web access for users or applications during specified
time intervals.

The web pages blocked by Web Control are not displayed in the browser. Instead, a default
web page is displayed informing the user that the requested web page has been blocked
by Web Control.

Computer Policies - Content Control - Web

Use the switch to turn Web Control on or off.

You have three configuration options:

• Select Allow to always grant web access.

• Select Block to always deny web access.

• Select Schedule to enable time restrictions on web access upon a detailed schedule.

Either if you choose to allow or block the web access, you can define exceptions to these
actions for entire web categories or only for specific web addresses. Click Settings to
configure your web access schedule and exceptions as follows:
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Scheduler

To restrict Internet access to certain times of day on a weekly basis:

1. Select from the grid the time intervals during which you want Internet access to be
blocked.

You can click individual cells, or you can click and drag to cover longer periods. Click
again in the cell to reverse the selection.

To start a new selection, click Allow All or Block all, depending on the type of restriction
you wish to implement.

2. Click Save.

Note
Endpoint Security will perform updates every hour no matter if web access is blocked.

Categories

Web Categories Filter dynamically filters access to websites based on their content. You
can use theWeb Categories Filter for defining exceptions to the selectedWeb Control action
(Allow or Block) for entire web categories (such as Games, Mature Content or Online
Networks).

To configure Web Categories Filter:

1. Select Web Categories Filter.

2. For a quick configuration, click one of the predefined profiles (Aggressive, Normal or
Permissive). Use the description on the right side of the scale to guide your choice. You
can view the predefined actions for available web categories by clicking the Categories
button placed below.

3. If you are not satisfied with the default settings, you can define a custom filter:

a. Select Custom.

b. Click the Categories button to expand the corresponding section.

c. Find the category that you want in the list and choose the desired action from the
menu.

4. You can also choose to Treat Web Categories as exceptions for Web Access if you
want to ignore the existing web access settings and apply only theWeb Categories Filter.

5. Click Save.

Note
Allow permission for specific web categories is also taken into account during time
intervals when web access is blocked by Web Control.

•
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• Allow permissions work only when web access is blocked by Web Control, while Block
permissions work only when web access is allowed by Web Control.

• You can override the category permission for individual web addresses by adding them
with opposite permission in Web Control > Settings > Exclusions. For example, if a
web address is blocked by Web Categories Filter, add a web rule for that address with
permission set to Allow.

Exclusions

You can also define web rules to explicitly block or allow certain web addresses, overriding
the existing Web Control settings. Users will be able, for example, to access a specific
webpage also when the web browsing is blocked by Web Control.

To create a web rule:

1. Select Use Exceptions to enable web exceptions.

2. Enter the address you want to allow or block in the Web Address field.

3. Select Allow or Block from the Permission menu.

4. Click the Add button at the right side of the table to add the address to the exceptions
list.

5. Click Save.

To edit a web rule:

1. Click the web address you want to edit.

2. Modify the existing URL.

3. Click Save.

To remove a web rule:

1. Move the cursor over the web address you want to remove.

2. Click the Delete button.

3. Click Save.

Antiphishing

Antiphishing protection automatically blocks known phishing web pages to prevent users
from inadvertently disclosing private or confidential information to online fraudsters. Instead
of the phishing web page, a special warning page is displayed in the browser to inform the
user that the requested web page is dangerous.

Select Antiphishing to activate antiphishing protection. You can further tune Antiphishing
by configuring the following settings:

• Protection against fraud. Select this option if you want to extend protection to other
types of scams besides phishing. For example, websites representing fake companies,
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which do not directly request private information, but instead try to pose as legitimate
businesses and make a profit by tricking people into doing business with them.

• Protection against phishing. Keep this option selected to protect users against phishing
attempts.

If a legitimate web page is incorrectly detected as phishing and blocked, you can add it to
the whitelist to allow users to access it. The list should contain only websites you fully trust.

To manage antiphishing exceptions:

1. Click Exclusions.

2. Enter the web address and click the Add button.

To remove an exception from the list, move the cursor over it and click the Delete
button.

3. Click Save.

Data Protection

Data Protection prevents unauthorized disclosure of sensitive data based on
administrator-defined rules.

Computer Policies - Content Control - Data Protection

You can create rules to protect any piece of personal or confidential information, such as:

• Customer personal information

• Names and key details of in-development products and technologies

• Contact information of company executives
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Protected information might include names, phone numbers, credit card and bank account
information, email addresses and so on.

Based on the data protection rules you create, Endpoint Security scans the web and email
traffic leaving the computer for specific character strings (for example, a credit card number).
If there is a match, the respective web page or email message is blocked in order to prevent
protected data from being sent. The user is immediately informed about the action taken
by Endpoint Security through an alert web page or email.

To configure Data Protection:

1. Use the checkbox to turn on Data Protection.

2. Create data protection rules for all of the sensitive data you want to protect. To create
a rule:

a. Click the Add button at the right side of the table. A configuration window is
displayed.

b. Enter the name under which the rule will be listed in the rules table. Choose a
suggestive name so that you or other administrator can easily identify what the rule
is about.

c. Enter the data you want to protect (for example, the phone number of a company
executive or the internal name of a new product the company is working on). Any
combination of words, numbers or strings consisting of alphanumerical and special
characters (such as @, # or $) is accepted.

Make sure to enter at least five characters in order to avoid the mistaken blocking of
email messages and web pages.

Important
Provided data is stored in encrypted form on protected computers, but it can be
seen on your Control Center account. For extra safety, do not enter all of the data
you want to protect. In this case, you must clear the Match whole words option.

d. Configure the traffic scan options as needed.

• Scan web (HTTP traffic) - scans the HTTP (web) traffic and blocks the outgoing
data that matches the rule data.

• Scan email (SMTP traffic) - scans the SMTP (mail) traffic and blocks the outgoing
email messages that contain the rule data.

You can choose to apply the rule only if the rule data matches whole words or if the
rule data and the detected string case match.

e. Click Save. The new rule will be added to the list.
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3. Configure exclusions to data protection rules so that users can still send protected data
to authorized websites and recipients. Exclusions can be applied globally (to all rules) or
to specific rules only. To add an exclusion:
a. Click the Add button at the right side of the table. A configuration window is

displayed.
b. Enter the web or email address that users are authorized to disclose protected data

to.
c. Select the type of exclusion (web or email address).
d. From the Rules table, select the data protection rules(s) on which this exclusion

should be applied.
e. Click Save. The new exclusion rule will be added to the list.

Note
If an email containing blocked data is addressed to multiple recipients, those for which
exclusions have been defined will receive it.

To remove a rule or an exclusion from the list, click the corresponding Delete button at
the right side of the table.

Applications

In this section you can configure Application Control. Application Control helps you completely
block or restrict users' access to applications on their computers. Games, media and
messaging software, as well as other categories of software and malware can be blocked
in this way.

Computer Policies - Content Control - Applications

To configure Application Control:

1. Use the switch to turn on Application Control.
2. Specify the applications you want to restrict access to. To restrict access to an application:

a. Click the Add button at the right side of the table. A configuration window is
displayed.
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b. You must specify the path to the application executable file on the target computers.
There are two ways to do this:
• Choose from the menu a predefined location and complete the path as needed

in the edit field. For example, for an application installed in the Program Files
folder, select %ProgramFiles and complete the path by adding a backslash (\)
and the name of the application folder.

• Enter the full path in the edit field. It is advisable to use system variables (where
appropriate) to make sure the path is valid on all target computers.

c. Access Scheduler. Schedule the applications access during certain times of day on
a weekly basis:
• Select from the grid the time intervals during which you want to block access to

the application. You can click individual cells, or you can click and drag to cover
longer periods. Click again in the cell to reverse the selection.

• To start a new selection, click Allow All or Block All, depending on the type of
restriction you wish to implement.

• Click Save. The new rule will be added to the list.

To remove a rule from the list, click the corresponding Delete button at the right side of
the table. To edit an existing rule, click the application name.

10.3. Mobile Device Policies
Policy settings can be initially configured when creating the policy. Later on, you can change
them as needed anytime you want.

To configure the settings of a policy:

1. Go to the Policies page.

2. Choose Mobiles from the service selector.

3. Click the policy name. This will open the policy settings page.

4. Configure the policy settings as needed. Settings are organized under the following
categories:

• General
– Details

• Device Management
– Security
– Password
– Profiles

You can select the settings category using the menu on the left-side of the page.

5. Click Save to save changes and apply them to the target mobile devices. To leave the
policy page without saving changes, click Cancel.
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10.3.1. General
The General category contains descriptive information regarding the selected policy.

Details

The Details page shows general policy details:

• Policy name

• User who created the policy

• Date and time when the policy was created

• Date and time when the policy was last modified

You can rename the policy by entering the new name in the corresponding field. Policies
should have suggestive names so that you or other administrator can quickly identify them.

Note
By default, only the user who created the policy can modify it. To change that, the policy
owner must check the option Allow other users to change this policy from the policy’s
Details page.

10.3.2. Device Management
Device management settings allow you to define the security options for mobile devices,
the screen locking with password and also several profiles for each mobile device policy.

The settings are organized into the following sections:

• Security
• Password
• Profiles

Security

In this section you can configure various security settings for mobile devices, including
antimalware scans for Android devices, management of rooted or jailbroken devices or the
action to be taken on non-compliant devices.

Important
The antimalware scanning is performed in the cloud, therefore the mobile devices must have
Internet access.
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Mobile Devices Policies - Security settings

Android Security

• Select Scan applications on install if you want to perform a scanning when new
applications are installed on the managed mobile devices.

• Select Scan storage onmount if you want to perform a scanning of each storage device
when it’s mounted.

Warning
If malware is found, the user is prompted to remove it. If the user does not remove
detected malware within one hour after detection, the mobile device is declared
non-compliant and the selected non-compliance action is automatically applied (Ignore,
Deny Access, Lock, Wipe or Unlink).

• Select Require device encryption to prompt the user to activate the encryption feature
available in the Android OS. Encryption protects the data stored on Android devices,
including accounts, settings, downloaded applications, media and other files, from
unauthorized access. Encrypted data can be accessed from external devices only by
providing the unlock password.

Important
Device encryption is available for Android 3.0 or later. Not all device models support
encryption. Check the Mobile Device Details window for encryption support
information.

–

– Encryption might impact device performance.
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– Device encryption is irreversible: the only way to revert to the unencrypted state is
to wipe the device.

Warning
Device encryption is irreversible and the only way to revert to the unencrypted state
is to wipe the device.

–

– Users should back up their data before activating device encryption.

– Users must not interrupt the encryption process or they will lose some or all of their
data.

If you enable this option, GravityZone Mobile Client displays a persistent issue informing
the user to activate encryption. The user must tap the Resolve button to proceed to the
encryption screen and start the process. If encryption is not activated within seven days
after the notification, the device will become non-compliant.

To enable encryption on an Android device:

– The battery must be above 80% charged.

– The device must be plugged-in until encryption is completed.

– The user must set an unlock password meeting the complexity requirements.

Note
• Android devices use the same password for unlocking the screen and for unlocking

encrypted content.

• Encryption requires password, PIN or FACE to unlock the device, disabling the
other screen lock settings.

The encryption process can take an hour or more, during which the device may restart
several times.

You can check the storage encryption status for each mobile device in theMobile Device
Details window.

• Select Web Security to enable web security features on Android devices.

Web Security scans in-the-cloud each accessed URL, then returns a security status to
GravityZoneMobile Client. The URL security status can be: clean, fraud, malware, phishing
or untrusted.

GravityZone Mobile Client can take a specific action based on the URL security status:

– Block phishing web pages. When the user tries to access a phishing website,
GravityZoneMobile Client blocks the corresponding URL, displaying instead a warning
page.
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– Block web pages containing malware or exploits. When the user tries to access
a website spreading malware or web exploits, GravityZone Mobile Client blocks the
corresponding URL, displaying instead a warning page.

– Block web pages used in scams or frauds. Extends protection to other types of
scams besides phishing (for example fake escrows, fake donations, social media
threats and so on). When the user tries to access a fraudulent web page, GravityZone
Mobile Client blocks the corresponding URL, displaying instead a warning page.

– Warn user about untrusted web pages. When the user is accessing a website that
was previously hacked for phishing purposes or recently promoted through spam or
phishing emails, a warning pop-up message will be displayed, without blocking the
web page.

Important
Web Security features work only with Chrome and the built-in Android browser.

OS Changes

Considered a security risk for corporate networks, rooted or jailbroken devices are
automatically declared non-compliant.

• Select Allow management of rooted or jailbroken devices if you want to manage
rooted or jailbroken devices from Control Center. Note that because such devices are
by default non-compliant, they are automatically applied the selected non-compliance
action as soon as they are detected. Therefore, to be able to apply them the policy
security settings or to run tasks on them, you must set the non-compliance action to
Ignore.

• If you clear the Allow management of rooted or jailbroken devices check box, you
automatically unlink rooted or jailbroken devices from the Small Office Security network.
In this case, the GravityZone Mobile Client application prompts a message stating the
device is rooted / jailbroken. The user can tap the OK button, which redirects to the
registration screen. As soon as the device is unrooted / unjailbroken, or the policy is set
to allow the management of rooted / jailbroken devices, it can be re-enrolled (with the
same token for Android devices / with a new token for iOS devices).

Compliance

You can configure specific actions to be taken automatically on devices detected as
non-compliant based on device ownership (enterprise or personal).

Note
When adding a new device in Control Center, you are prompted to specify the device
ownership (enterprise or personal). This will allow Small Office Security to manage personal
and enterprise mobile devices separately.
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• Non-compliance criteria

• Non-compliance actions

Non-compliance criteria

A device is declared non-compliant in the following situations:

• Android devices

– Device is rooted.

– GravityZone Mobile Client is not Device Administrator.

– USB Debugging is enabled.

– Malware is not removed within one hour after detection.

– Policy not satisfied:

• The user does not set the lock screen password within 24 hours after the first
notification.

• The user does not change the lock screen password at the specified time.

• The user does not activate device encryption within seven days after the first
notification.

• iOS devices

– Device is jailbroken.

– GravityZone Mobile Client is uninstalled from the mobile device.

– Policy not satisfied:

• The user does not set the lock screen password within 24 hours after the first
notification.

• The user does not change the lock screen password at the specified time.

Default action when the device is non-compliant

When a device is declared non-compliant, the user is prompted to fix the non-compliance
issue. The user must make the required changes within a specific time period, otherwise
the selected action for non-compliant devices will be applied (Ignore, Deny access, Lock,
Wipe or Unlink).

You can change the action for non-compliant devices in the policy at any time. The new
action is applied to non-compliant devices once the policy is saved.

Select from the menu corresponding to each device ownership type the action to be taken
when a device is declared non-compliant:

• Ignore. Only notifies the user that the device does not comply with the mobile device
usage policy.
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• Deny Access. Blocks the device access to corporate networks by deleting the Wi-Fi
and VPN settings, but keeping all the other settings defined in policy. Blocked settings
are restored as soon as the device becomes compliant.

Important
When Device Administrator is disabled for GravityZone Mobile Client, the corresponding
device becomes non-compliant and is automatically applied the Deny Access.

• Lock. Immediately locks the device screen.

– On Android, the screen is locked with a password generated by GravityZone. If the
user already has a lock screen password, this will be automatically changed.

– On iOS, if the device has a lock screen password, it is asked in order to unlock.

• Wipe. Restores the factory settings of the mobile device, permanently erasing all user
data.

Note
Wipe does not currently erase data from mounted devices (SD cards).

• Unlink. The device is immediately removed from the network.

Warning
If GravityZone Mobile Client is no longer device administrator, the corresponding mobile
device is automatically unlinked from Small Office Security.

Note
To re-enroll a mobile device to which the Unlink action has been applied, you must add
the device again in Control Center. The device must then be re-registered with the new
activation token. Before re-enrolling the device, make sure the conditions that lead to
the device being unlinked are no longer present or change the policy settings so as to
allow the management of the device.

Password

In this section you can choose to activate the lock screen password feature available in the
mobile devices OS.
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Mobile Devices Policies - Password protection settings

Once this feature has been enabled, an on-screen notification prompts the user to define a
lock screen password. The user must enter a password that complies with the password
criteria defined in the policy. Once the password has been set by the user, all notifications
regarding this issue are cleared. A message prompting to enter the password is displayed
at each attempt to unlock the screen.

Note
If the user does not set a password when prompted, the device can be used without a lock
screen password up to 24 hours after the first notification. During this time, a message asking
the user to enter a lock screen password is prompted every 15 minutes on the screen.

Warning
If the user does not set a password within 24 hours after the first notification, the mobile
device becomes non-compliant and the selected action for non-compliant devices will be
applied.

To configure the lock screen password settings:

1. Select the Screen locking with password check box.

2. Click the password security level that best suits your needs (Aggressive, Normal or
Permissive). Use the description on the right side of the scale to guide your choice.

3. Advanced users can configure the lock screen password settings in detail by selecting
the Custom protection level and then clicking the Settings link.
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Mobile Devices Policies - Password protection advanced settings

Note
To view the password configuration requirements of a predefined security level, select that
level and click the Settings link. If you modify any option, the password security level will
automatically change to Custom.

Custom options.

• Type. You can require the password to be Simple or Complex. Password complexity
criteria are defined within the mobile device OS.

– On Android devices, complex passwords must contain at least one letter, one digit
and one special character.

Note
Complex passwords are supported on Android 3.0 or later.

– On iOS devices, complex passwords do not allow sequential or repeated characters
(such as abcdef, 12345 or aaaaa, 11111).

Depending on the selected option, when the user sets the lock screen password, the
operating system checks and prompts the user if the required criteria are not met.

• Require alphanumeric value. Require the password to contain both letters and numbers.

• Minimum length. Require the password to contain a minimum number of characters,
which you specify in the corresponding field.
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• Minimum number of complex characters. Require the password to contain a minimum
number of non-alphanumerical characters (such as @, # or $), which you specify in the
corresponding field.

• Expiration period (months). Force the user to change the lock screen password at a
specified interval (in months). For example, if you enter 3, the user will be prompted to
change the lock screen password every three months.

Note
On Android, this feature is supported in version 3.0 or later.

• History restriction (previous passwords). Select or enter a value in the corresponding
field to specify the number of last passwords that cannot be reused. For example, if you
enter 4, the user cannot reuse a password that matches one of the last four used
passwords.

Note
On Android, this feature is supported in version 3.0 or later.

• Maximum number of failed attempts. Specify how many times the user is allowed to
enter an incorrect password.

Note
On iOS devices, when this number is greater than 6: after six failed attempts, a time
delay is imposed before the user can enter the password again. The time delay increases
with each failed attempt.

Warning
If the user exceeds the maximum number of failed attempts to unlock the screen, the
device will be wiped (all data and settings will be erased).

• Auto-lock after (min). Set the period of inactivity (in minutes) after which the device is
automatically locked.

When you modify the policy, if you choose a higher security level for the lock screen
password, users will be prompted to change the password according to the new criteria.

If you clear the Screen locking with password option, users will regain full access to the
lock screen settings on their mobile device. The existing password remains active until the
user decides to change or remove it.
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Profiles

In this section you can create, modify and delete usage profiles for mobile devices. Usage
profiles help you push Wi-Fi and VPN settings and enforce web access control on managed
mobile devices.

Mobile Devices Policies - Profile Templates

You can configure one or several profiles, but only one can be active at a time on a device.

• If you configure only one profile, that profile is automatically applied to all devices the
policy is assigned to.

• If you configure several profiles, the first in the list is automatically applied to all devices
the policy is assigned to.

Mobile device users can view the assigned profiles and the settings configured for each
profile in the GravityZone Mobile Client application. Users cannot modify existing settings
in a profile, but they can switch between profiles if several are available.

Note
Profile switching requires Internet connectivity.

To create a new profile:

1. Click the Add button at the right side of the table. The profile configuration page is
displayed.

2. Configure the profile settings as needed. For detailed information, refer to:

• “Details” (p. 176)

• “Networks” (p. 176)

• “Web Access” (p. 179)

3. Click Save. The new profile is added to the list.

To delete one or several profiles, select their corresponding check boxes and click the
Delete button at the right side of the table.

To modify a profile, click its name, change settings as needed and click Save.

Security Policies 175

ENTERPRISE BITDEFENDER SMALL OFFICE SECURITY



Details

The Details page contains general information regarding the profile:

• Name. Enter the desired profile name. Profiles should have suggestive names so that
you or other administrator can quickly identify them.

• Description. Enter a detailed profile description. This option may help administrators
easily identify a profile from several others.

Networks

In this section you can specify the settings of one or several Wi-Fi and VPN networks. The
VPN settings are available only for iOS devices.

Mobile Devices Policies - Profile's networks connection settings

Important
Before defining the Wi-Fi and VPN connections, make sure you have all the necessary
information at hand (passwords, proxy settings etc.).

The mobile devices assigned with the corresponding profile will automatically connect to
the defined network, when it is in range. You can set the priority when several networks are
created, taking into account that only one network can be used at a time. When the first
network is not available, the mobile device will connect to the second one, and so on.

To set the networks priority:

1. Select the check box of the desired network.

2. Use the priority buttons at the right side of the table:
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• Click the Up button to promote the selected network.

• Click the Down button to demote it.

• Wi-Fi

You can add as many Wi-Fi networks as you need. To add a Wi-Fi network:

1. In the Wi-Fi section, click the Add button at the right side of the table. A
configuration window is displayed.

2. Under the General tab, you can configure the details of the Wi-Fi connection:

– Name (SSID). Enter the name of the new Wi-Fi network.

– Security. Select the option corresponding to the Wi-Fi network security level:

• None. Choose this option when the Wi-Fi connection is public (no credentials
required).

• WEP. Choose this option to set a Wireless Encryption Protocol (WEP)
connection. Enter the required password for this type of connection in the
corresponding field displayed below.

• WPA/WPA2 Personal. Choose this option if the Wi-Fi network is secured
using Wi-Fi Protected Access (WPA). Enter the required password for this type
of connection in the corresponding field displayed below.

3. Under the TCP/IP you can configure the TCP/IP settings for the Wi-Fi connection.
Each Wi-Fi connection can use IPv4 or IPv6 or both.

– Configure IPv4. If you want to use the IPv4 method, select the IP assignment
method from the corresponding menu:

DHCP: if the IP address is assigned automatically by a DHCP server. If needed,
provide the DHCP Client ID in the subsequent field.

Disabled: select this option if you do not want to use the IPv4 protocol.

– Configure IPv6. If you want to use the IPv6 method, select the IP assignment
method from the corresponding menu:

DHCP: if the IP address is assigned automatically by a DHCP server.

Disabled: select this option if you do not want to use the IPv6 protocol.

– DNS Servers. Enter the address of at least one DNS server for the network.

4. Under the Proxy tab, configure the proxy settings for the Wi-Fi connection. Select
the desired proxy configuration method from the Type menu:

– Off. Choose this option if the Wi-Fi network has no proxy settings.

– Manual. Choose this option to manually specify the proxy settings. Enter the
hostname of the proxy server and the port on which it listens for connections. If
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the proxy server requires authentication, select the Authentication check box
and provide the user name and the password in the subsequent fields.

– Automatic. Choose this option to retrieve the proxy settings from a Proxy
Auto-Configuration (PAC) file published in the local network. Enter the PAC file
address in the URL field.

5. Click Save. The new Wi-Fi connection is added to the list.

• VPN for iOS

You can add as many VPNs as you need. To add a VPN:

1. In the VPN for iOS section, click the Add button at the right side of the table. A
configuration window is displayed.

2. Define the VPN settings in the VPN Connection window:

General:

– Name. Enter the name of the VPN connection.

– Encryption. The available authentication protocol for this connection type is IPSec,
which requires user authentication by password and machine authentication by
shared secret.

– Server. Enter the VPN server address.

– User. Enter the VPN user name.

– Password. Enter the VPN password.

– Group Name. Enter the group name.

– Secret. Enter the pre-shared key.

Proxy:

In this section you can configure the proxy settings for the VPN connection. Select
the desired proxy configuration method from the Type menu:

– Off. Choose this option if the VPN connection has no proxy settings.

– Manual. This option allows you to manually specify the proxy settings:

• Server: enter the proxy host name.

• Port: enter the proxy port number.

• If the proxy server requires authentication, select the Authentication check
box and provide the user name and the password in the subsequent fields.

– Automatic. Select this option to retrieve the proxy settings from a Proxy
Auto-Configuration (PAC) file published in the local network. Enter the PAC file
address in the URL field.

3. Click Save. The new VPN connection will be added to the list.
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To delete one or several networks, select their corresponding check boxes and click the

Delete button at the right side of the table.

To modify a network, click its name, change settings as needed and click Save.

Web Access

In this section you can configure the web access control for Android and iOS devices.

Mobile Devices Policies - Profile's web access settings

• Web Access Control for Android. Enable this option to filter web access for the built-in
Android browser. You can set time restrictions on web access and also explicitly allow
or block access to specific web pages. The web pages blocked by Web Access Control
are not displayed in the browser. Instead, a default web page is displayed informing the
user that the requested web page has been blocked by Web Access Control.

You have three configuration options:

– Select Allow to always grant web access.

– Select Block to always deny web access.

– Select Schedule to enable time restrictions on web access upon a detailed schedule.

Either if you choose to allow or block the web access, you can define exceptions to these
actions for entire web categories or only for specific web addresses. Click Settings to
configure your web access schedule and exceptions as follows:

Scheduler
To restrict Internet access to certain times of day on a weekly basis:

1. Select from the grid the time intervals during which you want Internet access to
be blocked.
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You can click individual cells, or you can click and drag to cover longer periods.
Click again in the cell to reverse the selection.

Mobile Devices Policies - Scheduler for web access

To start a new selection, click Allow All or Block all, depending on the type of
restriction you wish to implement.

2. Click Save.

Web Rules
You can also define web rules to explicitly block or allow certain web addresses,
overriding the existing Web Control settings. Users will be able, for example, to
access a specific webpage also when the web browsing is blocked by Web Control.

To create a web rule:

1. Select Use Exceptions to enable web exceptions.
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Mobile Devices Policies - Web rules for web access

2. Enter the address you want to allow or block in the Web Address field.

3. Select Allow or Block from the Permission menu.

4. Click the Add button at the right side of the table to add the address to the
exceptions list.

5. Click Save.

To edit a web rule:

1. Click the web address you want to edit.

2. Modify the existing URL.

3. Click Save.

To remove a web rule:

1. Move the cursor over the web address you want to remove.

2. Click the Delete button.

3. Click Save.

Use wildcards to define web address patterns:

– Asterisk (*) substitutes for zero or more characters.

– Question mark (?) substitutes for exactly one character. You can use several
question marks to define any combination of a specific number of characters.
For example, ??? substitutes for any combination of exactly three characters.

In the following table, you can find several sample syntaxes for specifying web
addresses.
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ApplicabilitySyntax

Any website or web page starting with www.example
(regardless of the domain extension).

www.example*

The rule will not apply to the subdomains of the specified
website, such as subdomain.example.com.

Any website ending in example.com, including pages and
subdomains thereof.

*example.com

Any website or web page whose address contains the
specified string.

*string*

Any website having the .com domain extension, including
pages and subdomains thereof. Use this syntax to exclude
from scanning the entire top-level domains.

*.com

Any web address starting with www.example?.com, where
? can be replaced with any single character. Such websites
might include: www.example1.com or www.exampleA.com.

www.example?.com

• Web Access Control for iOS. Enable this option to centrally manage the settings of
the built-in iOS browser (Safari). Mobile device users will no longer be able to change
the corresponding settings on their device.

– Allow use of Safari. This option helps you control the use of Safari browser on mobile
devices. Disabling the option removes the Safari shortcut from the iOS interface, thus
preventing users from accessing the Internet via Safari.

– Enable auto-fill. Disable this option if you want to prevent the browser from storing
form entries, which may include sensitive information.

– Force fraud warning. Select this option to ensure that users are warned when
accessing fraudulent web pages.

– Enable Javascript. Disable this option if you want Safari to ignore javascript on
websites.

– Block pop-ups. Select this option to prevent pop-up windows from opening
automatically.

– Accept cookies. Safari allows cookies by default. Disable this option if you want to
prevent websites from storing browsing information.
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11. Monitoring Dashboard
The Control Center dashboard is a customizable visual display providing a quick security
overview of all protected network objects.

Dashboard portlets display various real-time security information using easy-to-read charts,
thus allowing you to quickly identify any issues that might require your attention.

The Dashboard

This is what you need to know about dashboard portlets:

• Control Center comes with several predefined dashboard portlets for each Small Office
Security security service.

• Each dashboard portlet includes a detailed report in the background, accessible with
just one click on the chart.

• There are several types of portlets that include various information about your network
objects protection, such as update status, malware status, firewall activity etc. For more
information on dashboard portlets types, refer to “Available Report Types” (p. 186).

• The information displayed by portlets refers only to the network objects under your
account. You can customize the target of each portlet using the Edit Portlet command.

• Click the chart legend entries, when available, to hide or display the corresponding
variable on the graph.
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• The portlets are displayed in groups of four. Use the slider at the bottom of the page to
navigate between portlet groups.

The dashboard is easy to configure, based on individual preferences. You can edit portlet
settings, add additional portlets, remove or rearrange existing portlets.

11.1. Refreshing Portlet Data
To make sure the portlet displays the latest information, click the Refresh icon on its title
bar.

11.2. Editing Portlet Settings
Some portlets offer status information, while other report on security events in the last period.

You can check and configure the reporting period of a portlet by clicking the Edit Portlet
icon on its title bar.

11.3. Adding a New Portlet
You can add additional portlets to obtain the information you need.

To add a new portlet:

1. Go to the Dashboard page.

2. Click the Add Portlet button at the right side of the dashboard. The configuration
window is displayed.

3. Under the Details tab, configure the portlet details:
• Security service (Computers or Mobile Devices)
• Type of background report
• Suggestive portlet name
• Update interval

For more information on available report types, refer to “Available Report Types” (p. 186).

4. Under the Targets tab, select the network objects and groups to include.

5. Click Save.

11.4. Removing a Portlet
You can easily remove any portlet by clicking the Remove icon on its title bar. Once you
remove a portlet, you can no longer recover it. However, you can create another portlet with
the exact same settings.
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11.5. Rearranging Portlets
You can rearrange dashboard portlets to better suit your needs. To rearrange portlets:

1. Go to the Dashboard page.
2. Click the Rearrange Portlets button at the right side of the dashboard. The portlet

map window is displayed.
3. Drag and drop each portlet to the desired position.
4. Click Save.

Rearrange dashboard portlets
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12. Using Reports
Control Center allows you to create and view centralized reports on the security status of
the managed network objects. The reports can be used for multiple purposes, such as:

• Monitoring and ensuring compliance with the organization's security policies.

• Checking and assessing the network security status.

• Identifying network security issues, threats and vulnerabilities.

• Monitoring security incidents and malware activity.

• Providing upper management with easy-to-interpret data on network security.

Several different report types are available so that you can easily get the information you
need. The information is presented as easy-to-read interactive charts and tables, allowing
you to quickly check the network security status and identify security issues.

Reports can consolidate data from the entire network of managed network objects or from
specific groups only. In this way, from a single report, you can find out:

• Statistical data regarding all or groups of managed network objects.

• Detailed information for each managed network object.

• The list of computers that meet specific criteria (for example, those that have antimalware
protection disabled).

All scheduled reports are available in Control Center but you can save them to your computer
or email them.

Available formats include Portable Document Format (PDF) and comma-separated values
(CSV).

12.1. Available Report Types
Different report types are available for each security service:

• Computer Reports
• Mobile Device Reports

12.1.1. Computer Reports
This is the list of available report types for computers:
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Update Status
Shows you the update status of the Endpoint Security protection installed on selected
computers. The update status refers to product version and engines (signatures) version.

Using the available filters, you can easily find out which clients have updated or have
not updated in a specific time period.

Malware Status
Helps you find out how many and which of the selected computers have been affected
by malware over a specific time period and how the threats have been dealt with.

Computers are grouped based on these criteria:

• Computers with no detections (no malware threat has been detected over the
specified time period)

• Computers with resolved malware (all detected files have been successfully
disinfected or moved to quarantine)

• Computers still infected with malware (some of the detected files have been denied
access to)

Malware Activity
Provides you with overall information about the malware threats detected over a specific
time period on selected computers. You can see:

• Number of detections (files that have been found infected with malware)

• Number of resolved infections (files that have been successfully disinfected or moved
to quarantine)

• Number of unresolved infections (files that could not be disinfected, but to which
access has been denied; for example, an infected file stored in some proprietary
archive format)

Network Status
Provides you with detailed information on the overall security status of selected
computers. Computers are grouped based on these criteria:
• Issues status
• Management status
• Infection status
• Antimalware protection status
• Product update status
• Licensing status
• The network activity status of each computer(online/offline). If the computer is offline

when the report is generated, you will see the date and time when it was last seen
online by Control Center.

Computer Protection Status
Provides you with various status information concerning selected computers from your
network.
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• Antimalware protection status
• Endpoint Security update status
• Network activity status (online/offline)
• Management status

You can apply filters by security aspect and status to find the information you are looking
for.

Top 10 Infected Computers
Shows you the top 10 most infected computers by the number of total detections over
a specific time period out of the selected computers.

Note
The details table displays all malware detected on the top 10 infected computers.

Top 10 Detected Malware
Shows you the top 10 malware threats detected over a specific time period on selected
computers.

Note
The details table displays all computers which were infected by the top 10 detected
malware.

Firewall Activity
Informs you about the status of the Firewall module of Endpoint Security. You can see
the number of blocked traffic attempts and blocked port scans on the selected
computers.

Blocked Websites
Informs you about the status of the Web Control module of Endpoint Security. You can
see the number of blocked websites on the selected computers.

Blocked Applications
Informs you about the status of the Application Control module of Endpoint Security.
You can see the number of blocked applications on the selected computers.

Data Protection
Informs you about the status of the Data Protection module of Endpoint Security. You
can see the number of blocked emails and websites on the selected computers.

Antiphishing Activity
Informs you about the status of the Antiphishing module of the Endpoint Security. You
can see the number of blocked websites on the selected computers.

Blocked Applications By Behavior Scan
Informs you about the applications blocked by AVC (Active Virus Control) / IDS (Intrusion
Detection System). You can view the number of applications blocked by AVC / IDS for
each selected computer. Click the number of blocked applications for the computer
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you are interested in to view the list of blocked application and related information
(application name, the reason for which it has been blocked, the number of blocked
attempts and the date and time of the last blocked attempt).

12.1.2. Mobile Devices Reports

Note
Malware protection and related reports are only available for Android devices.

This is the list of available report types for mobile devices:

Malware Status
Helps you find out howmany and which of the target mobile devices have been affected
by malware over a specific time period and how the threats have been dealt with. Mobile
devices are grouped based on these criteria:

• Mobile devices with no detections (no malware threat has been detected over the
specified time period)

• Mobile devices with resolved malware (all detected files have been removed)

• Mobile devices with existing malware (some of the detected files have not been
deleted)

Malware Activity
Provides you with details about the malware threats detected over a specific time period
on target mobile devices. You can see:

• Number of detections (files that have been found infected with malware)

• Number of resolved infections (files that have been successfully removed from the
device)

• Number of unresolved infections (files that have not been removed from the device)

Top 10 Infected Devices
Shows you the top 10 most infected mobile devices over a specific time period out of
the target mobile devices.

Note
The details table displays all malware detected on the top 10 infected mobile devices.

Top 10 Detected Malware
Shows you the top 10 malware threats detected over a specific time period on the target
mobile devices.

Note
The details table displays all mobile devices which were infected by the top 10 detected
malware.
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Device Compliance
Informs you of the compliance status of the target mobile devices. You can see the
device name, status, operating system and the non-compliance reason.

Formore information regarding compliance requirements, please check “Non-compliance
criteria” (p. 170).

Device Synchronization
Informs you of the synchronization status of the target mobile devices. You can view
the device name, the user it is assigned to, as well as the synchronization status, the
operating system and the time when the device was last seen online.

For more information, refer to “Managed and Unmanaged Mobile Devices” (p. 92).

Blocked Websites
Informs you about the number of attempts of the target devices to access websites
which are blocked by Web Access rules, over a certain time interval.

For each device with detections, click the number provided in the Blocked Websites
column to view detailed information of each blocked web page, such as:

• Website URL

• Policy component that performed the action

• Number of blocked attempts

• Last time when the website was blocked

For more information about the web access policy settings, refer to “Profiles” (p. 175).

Web Security Activity
Informs you about the number of attempts of the target mobile devices to access
websites with security threats (phishing, fraud, malware or untrusted websites), over a
certain time interval. For each device with detections, click the number provided in the
BlockedWebsites column to view detailed information of each blocked web page, such
as:

• Website URL

• Type of threat (phishing, malware, fraud, untrusted)

• Number of blocked attempts

• Last time when the website was blocked

Web Security is the policy component which detects and blocks websites with security
issues. For more information about the web security policy settings, refer to “Security”
(p. 166).

12.2. Creating Reports
You can create two categories of reports:
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• Instant reports. Instant reports are automatically displayed after you generate them.
• Scheduled reports. Scheduled reports can be configured to run at a specified time and

date and a list of all the scheduled reports is displayed in the Reports page.

Important
Instant reports are automatically deleted when you close the report page. Scheduled reports
are saved and displayed in the Reports page.

To create a report:

1. Go to the Reports page.

2. Choose the desired network objects type from the service selector.

3. Click the Add button at the right side of the table.
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Computer Reports Options

4. Select the desired report type from the menu.

5. Enter a suggestive name for the report. When choosing a name, consider the report type
and target, and possibly the report options.

6. Configure the report target by clicking theChange target link. Select the group you want
to run the report on.

7. Configure report recurrence (schedule). You can choose to create the report immediately
(instant report), or schedule it to run daily, weekly (on a specific day of the week) or
monthly (on a specific day of the month).
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Note
Scheduled reports are generated on the due date immediately after 00:00 UTC (default
timezone of the GravityZone appliance).

8. Configure the report options.
a. For most report types you must specify the update interval. The report will only include

data from the selected time period.
b. Several report types provide filtering options to help you easily find the information

you are interested in. Use the filtering options to obtain only the desired information.

For example, for an Update Status report you can choose to view only the list of
computers that have updated (or, on the contrary, that have not updated) in the
selected time period or the ones that need to be restarted to complete the update.

c. To receive a scheduled report by email, select the corresponding option.

9. Click Generate to create an instant report or Save to create a scheduled report. The
Save button will change to Generate if you choose to create an instant report.

• If you have chosen to create an instant report, it will be displayed immediately after
clicking Generate. The time required for reports to be created may vary depending
on the number of managed computers. Please wait for the requested report to be
created.

• If you have chosen to create a scheduled report, it will be displayed in the list on the
Reports page. Once the report has been created, you can view the report by clicking
its corresponding link in the View report column on the Reports page.

12.3. Viewing and Managing Scheduled Reports
To view and manage scheduled reports, go to the Reports page.

The Reports page
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All scheduled reports are displayed in a table. You can see the generated scheduled reports
and useful information about them:

• Report name and type.

• When the report will be generated.

Note
Scheduled reports are available only for the user who has created them.

To sort reports by a specific column, simply click the header of that column. Click the column
header again to change the sorting order.

The report details are displayed in a table that consists of several columns providing various
information. The table can span several pages (only 10 entries are displayed per page by
default). To browse through the details pages, use the buttons at the bottom of the table.

To easily find what you are looking for, use the search boxes or the filtering options below
the column headers.

To sort report details by a specific column, simply click the header of that column. Click the
column header again to change the sorting order.

To clear a search box, place the cursor over it and click the Delete icon.

To make sure the latest information is being displayed, click the Refresh icon in the
bottom-left corner of the table.

12.3.1. Viewing Reports
To view a report:

1. Go to the Reports page.

2. Sort reports by name, type or recurrence to easily find the report you are looking for.

3. Click the corresponding link in the View report column to display the report.

All reports consist of a summary section (the upper half of the report page) and a details
section (the lower half of the report page).

• The summary section provides you with statistical data (pie charts and graphics) for all
target network objects or groups as well as general information about the report, such
as the reporting period (if applicable), report target etc.

• The details section provides you with detailed information for each managed network
object.

Note
To configure the information displayed by the chart, click the legend entries to show or
hide the selected data.

•
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• Click the graphic area you are interested in to view related details in the table placed
below the chart.

12.3.2. Editing Scheduled Reports

Note
When editing a scheduled report, any updates will be applied starting with the report's next
recurrence. Previously generated reports will not be impacted by the editing.

To change the settings of a scheduled report:

1. Go to the Reports page.

2. Click the report name.

3. Change report settings as needed. You can change the following:

• Report name. Choose a suggestive name for the report to help easily identify what
it is about. When choosing a name, consider the report type and target, and possibly
the report options. Reports generated by a scheduled report are named after it.

• Report target. The selected option indicates the type of the current report target
(either groups or individual network objects). Click the corresponding link to view the
current report target. To change it, select the groups or network objects to be included
in the report.

• Report recurrence (schedule). You can set the report to be automatically generated
daily, weekly (on a specific day of the week) or monthly (on a specific day of the
month). Depending on the selected schedule, the report will only include data from
the last day, week or month, respectively.

• Report options. The report will only include data from the selected update interval.
You can change the interval starting with the next recurrence. You can choose to
receive the report by email. Most reports provide filtering options to help you easily
find the information you are interested in. When you view the report in the console,
all information will be available, regardless of the selected options. If you download
or email the report however, only the report summary and the selected information
will be included in the PDF file. Report details will only be available in CSV format.

4. Click Save to save changes.

12.3.3. Deleting Scheduled Reports
When a scheduled report is no longer needed, it is best to delete it. Deleting a scheduled
report will delete all the reports it has generated automatically to that point.

To delete a scheduled report:

1. Go to the Reports page.
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2. Select the report you want to delete.

3. Click the Delete button at the right side of the table.

12.4. Saving Reports
By default, scheduled reports are automatically saved in Control Center.

If you need reports to be available for longer time periods, you can save them to your
computer. The report summary will be available in PDF format, whereas report details will
be available just in CSV format.

You have two ways of saving reports:

• Export
• Download

12.4.1. Exporting Reports
To export the report to your computer:

1. Click the Export button in the upper-right corner of the report page.

Reports - Export option

2. Select the desired format of the report:

• Portable Document Format (PDF) or

• Comma Separated Values (CSV)

3. Depending on your browser settings, the file may be downloaded automatically to a
default download location, or a download window will appear, where you must specify
the destination folder.
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12.4.2. Downloading Reports
A report archive contains both the report summary and the report details.

To download a report archive:

1. Go to the Reports page.

2. Select the report you want to save.

3. Click the Download button and select either Last Instance to download the last
generated instance of the report or Full Archive to download an archive containing all
the instances.

Depending on your browser settings, the file may be downloaded automatically to a
default download location, or a download window will appear, where you must specify
the destination folder.

12.5. Emailing Reports
You can send reports by email using the following options:

1. To email the report you are viewing, click the Email button in the upper-right corner of
the report page. The report will be sent to the email address associated with your account.

2. To configure the desired scheduled reports delivery by email:

a. Go to the Reports page.

b. Click the desired report name.

c. Under Options > Delivery, select Send by email at.

d. Provide the desired email address in the field below. You can add as many email
addresses as you want.

e. Click Save.

Note
Only the report summary and the chart will be included in the PDF file sent by email.
Report details will be available in the CSV file.

12.6. Printing Reports
Control Center does not currently support print button functionality. To print a report, you
must first save it to your computer.
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13. Quarantine
By default, Small Office Security security services isolates suspicious files and the
malware-infected files that cannot be disinfected in a secure area named quarantine. When
a virus is in quarantine it cannot do any harm because it cannot be executed or read.

By default, Endpoint Security isolates suspicious files and the malware-infected files that
cannot be disinfected in a secure area named quarantine. When a virus is in quarantine it
cannot do any harm because it cannot be executed or read.

Security for Endpoints stores the quarantined files on each managed computer. Using
Control Center you have the option to either delete or restore specific quarantined files.

By default, quarantined files are automatically sent to Bitdefender Labs in order to be analyzed
by the Bitdefender malware researchers. If malware presence is confirmed, a signature is
released to allow removing the malware.

In addition, quarantined files are scanned after each malware signature update. Cleaned
files are automatically moved back to their original location.

Control Center provides detailed information on all files moved to quarantine on the network
objects managed from your account.

To check and manage quarantined files, go to the Quarantine page and choose the desired
network object from the service selector.

The Quarantine page

Information about quarantined files is displayed in a table. You are provided with the following
information:

• The name of network object the threat was detected on.

• The IP of network object the threat was detected on.
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• Path to the infected or suspicious file on the network object it was detected on.

• Name given to the malware threat by the Bitdefender security researchers.

• Time when the file was quarantined.

• Pending action requested by administrator to be taken on the quarantined file.

To make sure the latest information is being displayed, click the Refresh button in the
bottom-left corner of the table. This may be needed when you spendmore time on the page.

13.1. Navigation and Search
Depending on the number of managed network objects and the nature of infections, the
number of quarantined files can be sometimes large. The table can span several pages (only
10 entries are displayed per page by default).

To move through the pages, use the navigation buttons at the bottom of the table. To change
the number of entries displayed on a page, select an option from the menu next to the
navigation buttons.

If there are too many entries, you can use the search boxes under the column headers to
filter displayed data. For example, you can search for a specific threat detected in the network
or for a specific network object. You can also click column headers to sort data by a specific
column.

13.2. Restoring Quarantined Files
On particular occasions, you may need to restore quarantined files, either to their original
location or to an alternate location. One such situation is when you want to recover important
files stored in an infected archive that has been quarantined.

To restore one or more quarantined files:

1. Go to the Quarantine page.

2. Choose Computers from the service selector.

Note
Restoring quarantined files is only possible in environments protected by Security for
Endpoints.

3. Select the check boxes corresponding to the quarantined files you want to restore.

4. Click the Restore button at the right side of the table.

5. Choose the location where you want the selected files to be restored (either the original
or a custom location on the target computer).
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If you choose to restore to a custom location, youmust enter the path in the corresponding
field. It is advisable to use system variables (where appropriate) to make sure the path
is valid on all target computers. For more information, refer to “Using System Variables”
(p. 214).

6. Click Save to request the file restore action. You can notice the pending action in the
Action column.

7. The requested action is sent to the target computers immediately or as soon as they get
back online. Once a file is restored, the corresponding entry will disappear from the
Quarantine table.

13.3. Automatic Deletion of Quarantined Files
By default, quarantined files older than 30 days are automatically deleted. This setting can
be changed by editing the policy assigned to the managed network objects.

To change the automatic deletion interval for quarantined files:

1. Go to the Policies page.

2. Find the policy assigned to the network objects on which you want to change the setting
and click its name.

3. Go to the Antimalware > Quarantine section.

4. Select the desired automatic deletion period from the menu.

5. Click Save to save changes.

13.4. Deleting Quarantined Files
If you want to delete quarantined files manually, you should first make sure the files you
choose to delete are not needed. Use these tips when deleting quarantined files:

• A file may actually be the malware itself. If your research leads you to such a situation,
you can search the quarantine for the specific threat and delete it from quarantine.

• You can safely delete:

– Unimportant archive files.

– Infected setup files.

To delete one or more quarantined files:

1. Go to the Quarantine page.

2. Choose the desired network object from the service selector.

3. Check the list of quarantined files and select the check boxes corresponding to the ones
you want to delete.
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4. Click the Delete button at the right side of the table. You can notice the pending status
in the Action column.

5. The requested action is sent to the target network objects immediately or as soon as
they get back online. Once a file is deleted, the corresponding entry will disappear from
the Quarantine table.
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14. User Activity Log
Control Center logs all the operations and actions performed by users. Logs list include the
following events, according to your administrative permission level:

• Logging in and logging out
• Creating, editing, renaming and deleting reports
• Adding and removing dashboard portlets
• Creating, editing, and deleting credentials
• Creating, modifying, downloading and deleting network packages
• Creating network tasks
• Creating, editing, renaming and deleting user accounts
• Deleting or moving computers between groups
• Creating, moving, renaming and deleting groups
• Deleting and restoring quarantined files
• Creating, editing and deleting user accounts
• Creating, editing, renaming, assigning and deleting policies
• Updating Small Office Security appliance.

To examine the user activity records, go to the Logs page and choose the desired network
object from the service selector.

The Logs Page

To display recorded events that you are interested in, you have to define a search. Fill in the
available fields with the search criteria and click the Search button. All the records matching
your criteria will be displayed in the table.

The table columns provide you with useful information about the listed events:

• The username of who performed the action.

• User role.
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• Action that caused the event.

• Type of console object affected by the action.

• Specific console object affected by the action.

• Time when the event occurred.

To sort events by a specific column, simply click the header of that column. Click the column
header again to reverse the sorting order.

To view detailed information about an event, select it and check the section under the table.

To make sure the latest information is being displayed, click the Refresh button in the
bottom-left corner of the table.
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15. Notifications
Depending on the events that might occur throughout your network, Control Center will
show various notifications to inform you of the security status of your environment. The
notifications will be displayed in the Notification Area, located in the upper right side of the
Control Center interface.

Notification Area

When a new event is detected in the network, the notification area will display a red icon
indicating the number of newly detected events. Clicking the icon displays the list of detected
events.

15.1. Notification Types
This is the list of available notifications types:

Malware Outbreak
This notification is sent to the users that have at least 5% of all their managed network
objects infected by the same malware.

Update Available
Informs you of the availability of a new Small Office Security update.

License Expires
This notification is sent 30 and 7 days before the license expires, as well as the day the
license expires.

License Limit Is About To Be Reached
This notification is sent when 90% of the available licenses have been used.
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License Usage Limit Has Been Reached
This notification is sent when all of the available licenses have been used.

15.2. Viewing Notifications
To view the notifications, click the Notification Area button and then click See All
Notifications. A table containing all the notifications is displayed.

The Notifications page

Depending on the number of notifications, the notifications table can span several pages
(only 10 entries are displayed per page by default).

To move through the pages, use the navigation buttons at the bottom of the table.

To change the number of entries displayed on a page, select an option from the menu next
to the navigation buttons.

If there are too many entries, you can use the search boxes under the column headers or
the filter menu at the top of the table to filter displayed data. For example, you can search
for a specific type of notification or choose to view only the notifications generated in a
specific time interval.

• To filter notifications, select the notification type you want to see from the Type menu.
Optionally, you can select the time interval during which the notification was generated,
to reduce the number of entries in the table, especially if a high number of notifications
has been generated.

• To view the notification details, click the notification name in the table. A Details section
is displayed below the table, where you can see the event that generated the notification.

15.3. Deleting Notifications
To delete notifications:
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1. Click the Notification Area button at the right side of the menu bar and then click
See All Notifications. A table containing all the notifications is displayed.

2. Select the notifications you want to delete.

3. Click the Delete button at the right side of the table.

15.4. Configuring Notification Settings
The type of notifications to be sent and the email addresses they are sent to can be configured
for each user.

To configure the notification settings:

1. Click the Notification Area button at the right side of the menu bar and then click
See All Notifications. A table containing all the notifications is displayed.

2. Click the Configure button at the right side of the table. The Notification Settings
window is displayed.

Notifications Settings

Note
You may also access the Notification Settings window directly using the Configure
icon from upper-right corner of the Notification area window.

3. Select the desired notification types from the list. For more information, refer to
“Notification Types” (p. 204)
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4. Optionally, you can choose to send the notifications by email to specific email addresses.
Type the email addresses in the dedicated field, pressing Enter after each address.

5. Click Save.
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16. Getting Help
Bitdefender strives to provide its customers with an unparalleled level of fast and accurate
support. If you experience any issue with or if you have any question about your Bitdefender
product, go to our online Support Center. It provides several resources that you can use to
quickly find a solution or an answer. Or, if you prefer, you can contact the Bitdefender
Customer Care team. Our support representatives will answer your questions in a timely
manner and they will provide you with the assistance you need.

Note
You can find out information about the support services we provide and our support policy
at the Support Center.

16.1. Bitdefender Support Center
Bitdefender Support Center, available at http://www.bitdefender.com/support/business.html,
is the place where you will find all the assistance you need with your Bitdefender product.

You can use several resources to quickly find a solution or an answer:

• Knowledge Base Articles

• Bitdefender Support Forum

• Product Documentation

You can also use your favorite search engine to find out more information about computer
security, the Bitdefender products and the company.

Knowledge Base Articles
The Bitdefender Knowledge Base is an online repository of information about the Bitdefender
products. It stores, in an easily accessible format, reports on the results of the ongoing
technical support and bugfixing activities of the Bitdefender support and development teams,
along with more general articles about virus prevention, the management of Bitdefender
solutions with detailed explanations, and many other articles.

The Bitdefender Knowledge Base is open to the public and freely searchable. The extensive
information it contains is yet another means of providing Bitdefender customers with the
technical knowledge and insight they need. All valid requests for information or bug reports
coming from Bitdefender clients eventually find their way into the Bitdefender Knowledge
Base, as bugfix reports, workaround cheatsheets or informational articles to supplement
product helpfiles.
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The Bitdefender Knowledge Base for business products is available any time at
http://www.bitdefender.com/support/business.html.

Bitdefender Support Forum
The Bitdefender Support Forum provides Bitdefender users with an easy way to get help
and to help others. You can post any problem or question related to your Bitdefender product.

Bitdefender support technicians monitor the forum for new posts in order to assist you. You
may also get an answer or a solution from a more experienced Bitdefender user.

Before posting your problem or question, please search the forum for a similar or related
topic.

The Bitdefender Support Forum is available at http://forum.bitdefender.com, in 5 different
languages: English, German, French, Spanish and Romanian. Click theBusiness Protection
link to access the section dedicated to business products.

Product Documentation
Product documentation is the most complete source of information about your product.

You can check and download the latest version of documentation for Bitdefender business
products at Support Center > Documentation.

16.2. Asking for Assistance
You can contact us for assistance through our online Support Center:

1. Go to http://www.bitdefender.com/support/contact-us.html.

2. Use the contact form to open an email support ticket or access other available contact
options.

16.3. Using Support Tool
The Small Office Security Support Tool is designed to help users and support technicians
easily obtain the information needed for troubleshooting. Run the Support Tool on affected
computers and send the resulting archive with the troubleshooting information to the
Bitdefender support representative.

To use the Support Tool:

1. Download the Support Tool and distribute it to the affected computers. To download the
Support Tool:

a. Connect to Control Center using your account.

b. Click the Help and Support link in the lower-right corner of the console.
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c. The download links are available in the Support section. Two versions are available:
one for 32-bit systems and the other for 64-bit systems. Make sure to use the correct
version when running the Support Tool on a computer.

2. Run the Support Tool locally on each of the affected computers.

a. Select the agreement check box and click Next.

b. Complete the submission form with the necessary data:

i. Enter your email address.

ii. Enter your name.

iii. Choose your country from the corresponding menu.

iv. Enter a description of the issue you encountered.

v. Optionally, you can try to reproduce the issue before starting to collect data. In
this case, proceed as follows:

A. Enable the option Try to reproduce the issue before submitting.

B. Click Next.

C. Select the type of issue you have experienced.

D. Click Next.

E. Reproduce the issue on your computer. When done, return to Support Tool
and select the option I have reproduced the issue.

c. ClickNext. The Support Tool gathers product information, information related to other
applications installed on the machine and the software and hardware configuration.

d. Wait for the process to complete.

e. Click Finish to close the window. A zip archive has been created on your desktop.

Send the zip archive together with your request to the Bitdefender support
representative using the email support ticket form available in the Help and Support
page of the console.

16.4. Contact Information
Efficient communication is the key to a successful business. During the past 10 years
Bitdefender has established an unquestionable reputation by constantly striving for better
communication so as to exceed the expectations of our clients and partners. Should you
have any questions, do not hesitate to contact us.

16.4.1. Web Addresses
Sales Department: enterprisesales@bitdefender.com

Getting Help 210

ENTERPRISE BITDEFENDER SMALL OFFICE SECURITY

mailto:enterprisesales@bitdefender.com


Support Center: http://www.bitdefender.com/support/business.html
Documentation: documentation@bitdefender.com
Local Distributors: http://www.bitdefender.com/partners
Partner Program: partners@bitdefender.com
Media Relations: pr@bitdefender.com
Virus Submissions: virus_submission@bitdefender.com
Spam Submissions: spam_submission@bitdefender.com
Report Abuse: abuse@bitdefender.com
Web site: http://www.bitdefender.com

16.4.2. Local Distributors
The Bitdefender local distributors are ready to respond to any inquiries regarding their areas
of operation, both in commercial and in general matters.

To find a Bitdefender distributor in your country:

1. Go to http://www.bitdefender.com/partners.

2. Go to Partner Locator.

3. The contact information of the Bitdefender local distributors should be displayed
automatically. If this does not happen, select the country you reside in to view the
information.

4. If you do not find a Bitdefender distributor in your country, feel free to contact us by email
at enterprisesales@bitdefender.com. Please write your email in English in order for us to
be able to assist you promptly.

16.4.3. Bitdefender Offices
The Bitdefender offices are ready to respond to any inquiries regarding their areas of
operation, both in commercial and in general matters. Their respective addresses and
contacts are listed below.

United States

Bitdefender, LLC
PO Box 667588
Pompano Beach, Fl 33066
United States
Phone (sales&technical support): 1-954-776-6262
Sales: sales@bitdefender.com
Web: http://www.bitdefender.com
Support Center: http://www.bitdefender.com/support/business.html
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France

PROFIL TECHNOLOGY
49, Rue de la Vanne
92120 Montrouge
Fax: +33 (0)1 47 35 07 09
Phone: +33 (0)1 47 35 72 73
Email: supportpro@profiltechnology.com
Website: http://www.bitdefender.fr
Support Center: http://www.bitdefender.fr/support/professionnel.html

Spain

Bitdefender España, S.L.U.
Avda. Diagonal, 357, 1º 1ª
08037 Barcelona
España
Fax: (+34) 93 217 91 28
Phone (office&sales): (+34) 93 218 96 15
Phone (technical support): (+34) 93 502 69 10
Sales: comercial@bitdefender.es
Website: http://www.bitdefender.es
Support Center: http://www.bitdefender.es/support/business.html

Germany

Bitdefender GmbH
Airport Office Center
Robert-Bosch-Straße 2
59439 Holzwickede
Deutschland
Phone (office&sales): +49 (0)2301 91 84 222
Phone (technical support): +49 (0)2301 91 84 444
Sales: vertrieb@bitdefender.de
Website: http://www.bitdefender.de
Support Center: http://www.bitdefender.de/support/business.html

UK and Ireland

Genesis Centre Innovation Way
Stoke-on-Trent, Staffordshire
ST6 4BF
UK
Phone (sales&technical support): +44 (0) 8451-305096
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Email: info@bitdefender.co.uk
Sales: sales@bitdefender.co.uk
Website: http://www.bitdefender.co.uk
Support Center: http://www.bitdefender.co.uk/support/business.html

Romania

BITDEFENDER SRL
DV24 Offices, Building A
24 Delea Veche Street
024102 Bucharest, Sector 2
Fax: +40 21 2641799
Phone (sales&technical support): +40 21 2063470
Sales: sales@bitdefender.ro
Website: http://www.bitdefender.ro
Support Center: http://www.bitdefender.ro/support/business.html

United Arab Emirates

Bitdefender FZ-LLC
Dubai Internet City, Building 17
Office # 160
Dubai, UAE
Phone (sales&technical support): 00971-4-4588935 / 00971-4-4589186
Fax: 00971-4-44565047
Sales: sales@bitdefender.com
Web: http://www.bitdefender.com/world
Support Center: http://www.bitdefender.com/support/business.html
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A. Appendices

A.1. List of Application File Types
The antimalware scanning engines included in the Bitdefender security solutions can be
configured to limit scanning to application (or program) files only. Application files are far
more vulnerable to malware attacks than other types of files.

This category includes files with the following extensions:

386; a6p; ac; accda; accdb; accdc; accde; accdp; accdr; accdt; accdu;
acl; acr; action; ade; adp; air; app; as; asd; asp; awk; bas; bat;
bin; cgi; chm; cla; class; cmd; cnv; com; cpl; csc; csh; dat; dek;
dld; dll; doc; docm; docx; dot; dotm; dotx; drv; ds; ebm; esh; exe;
ezs; fky; frs; fxp; gadget; grv; hlp; hms; hta; htm; html; iaf; icd;
ini; inx; ipf; isu; jar; js; jse; jsx; kix; laccdb; lnk; maf; mam;
maq; mar; mat; mcr; mda; mdb; mde; mdt; mdw; mem; mhtml; mpp; mpt;
mpx; ms; msg; msi; msp; mst; msu; oab; obi; obs; ocx; oft; ole; one;
onepkg; ost; ovl; pa; paf; pex; pfd; php; pif; pip; pot; potm; potx;
ppa; ppam; pps; ppsm; ppsx; ppt; pptm; pptx; prc; prf; prg; pst; pub;
puz; pvd; pwc; py; pyc; pyo; qpx; rbx; rgs; rox; rpj; rtf; scar; scr;
script; sct; shb; shs; sldm; sldx; smm; snp; spr; svd; sys; thmx;
tlb; tms; u3p; udf; url; vb; vbe; vbs; vbscript; vxd; wbk; wcm; wdm;
wiz; wll; wpk; ws; wsf; xar; xl; xla; xlam; xlb; xlc; xll; xlm; xls;
xlsb; xlsm; xlsx; xlt; xltm; xltx; xlw; xml; xqt; xsf; xsn; xtp

A.2. Using System Variables
Some of the settings available in the console require specifying the path on the target
computers. It is advisable to use system variables (where appropriate) to make sure the path
is valid on all target computers.

Here is the list of the predefined system variables:

%ALLUSERSPROFILE%
The All Users profile folder. Typical path:

C:\Documents and Settings\All Users

%APPDATA%
The Application Data folder of the logged-in user. Typical path:

• Windows XP:
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C:\Documents and Settings\{username}\Application Data

• Windows Vista/7:

C:\Users\{username}\AppData\Roaming

%HOMEPATH%
The user folders. Typical path:

• Windows XP:

\Documents and Settings\{username}

• Windows Vista/7:

\Users\{username}

%LOCALAPPDATA%
The temporary files of Applications. Typical path:

C:\Users\{username}\AppData\Local

%PROGRAMFILES%
The Program Files folder. A typical path is C:\Program Files.

%PROGRAMFILES(X86)%
The Program Files folder for 32-bit applications (on 64-bit systems). Typical path:

C:\Program Files (x86)

%COMMONPROGRAMFILES%
The Common Files folder. Typical path:

C:\Program Files\Common Files

%COMMONPROGRAMFILES(X86)%
The Common Files folder for 32-bit applications (on 64-bit systems). Typical path:

C:\Program Files (x86)\Common Files

%WINDIR%
The Windows directory or SYSROOT. A typical path is C:\Windows.
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Glossary
Adware

Adware is often combined with a host application that is provided at no charge as long
as the user agrees to accept the adware. Because adware applications are usually
installed after the user has agreed to a licensing agreement that states the purpose of
the application, no offense is committed.

However, pop-up advertisements can become an annoyance, and in some cases
degrade system performance. Also, the information that some of these applications
collect may cause privacy concerns for users who were not fully aware of the terms in
the license agreement.

Antivirus storm
An intensive use of system resources that occurs when antivirus software simultaneously
scans multiple virtual machines on a single physical host.

Archive
A disk, tape, or directory that contains files that have been backed up.

A file that contains one or more files in a compressed format.

Backdoor
A hole in the security of a system deliberately left in place by designers or maintainers.
The motivation for such holes is not always sinister; some operating systems, for
example, come out of the box with privileged accounts intended for use by field service
technicians or the vendor's maintenance programmers.

Boot sector
A sector at the beginning of each disk that identifies the disk's architecture (sector size,
cluster size, and so on). For startup disks, the boot sector also contains a program that
loads the operating system.

Boot virus
A virus that infects the boot sector of a fixed or floppy disk. An attempt to boot from a
diskette infected with a boot sector virus will cause the virus to become active in memory.
Every time you boot your system from that point on, you will have the virus active in
memory.

Browser
Short for Web browser, a software application used to locate and display Web pages.
The twomost popular browsers are Netscape Navigator andMicrosoft Internet Explorer.
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Both of these are graphical browsers, which means that they can display graphics as
well as text. In addition, most modern browsers can present multimedia information,
including sound and video, though they require plug-ins for some formats.

Command line
In a command line interface, the user types commands in the space provided directly
on the screen using command language.

Cookie
Within the Internet industry, cookies are described as small files containing information
about individual computers that can be analyzed and used by advertisers to track your
online interests and tastes. In this realm, cookie technology is still being developed and
the intention is to target ads directly to what you've said your interests are. It's a
double-edge sword for many people because on one hand, it's efficient and pertinent
as you only see ads about what you're interested in. On the other hand, it involves
actually "tracking" and "following" where you go and what you click. Understandably
so, there is a debate over privacy and many people feel offended by the notion that
they are viewed as a "SKU number" (you know, the bar code on the back of packages
that gets scanned at the grocery check-out line). While this viewpoint may be extreme,
in some cases it is accurate.

Events
An action or occurrence detected by a program. Events can be user actions, such as
clicking a mouse button or pressing a key, or system occurrences, such as running out
of memory.

False positive
Occurs when a scanner identifies a file as infected when in fact it is not.

Filename extension
The portion of a filename, following the final point, which indicates the kind of data
stored in the file.

Many operating systems use filename extensions, e.g. Unix, VMS, and MS-DOS. They
are usually from one to three letters (some sad old OSes support no more than three).
Examples include "c" for C source code, "ps" for PostScript, "txt" for arbitrary text.

Heuristic
A rule-based method of identifying new viruses. This method of scanning does not rely
on specific virus signatures. The advantage of the heuristic scan is that it is not fooled
by a new variant of an existing virus. However, it might occasionally report suspicious
code in normal programs, generating the so-called "false positive".
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IP
Internet Protocol - A routable protocol in the TCP/IP protocol suite that is responsible
for IP addressing, routing, and the fragmentation and reassembly of IP packets.

Keylogger
A keylogger is an application that logs anything you type.

Keyloggers are not malicious in nature. They can be used for legitimate purposes, such
as monitoring employees or children activity. However, they are increasingly being used
by cyber-criminals for malicious purposes (for example, to collect private data, such as
login credentials and social security numbers).

Macro virus
A type of computer virus that is encoded as a macro embedded in a document. Many
applications, such as Microsoft Word and Excel, support powerful macro languages.

These applications allow you to embed a macro in a document, and have the macro
execute each time the document is opened.

Malware
Malware is the generic term for software that is designed to do harm - a contraction of
'malicious software'. It is not yet in universal usage, but its popularity as a general term
for viruses, Trojan Horses, worms, and malicious mobile code is growing.

Malware signature
Malware signatures are snippets of code extracted from actual malware samples. They
are used by antivirus programs to perform pattern-matching and detect malware.
Signatures are also used to remove the malware code from infected files.
The Bitdefender Malware Signature Database is a collection of malware signatures
updated hourly by the Bitdefender malware researchers.

Non-heuristic
This method of scanning relies on specific virus signatures. The advantage of the
non-heuristic scan is that it is not fooled by what might seem to be a virus, and does
not generate false alarms.

Phishing
The act of sending an email to a user falsely claiming to be an established legitimate
enterprise in an attempt to scam the user into surrendering private information that will
be used for identity theft. The email directs the user to visit a Web site where they are
asked to update personal information, such as passwords and credit card, social security,
and bank account numbers, that the legitimate organization already has. The Web site,
however, is bogus and set up only to steal the user’s information.
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Polymorphic virus
A virus that changes its form with each file it infects. Since they have no consistent
binary pattern, such viruses are hard to identify.

Port
An interface on a computer to which you can connect a device. Personal computers
have various types of ports. Internally, there are several ports for connecting disk drives,
display screens, and keyboards. Externally, personal computers have ports for
connecting modems, printers, mice, and other peripheral devices.

In TCP/IP and UDP networks, an endpoint to a logical connection. The port number
identifies what type of port it is. For example, port 80 is used for HTTP traffic.

Report file
A file that lists actions that have occurred. Bitdefender maintains a report file listing the
path scanned, the folders, the number of archives and files scanned, howmany infected
and suspicious files were found.

Rootkit
A rootkit is a set of software tools which offer administrator-level access to a system.
The term was first used for the UNIX operating systems and it referred to recompiled
tools which provided intruders administrative rights, allowing them to conceal their
presence so as not to be seen by the system administrators.

The main role of rootkits is to hide processes, files, logins and logs. They may also
intercept data from terminals, network connections or peripherals, if they incorporate
the appropriate software.

Rootkits are not malicious in nature. For example, systems and even some applications
hide critical files using rootkits. However, they are mostly used to hide malware or to
conceal the presence of an intruder into the system. When combined with malware,
rootkits pose a great threat to the integrity and the security of a system. They canmonitor
traffic, create backdoors into the system, alter files and logs and avoid detection.

Script
Another term for macro or batch file, a script is a list of commands that can be executed
without user interaction.

Spam
Electronic junk mail or junk newsgroup postings. Generally known as any unsolicited
email.

Spyware
Any software that covertly gathers user information through the user's Internet connection
without his or her knowledge, usually for advertising purposes. Spyware applications
are typically bundled as a hidden component of freeware or shareware programs that
can be downloaded from the Internet; however, it should be noted that the majority of
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shareware and freeware applications do not come with spyware. Once installed, the
spyware monitors user activity on the Internet and transmits that information in the
background to someone else. Spyware can also gather information about email
addresses and even passwords and credit card numbers.

Spyware's similarity to a Trojan horse is the fact that users unwittingly install the product
when they install something else. A common way to become a victim of spyware is to
download certain peer-to-peer file swapping products that are available today.

Aside from the questions of ethics and privacy, spyware steals from the user by using
the computer's memory resources and also by eating bandwidth as it sends information
back to the spyware's home base via the user's Internet connection. Because spyware
is using memory and system resources, the applications running in the background can
lead to system crashes or general system instability.

System tray
Introduced with Windows 95, the system tray is located in theWindows taskbar (usually
at the bottom next to the clock) and contains miniature icons for easy access to system
functions such as fax, printer, modem, volume, and more. Double click or right-click an
icon to view and access the details and controls.

TCP/IP
Transmission Control Protocol/Internet Protocol - A set of networking protocols widely
used on the Internet that provides communications across interconnected networks of
computers with diverse hardware architectures and various operating systems. TCP/IP
includes standards for how computers communicate and conventions for connecting
networks and routing traffic.

Trojan
A destructive program that masquerades as a benign application. Unlike viruses, Trojan
horses do not replicate themselves but they can be just as destructive. One of the most
insidious types of Trojan horse is a program that claims to rid your computer of viruses
but instead introduces viruses onto your computer.

The term comes from a story in Homer's Iliad, in which the Greeks give a giant wooden
horse to their foes, the Trojans, ostensibly as a peace offering. But after the Trojans
drag the horse inside their city walls, Greek soldiers sneak out of the horse's hollow
belly and open the city gates, allowing their compatriots to pour in and capture Troy.

Update
A new version of a software or hardware product designed to replace an older version
of the same product. In addition, the installation routines for updates often check to
make sure that an older version is already installed on your computer; if not, you cannot
install the update.

Bitdefender has its own update module that allows you to manually check for updates,
or let it automatically update the product.
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Virus
A program or piece of code that is loaded onto your computer without your knowledge
and runs against your will. Most viruses can also replicate themselves. All computer
viruses are manmade. A simple virus that can copy itself over and over again is relatively
easy to produce. Even such a simple virus is dangerous because it will quickly use all
available memory and bring the system to a halt. An even more dangerous type of virus
is one capable of transmitting itself across networks and bypassing security systems.

Worm
A program that propagates itself over a network, reproducing itself as it goes. It cannot
attach itself to other programs.
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